IMPORTANT NOTICE:
YOUR USE OF THESE MATERIALS SHALL BE DEEMED TO CONSTITUTE YOUR
AGREEMENT THAT SUCH USE SHALL BE GOVERNED BY THE PROVISIONS OF YOUR
AGREEMENT WITH REALPAGE, INC. OR ITS SUBSIDIARY (THE "AGREEMENT").

Notification
All documentation, source programs, object programs, procedures, and any other material
supplied in connection therewith ("Materials") remain the exclusive property of RealPage, Inc.,
an affiliate of RealPage, Inc., or, in certain cases, its licensees. This document and the Materials
are confidential and proprietary information of RealPage, Inc., its affiliates, or, in certain cases,
its licensees. The Materials may not be copied, distributed, or otherwise disclosed, and may not
be used in any way unless expressly authorized by RealPage. Any copying, distribution, or use
of such Materials not specifically authorized by the Agreement shall be deemed a violation of the
Agreement. Such a violation will terminate the licensee’s right to use such Material. This
notification constitutes part of the documentation and accordingly may not be removed
therefrom.

© 2013 RealPage, Inc. All rights reserved.
Printed in the United States of America
All other brands and product names are trademarks or
registered trademarks of their respective owners.
# Contents

## Applicant and Resident Management

<table>
<thead>
<tr>
<th>Applicants and Residents</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Senior Living Page</td>
<td>5</td>
</tr>
<tr>
<td>Finding a Resident</td>
<td>6</td>
</tr>
<tr>
<td>Printing the Residents List</td>
<td>7</td>
</tr>
<tr>
<td>Applicant and Resident Actions</td>
<td>8</td>
</tr>
<tr>
<td>Adding an Applicant</td>
<td>9</td>
</tr>
</tbody>
</table>

## Senior at a Glance

| Changing the Next Assessment Due Date | 14 |
| Summary Tab                          | 17 |
| Changing Presence                    | 20 |
| Deleting the Temporary Absence Record | 20 |
| Editing the Primary Emergency Contact | 21 |

## General, Personal Health, and Demographic Information

| General Information | 26 |
| Selecting or Changing an Applicant’s Unit | 30 |
| Personal Health Information | 32 |
| Adding a Medication | 36 |
| Demographics         | 37 |
| Select Race           | 40 |
| Previous Residence   | 41 |
| Entering an Address  | 43 |
| Activities and Preferences | 46 |

## Assessment History Tab

| Understanding Assessment Status and Workflow—Without Reviews | 49 |
| Understanding Assessment Status and Workflow—with Reviews | 50 |
| Approving an Assessment | 54 |
| Deleting an Assessment | 54 |
| Finalizing an Assessment | 55 |
| Creating a New Assessment | 57 |
| The Assessment Page | 60 |
| Completing an Assessment | 61 |
| Adding or Changing a Resident Need | 66 |
| Deleting a Resident Need | 66 |
| Copying an Existing Need | 67 |
| Managing the Tasks Associated with a Resident Need | 68 |
| Adding or Changing a Task | 70 |
| Deleting a Resident Task from the Tasks List | 73 |
| Reviewing or Printing an Assessment | 75 |
| Finalizing an Assessment | 76 |
# Contents

- Approving an Assessment ......................................................... 77
- Contacts Tab ............................................................................. 81
  - Adding a Contact .................................................................... 82
  - Finding a Contact ................................................................. 83
  - Changing the Primary Emergency Contact .......................... 83
  - Editing a Contact’s Information ........................................... 84
  - Deleting a Contact .............................................................. 84
- Find Contacts ................................................................................ 87
  - Finding Contacts ................................................................. 88
  - Using the Find Contacts Page ............................................... 89
- Manage Contacts ....................................................................... 93
  - Adding Name and Contact Information .................................. 93
- Contact/Resident Association .................................................. 97
  - Adding the Contact/Resident Association Information .......... 98
  - Removing a Contact from Group Membership .................... 99
- Change Primary Emergency Contact ........................................ 103
  - Assigning a New Primary Emergency Contact .................. 103
  - Checking for Duplicate Contacts ........................................ 104
- Care Fee History Tab .................................................................. 107
  - Updating the Care Fee Status .............................................. 108
- Activity Tab ................................................................................ 113
  - Adding or Editing Activities ................................................ 113
  - Printing the Activity Journal ................................................ 114

## Actions

### Actions Common to Applicants and Residents 115

- Print Reports ............................................................................. 119
  - Printing Reports ..................................................................... 119
- Assess .................................................................................... 121
- Record Activity ........................................................................ 123

### Applicant Actions 125

- Select Unit .............................................................................. 127
- Move-In .................................................................................. 129
  - Moving In an Applicant ...................................................... 129
- Cancel or Deny Application ................................................... 131
  - Canceling the Application ................................................ 131
  - Denying the Application .................................................... 131
- Undo Cancel or Deny Application .......................................... 133
  - How to Get Here ............................................................... 133
  - Restoring the Application .................................................. 133

### Resident Actions 135

- Change Presence ................................................................. 137
- Print Staff Assignments ......................................................... 139
  - Printing Staff Assignments ................................................ 139
- Give/Change Notice ............................................................... 141
  - Giving Notice to Move Out ................................................ 141
  - Changing the Move-Out Notice .......................................... 141

---

vi  Care Management uGuide  © 2013 RealPage, Inc.
Book I

Applicant and Resident Management

In This Book
Applicants and Residents.................................................................3
CHAPTER 1

Applicants and Residents

This part of the RealPage Senior Living Care Management product center is devoted to managing all resident and applicant activity. The Senior living page presents a list of all applicants and residents at your community, allowing you to search and filter the list as you need in order to find the person you want to work with.

When you select an applicant or resident (current or past), the Senior at a glance page opens. It is the “gateway” to access all household information. The tabs across the top of the page allow you to access the person’s information, such as the ledger, activity journal, and lease details. Shortcuts (common functions) are available at the left of the page in the Actions section. The list of available shortcuts is dynamic; it changes according to the status of the resident or applicant.

Most of the functions accessed from the tabs are available for both residents and applicants. Some of the options, however, are exclusive. Later chapters describe the actions available only to applicants, only to residents, and to both.

In This Chapter

The Senior Living Page ...........................................................................................................5
Senior at a Glance ................................................................................................................13
The Senior Living Page

Use the Senior living page to find and manage your property’s residents. When the page displays initially, it is blank. The product provides a number of ways to search for residents and applicants.

- You can find residents and applicants by name, unit number, or by the care management assessment template last used to assess the person’s care needs by entering search criteria in the fields above the Senior living list.
- You can also use the A-to-Z bar in the lower portion of the page. This feature lets you find people whose first and/or last name begins with the letter you select.
- Last, you can filter the list by status (applicants, current residents, pending move-outs, previous residents, etc.). See Finding a Resident or Applicant (on page 6) for more detailed instructions.

For each resident, you see the building and unit number, name, status, move-in and move-out dates, and presence indicator. You also see key information on the resident’s assessment status, including the last assessment date, the template used, and the next scheduled assessment date.

The Actions column provides two links that let you manage your applicants and residents easily.

- The More link lets you update specific information from the Senior living page quickly and easily by taking you directly to the task you want to perform.
- The View link lets you view the full detail for a specific person and perform additional actions. The link you choose depends on the needed actions and the number of residents you will be working with. Click the Refresh button above the list as you update information in the Senior living list.

When you click the More link, the system presents a list of tasks you can perform with this person. Selecting an option from the drop-down list takes you directly to the selected action from this page. The list of available actions changes, depending on the status of the selected person.

The View link opens the Senior at a glance page, which contains all of the information for this person: the applicant or resident file. From the Senior at a glance page you can perform all of the same actions that are available in the More list, plus these additional options:

- Add or make changes to the person’s personal, health, and demographic information, including address, phone number, and e-mail address, primary diagnoses, vaccine, and medication information, previous residence information, activities, and preferences.
- Review and manage assessments and care fees, including the resident’s full history.
- View or make changes to the person’s contact information, including the personal, emergency, and power of attorneys.
- Review a resident’s absence history.
• Review the activity ledger for the person, where both system-generated activities and user-added activities maintain a record of all actions taken with the applicant’s or resident’s file.

If you need to add a new resident, click the New button. Complete the Add applicant box. Adding a resident is a two-step process. The first step is adding an applicant so that you can do a pre-assessment for the applicant. The next step is to move in the applicant. It is common for the assessment to be completed and the resident physically moved in before the application is updated. It is also common for both steps to be completed days after the resident moves in.

Before You Begin

• Your ability to view information and perform tasks at the Senior living page is partially controlled by roles and rights assigned to your sign-on name in user management. In order to perform the tasks detailed in this area, you must have the following roles and/or rights assigned in user management. A Superuser in your company has the ability to modify your rights.
  • View Senior living tab: This access is controlled by the “View the Senior living resident listing” right. By default, this right is assigned to the Activity Director, Bookkeeper, Leasing Consultant, Property Manager, Regional Property Manager, Resident Care Director, Reviewer, and Superuser roles.
  • Adding an applicant: This action is controlled by the “Allow the user to add a new applicant” right. By default, this right is assigned to the Bookkeeper, Leasing Consultant, Property Manager, Regional Property Manager, Resident Care Director, Executive Director, and Superuser roles.

How to Get Here

Senior living

Click the Senior living tab.

Finding a Resident

Initially, the Senior living list is blank. You must enter search criteria or select a status to view a list of residents or applicants. Use the following search methods to find residents.

Find by Category

This type of search will find residents and applicants. Click the drop-down arrow beside the Find field and choose the search category:

• Unit: This is the default choice. Use this option to find an applicant or resident by unit number. You can enter a partial number when uncertain of the exact unit number. For example, entering “10” lists all units that begin with those two numbers.
• **Name**: This option finds an applicant or resident whose first or last name begins with the letters you enter. For example, entering “Sam” will return a resident named “Samuel Johnson” and a resident named “Jane Samosa.”

• **Template**: This option finds all applicants or residents who were last assessed using a care assessment template whose name begins with the letters that you enter. For example, if you have a template named “Memory Care,” entering an “M” here will return a list of all people last assessed with that template.

**A-to-Z Bar**

The A-to-Z bar works similar to the “Name” category above, except you click a letter rather than enter one. For example, if you click the letter “C,” the A-to-Z bar returns a list of applicants and residents whose first or last name begins with “C.” The A-to-Z bar also lets you search by first name only or last name only. To use this feature, click the **Name** link and select either “Last name” or “First name” in the drop-down list.

**Find by Status**

To find groups of applicants and residents with the same lease status (a broader search), click the drop-down arrow beside the **Refresh** button at the right of the page and select the appropriate status:

• **Applicants**: This option lists people who have been entered into OneSite but who have not yet moved in.

• **Canceled**: This option lists people who applied but whose application was denied or canceled prior to moving in.

• **Residents**: This option lists current residents.

• **Pending move-outs**: This option lists only residents who have given notice to vacate (move out).

• **Previous residents**: This option lists former residents, that is, residents who have moved out.

**Printing the Residents List**

1. Filter the list of residents using any search method available. For example, you may want to list residents whose first or last name begins with the letter “B.” Or, you may want to list only your residents.

2. Click **Print**. This button is located in the upper-left portion of the page.

   The **Print list** page opens and lists the filtered list of residents as they appear on the **Senior living** page in a printable format. The property name appears at the top of the list. The title includes (in parentheses) the search method used to filter the list of residents. For example, if you listed previous residents, the title is **Residents List (Previous Residents)**.

   The columns are as follows left to right on the page. For detail information, refer to the **Fields** (on page 10) topic for the **Senior living** page.

   • Unit
   • Last Name
   • First Name
   • Status
- Move In
- Present
- Move Out
- Last Assessment
- Template
- Next Assessment

3. Click Print.
4. Select the printer and click Print again.
5. To return to the Senior living page, click Close.

Refreshing the Data

Use the Refresh button to update data. For example, if you change a resident’s presence status and return to this page, the Present column won’t reflect the current status until you click the Refresh button.

Applicant and Resident Actions

The following options are available from the More link at the Senior living page and in the Actions list on the Senior at glance page. Many can also be accessed from the tabs on the Senior at glance page, but the More links and Actions list provide direct shortcuts to the tasks.

Because the actions list is dynamic—it changes according to the lease status—actions are listed by status below.

Working with Applicants
- Print reports: This option opens the person’s most recent assessment, where you can review or print the assessment summary and forms.
- Assess: Use this option to begin a new assessment.
- Record activity: Use this option to log an entry on the person’s Activity tab.
- Move in: Use this option to move an applicant in to the property. Upon completion, the applicant is considered a resident. This changes the person to a Current resident.
- Change unit: Use this option to change an applicant’s requested unit.
- Cancel application: Use this option when an applicant decides not to continue with moving it to the property. This changes the person to Former applicant status.
- Deny application: Use this option when you have decided not to lease to an applicant. This changes the person to Former applicant status.

Working with Canceled Applicants
- Record activity: Use this option to log an entry on the person’s Activity tab.
- Undo cancel application: Use this option to reinstate an applicant that you canceled previously. This returns the person to Applicant status.
Chapter 1: Applicants and Residents

- **Undo deny application**: Use this option to reinstate an applicant that you denied previously. This returns the person to Applicant status.

**Working with Residents**
- **Print reports**: This option opens the person’s most recent assessment, where you can review or print the assessment summary and other key reports for this resident.
- **Assess**: Use this option to begin a new assessment.
- **Change presence**: Use this option to change the resident’s presence status.
- **Record activity**: Use this option to log an entry on the person’s Activity tab.
- **Undo move in**: Use this option to reverse the move-in. This changes the person back to an Applicant. You can undo a move-in for 45 days following the move-in date. After that, the system will not allow you to undo the move-in.
- **Give notice**: Use this option to record a resident’s planned move-out date. This changes a resident’s status to Pending move out.
- **Transfer**: Use this option to move a resident from the current unit to a different unit.
- **Move out**: This option opens the Move out box that lets you complete a move-out action. This changes the person’s status to Former resident.

**Working with Pending Move-Outs**
- **Print reports**: This option opens the person’s most recent assessment, where you can review or print the assessment summary and other key reports.
- **Assess**: Use this option to begin a new assessment.
- **Change presence**: Use this option to change the resident’s presence status.
- **Record activity**: Use this option to log an entry on the person’s Activity tab.
- **Change notice**: Use this option to change a resident’s scheduled move-out date.
- **Cancel notice**: Use this option to cancel a scheduled move-out. This changes the person’s status back to Current resident.
- **Move out**: This option opens the Move out box that lets you complete a move-out action. This changes the person’s status to Former resident.

**Working with Previous Residents**
- **Record activity**: Use this option to log an entry on the person’s Activity tab.
- **Undo move-out**: Use this option to reverse the move-out. This changes the person’s status back to Current resident.

**Adding an Applicant**
1. Enter the applicant’s full **Name**. Enter the first name, middle initial, and last name. To add a suffix to the applicant’s name, click the drop-down arrow and make a selection.
2. Click the **Calendar** and select the applicant’s **Scheduled move-in** date. This can be the current date or up to 45 in the future.
3. To cancel adding the applicant, click **Cancel**.
4. Click **Save**. The system checks for duplicate names. When the system finds a duplicate, an alert appears. You must either click **Yes** to continue adding the resident, or click **Cancel**.
Once the applicant is saved, the **General, personal health, and demographic information** appears (on page 25). You must complete the required tabs.

**Fields**

**Find Residents or Applicants**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Find</td>
<td>Select a category from the <strong>Find</strong> drop-down list, enter the criteria, and then click <strong>Find</strong>. You can search by:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unit (default):</strong> This option finds a person by unit number. You can enter a partial value. For example, if you enter “20,” OneSite will find anyone (residents and applicants) whose unit number begins with “20.”</td>
</tr>
<tr>
<td></td>
<td>If your property uses buildings, enter a specific building-unit number (1011-101, 1513-332, etc.), or enter a partial value. Entering 2020-1, for example, will list all units that begin with the number 1 in building 2020. To list all units in a particular building, enter the building number followed by a dash (5713-, 1011-, etc.).</td>
</tr>
<tr>
<td></td>
<td>- <strong>Name:</strong> This option finds people by first or last name. Enter the full first or last name or the first few letters of the name.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Template:</strong> This option finds people based on the care assessment template that was used for their most recent assessment.</td>
</tr>
<tr>
<td>(Entry field)</td>
<td>Enter the search criterion in this field and click <strong>Find</strong>. You must enter at least one character.</td>
</tr>
<tr>
<td>(Status)</td>
<td>To search by status, click the drop-down arrow to the right of the <strong>Refresh</strong> button and select one of the following options.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Residents:</strong> This option lists all active residents.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Previous residents:</strong> This option lists only former residents whose accounts have been closed. These are former residents who have completed the <strong>Close account</strong> wizard in OneSite.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Applicants:</strong> This option lists people who have been entered in the system but have not been moved in.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Canceled:</strong> This option lists people whose applications were canceled or denied prior to moving in.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Pending move-outs:</strong> This option lists residents who have given notice to vacate (move out).</td>
</tr>
</tbody>
</table>

**Residents and Applicants List**

| Actions - View | This link opens the **Senior at a glance** page that contains contact, assessment, care fee, and other information for the resident. |
Chapter 1: Applicants and Residents

Actions - More

This link opens a list of shortcuts that let you perform specific actions. The list of actions changes based on the person’s current status; therefore, you may not see all of the actions listed below:

- **Print assessment**: This option opens the person’s most recent assessment, where you can review or print the assessment summary and other key reports.
- **Assess**: Use this option to begin a new assessment. You cannot use this option if there is already an assessment in progress for this person.
- **Change presence**: Use this option to change the resident’s presence status.
- **Record activity**: Use this option to log an entry on the person’s Activity tab.
- **Change unit**: Use this option to change an applicant’s requested unit.
- **Cancel application**: Use this option when an applicant decides not to continue with moving in to the property.
- **Deny application**: Use this option when you have decided not to lease to an applicant.
- **Undo cancel**: Use this option to reinstate an application that was canceled or denied.
- **Move in**: Use this option to move an applicant in to the property. Upon completion, the applicant is considered a resident.
- **Undo move-in**: Use this option to reverse a move-in, making the person an applicant again.
- **Transfers**: Use this option to move a resident from the current unit to a different unit.
- **Give notice**: This option opens the Give notice box to declare the resident’s intention to move out of the community. This changes a resident’s status to Pending move out.
- **Change notice**: Use this option to change a resident’s scheduled move-out date.
- **Cancel notice**: Use this option to cancel a scheduled move-out. This changes the person’s status back to Current resident.
- **Move out**: This option opens the Move out box that lets you complete a move-out. This changes the person’s status to Former resident.
- **Undo move-out**: Use this option to reverse the move-out. This changes the person’s status back to Current resident.

Unit

This is the resident’s building (if buildings are used at the property) and unit number. Click the column heading to sort the list by unit number. For applicants, this is the person’s selected unit. If a unit has not yet been selected, this column is blank.
### Applicant and Resident Management

<table>
<thead>
<tr>
<th>Last name</th>
<th>This is the person’s last name. If incorrect, click View to make the necessary changes to the person’s information. Click the column heading to sort the list alphabetically by last name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>First name</td>
<td>This is the person’s first name. If incorrect, click View to make the necessary changes to the person’s information. Click the column heading to sort the list alphabetically by first name.</td>
</tr>
<tr>
<td>Status</td>
<td>This is the lease status (applicant, resident, former, pending move-out, etc.). OneSite updates the status as you perform lease administration actions on the applicants and residents. After performing an action from the More list or working with a person’s Senior at a glance page, click Refresh to view changes. You can sort people by status, if needed.</td>
</tr>
<tr>
<td>Move in</td>
<td>This is the resident’s move-in date. For applicants, this is the scheduled move-in date.</td>
</tr>
<tr>
<td>Present</td>
<td>This Yes/No indicator identifies whether the person is currently in residence at the community. For example, residents who are currently hospitalized or on an extended visit with family or friends should be identified as not present.</td>
</tr>
<tr>
<td>Move out</td>
<td>This is the scheduled move-out date for residents who have given notice or the actual move-out date for former residents.</td>
</tr>
<tr>
<td>Last assessment</td>
<td>This is the calendar date on which this person’s care needs were last assessed. (This is not the Effective date of the assessment.)</td>
</tr>
<tr>
<td>Template</td>
<td>This is the template that was last used to assess the person’s care needs.</td>
</tr>
<tr>
<td>Next assessment</td>
<td>This is the date on which this person’s care needs are scheduled to be re-assessed. This date is based on the last assessment date and the follow-up schedule defined for the last assessment template.</td>
</tr>
</tbody>
</table>

### Add Applicant

- **Name**: Enter the applicant’s full name and any suffix.
- **Scheduled move-in**: Enter the applicant’s scheduled move-in date.

### Buttons

- **New**: Opens the Add applicant box
- **Print**: Opens the Print list page
- **Find**: Finds residents or applicants that match the search criteria you entered
- **Refresh**: Refreshes the list of residents and applicants
CHAPTER 2

Senior at a Glance

Use this page to maintain information for the selected applicant or resident. The person’s name and unit assignment (if any) displays at the top of the page.

Heading

Beneath the person’s name are key items of information that are always visible as you work with an applicant or resident: the residency status, the next assessment date, the presence indicator, and the service group assignment. You also have the option to change the date of the person’s next scheduled assessment by clicking the Next assessment due date link.

The Tabs

Below the page header, several tabs allow you to view and update resident or applicant information. The following is a brief description of the tabs:

- **Summary**: (on page 17) This tab lists basic resident information, including critical health information, emergency contact information, primary physician, and absence history. From here, you will use the Edit general, personal health, and demographic information button to manage the resident’s personal data in detail.
- **Assessment history**: (on page 47) This tab allows you to perform applicant and resident assessments and review any current or past assessments.
- **Contacts**: (on page 81) This tab is used to set up and manage all of the resident’s contacts, including family, legal, medical, insurance, and financial contacts.
- **Care fee history**: (on page 107) This tab allows you to review and manage the care fees associated with the resident’s care. Just as you use the Assessment history tab to manage resident needs assessments, you will use the Care fee history tab to manage the care fees associated with that care.
- **Activity**: (on page 113) This tab lists all the activities associated with the resident. Two types of activities are recorded here. System-generated activities, such as move-ins and move-outs, are automatically recorded on the activity list. User-added activities allow you to record significant events, communications, or observations, as well as progress notes.

The Actions

In the Actions panel to the left, choose any one of the options to perform a task for the selected person. The available choices are determined by the person’s status. Most of these options are shortcuts to pages that can also be accessed using the tabs or from the More link at the Senior living tab.

- For applicants, you can begin an assessment, print reports, change the applicant’s selected unit, cancel or deny the application, move in, and log activities for the applicant.
- For canceled or denied applicants, you can undo the cancellation or denial and log activities.
- For current residents, you can begin an assessment, print reports, change the resident’s presence indicator, give notice, move out or transfer residents, log activities for the resident, and undo the move-in.
- For on-notice residents, you can begin an assessment, print reports, cancel or change the notice to move out, complete the move-out, change the resident’s presence indicator, and log activities for the resident.
- For former residents, you can undo the move-out and log activities.

In This Chapter
How to Get Here ......................................................................................................... 14
Changing the Next Assessment Due Date .................................................................. 14
Summary Tab .............................................................................................................. 17
Assessment History Tab ............................................................................................. 47
Contacts Tab ............................................................................................................... 81
Care Fee History Tab ................................................................................................ 107
Activity Tab .............................................................................................................. 113

How to Get Here
Senior living ➔ View
1. Click the Senior living tab.
2. Use one of the search methods to locate the applicant or resident you want to work with.
3. Click the View link for the resident or applicant.

Changing the Next Assessment Due Date
The Next assessment due date appears in the upper-right corner of the Senior at a glance page. This date is automatically calculated and updated by the system each time you complete an assessment based on the follow-up schedule defined for the care management template that you used for the resident. However, you can change this date if needed.
1. Click the link for the Next assessment due date.
2. Enter the new assessment due date. This date must be a future date.
3. Click Save to change the date and update the Senior at a glance page.

Fields
Status This is the residency status of the person (applicant, resident, previous resident, pending move-out, etc.). Senior Living updates the status as you perform administrative actions on the applicants and residents.
Present  This Yes/No indicator identifies whether the person is currently in residence at the property. For example, residents who are currently hospitalized or on an extended visit with family or friends should be identified as not present.

Next assessment due  This is the date on which this person’s care needs are scheduled to be re-assessed. This date is based on the last assessment date and the follow-up schedule defined for the last assessment template. You can override this date by clicking the date link and changing the scheduled date.

Service group  This is the service group that the person is currently assigned to.
Summary Tab

This page allows you to review the most commonly referenced information about your applicants and residents: general information, basic health information, the primary emergency contact, and the primary physician. General and personal health information is managed from a much more detailed set of tabs, using the Edit general, personal health, and demographic information button. Use the button to enter or update the person’s information and to see additional detail. Emergency contact and primary physician information is managed from Contacts tab, along with all other contact information. For quick reference, you can rely on the basic information shown on the Summary tab.

You also manage the resident’s presence status here. That is, if a resident will be absent from the community for a significant period of time, you record that temporary absence here, using the Change presence button above the Temporary absence history list. For example, if a resident has been hospitalized or is spending the holidays with family, you will record the absence so that staff are aware that this resident’s care tasks are temporarily suspended. The care fees associated with those tasks can also be suspended.

In the Actions panel to the left, you can select any of the options to initiate actions regarding the person’s leasing status. The choices vary according to the status of the applicant or resident.

Fields

General Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>This is the name of the resident or applicant, as recorded on the Resident information tab of the person’s General, personal health, and demographic information.</td>
</tr>
<tr>
<td>Unit</td>
<td>This is the person’s current unit number.</td>
</tr>
<tr>
<td>Age</td>
<td>This is the person’s current age, calculated from the date of birth as recorded on the Demographics tab of the person’s General, personal health, and demographic information.</td>
</tr>
<tr>
<td>Phone</td>
<td>This is the phone number entered for the applicant or resident, as recorded on the Resident information tab of the person’s General, personal health, and demographic information.</td>
</tr>
<tr>
<td>Scheduled move in</td>
<td>This is the applicant’s current scheduled move-in date. This field does not appear for residents (who have already moved in).</td>
</tr>
<tr>
<td>Moved onto property</td>
<td>This is the date the resident moved in, as recorded on the Resident information tab of the person’s General, personal health, and demographic information. This field is only available for residents.</td>
</tr>
<tr>
<td>Length of stay</td>
<td>This is how long the resident has been living at the community. This field only displays for residents.</td>
</tr>
</tbody>
</table>
Unit move in
This is the date that the resident moved in to his or her current unit, as recorded on the Resident information tab of the person’s General, personal health, and demographic information. This field only displays for residents.

Respite
This Yes/No flag indicates if the resident is receiving respite care, as recorded on the Resident information tab of the person’s General, personal health, and demographic information.

Personal Health Information

Primary diagnosis
This is the person’s primary diagnosis, as recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Secondary diagnosis
This is the person’s secondary diagnosis, as recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Allergies
This shows any allergies recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Alerts
This shows any alerts recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Advance directives
This Yes/No flag indicates whether there are any advance directives for this person, as recorded on the person’s Personal health information tab of the person’s General, personal health, and demographic information.

Code status
This shows the code status recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Evacuation assistance
This flag identifies whether the person requires assistance in case the property must be evacuated, as recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

Ambulatory
This Yes/No flag indicates whether the person is ambulatory, as recorded on the person’s Personal health information tab of the person’s General, personal health, and demographic information.

Primary Emergency Contact

Name
If there is a primary emergency contact entered for this person (on the Contacts tab), this is that contact’s name.

Address
If there is a primary emergency contact entered for this person, this is the contact’s address.

Primary contact method
If there is a primary emergency contact entered for this person, this is the contact’s preferred communication method.
## Chapter 2: Senior at a Glance

### Relationship
If there is a primary emergency contact entered for this person, this is the relationship of the contact to the resident.

### Notes
If there is a primary emergency contact entered for this person, these are the notes entered for the contact (not the notes entered for the resident association with the contact).

### Primary Physician

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>If there is a primary physician entered for this person (on the Contacts tab), this is physician’s name.</td>
</tr>
<tr>
<td><strong>Address</strong></td>
<td>If there is a primary physician entered for this person, this is the physician’s address.</td>
</tr>
<tr>
<td><strong>Primary contact method</strong></td>
<td>If there is a primary physician entered for this person, this is the physician’s preferred communication method.</td>
</tr>
<tr>
<td><strong>Contact notes</strong></td>
<td>If there is a primary physician entered for this person, these are the contact notes entered for the physician.</td>
</tr>
</tbody>
</table>

### Temporary Absence History

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Actions</strong></td>
<td>For each instance of an absence from the property, the following options are available:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edit:</strong> Use this option to change an absence record. For example, if a resident calls to report that he is extending his visit with his family, you can adjust the absence end date and the care fee restart date appropriately.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Delete:</strong> Use this option to delete an absence record completely. For example, if a resident’s planned visit is canceled, delete the absence record.</td>
</tr>
<tr>
<td><strong>Temporary absence reason</strong></td>
<td>This is the reason that the resident is/was/will be absent from the property.</td>
</tr>
<tr>
<td><strong>Temporary absence start</strong></td>
<td>This is the date on which the resident’s absence begins.</td>
</tr>
<tr>
<td><strong>Temporary absence end</strong></td>
<td>This is the date on which the resident’s absence ends.</td>
</tr>
<tr>
<td><strong>Care fee charge stop date</strong></td>
<td>If the care fee will not be charged for the period the resident is absent, this is the date on which the care fee stops being billed.</td>
</tr>
<tr>
<td><strong>Care fee charge restart date</strong></td>
<td>If the care fee was suspended for the period the resident is absent, this is the date on which the care fee starts being billed again.</td>
</tr>
<tr>
<td><strong>Last modified by</strong></td>
<td>This is the last name of the person who entered or last changed the absence record.</td>
</tr>
<tr>
<td><strong>Last modified date</strong></td>
<td>This is the date on which the absence record was entered or last changed.</td>
</tr>
</tbody>
</table>
Changing Presence

The **Temporary absence history** list allows you to keep a record of any extended period of time that the resident spends away from the community. For example, if a resident goes to visit a friend or family member for the holidays, you would record the absence here. If the resident is hospitalized, you would record the absence here. These absence records allow you to then adjust the resident’s care fee for the period of time that the property staff are not providing direct care to the resident.

1. To add or modify a record of absence:
   - To add a new record of absence, click the **Change presence** button.
   - To modify an existing record of absence, locate the absence in the **Temporary absence history** list and click the **Edit** link.
2. Click the drop-down arrow in the **Reason** field to select the reason for the resident’s absence.
3. Enter or modify the **Start** date to reflect the date on which the resident’s absence begins. You can enter a prior date (up to three weeks before the current calendar date) or a future date (up to one month after the current calendar date).
4. Enter or edit the **End** date to reflect the date on which the resident returns to the property. In the case of planned absences (such as family visits), you may know this date at the time you enter the temporary absence. However, you can also leave this field blank and then edit the absence record to record the **End** date when the resident returns. This date must be within 30 days of the absence start date.
5. In the **Care fee charge** section, enter or edit the date on which the care fee should be stopped. That is, if the resident will not be charged for care while he or she is absent from the property, enter the date on which the fee should be suspended. This is normally the same date as the **Start** date of the absence, but can be any day after the absence start date.
6. In the **Restart** field, enter or edit the date on which the care fee should be resumed. In most cases, this is the same date as the **End** date of the resident’s absence and is entered at the same time. However, this date can be any date after the care fee stop date.
7. Click **Save**.

Deleting the Temporary Absence Record

Use this procedure to delete an absence record. This is usually done only when an absence record was entered by mistake or when a resident’s plans change.

1. Locate the absence record in the **Temporary absence history** list.
2. Click the **Delete** link.
3. Click **Delete** again when asked to confirm your action.
4. Click **Delete** again when asked to confirm the deletion again. The absence record is deleted.
Chapter 2: Senior at a Glance

Fields

**Temporary Absence**

- **Reason**
  Click the drop-down arrow and select the reason that the resident is or will be absent from the property.

- **Start**
  Enter the date on which the resident’s absence begins. This date can be up to three weeks before the current calendar date or up to one month after the current calendar date.

- **End**
  Enter the date on which the resident’s absence ends. This date must be within 30 days of the absence start date.

**Care Fee Charge**

- **Stop**
  If the care fee will not be charged for the period the resident is absent, enter the date on which the care fee stops being billed. This date can be any day after the absence start date.

- **Restart**
  If the care fee was suspended for the period the resident is absent, enter the date on which the care fee starts being billed again. This date can be any day after the care fee stop date.

**Editing the Primary Emergency Contact**

If you need to change the information about the resident’s primary emergency contact, you can do so directly from the Summary tab. This option opens the contact’s information. That is, you can change the contact’s name, address, phone and e-mail information, group membership, and notes, but you cannot change the resident association. For example, you can change the emergency contact’s preferred contact method, but you cannot select or change who the primary emergency contact is. To change the association, you must work from the Contacts tab.

To edit the primary emergency contact’s information:

1. Click the Edit button. This opens the contact’s personal information directly, by-passing the contacts list.

2. In the Name section, you must enter either a Contact name or a Business name (or both).
   - For individuals, enter the name in the Contact name fields. First and last names are required. You can also enter an honorific (Mr., Mrs., Ms., Dr., etc.), a middle initial, or a suffix (Junior, Senior, etc.).
     If the contact is associated with the resident or property professionally, enter the name of the company the person works for in the Business name field.
   - For businesses, you can leave the Contact name fields blank and enter only the Business name.

When you enter a new contact name, the system automatically checks for duplicates. If there is already a contact with the same first and last name, the system displays a link in red reading “Duplicates exist for this name.” You must click this link and determine whether this is the same contact or a different contact.
with the same name. (See Checking for Duplicate Contacts (on page 104) for detailed instructions on this step.)

3. In the Information section, click the MAIN ST button and enter the contact address. An address is not required.

4. Click the drop-down arrow in the Contact method field and select the contact’s preferred method of contact.

5. Based on the contact method you selected, you must complete one of the contact fields. That is, if you selected “Work phone,” you must enter the phone number in the Work phone field. If you selected “E-mail,” you must complete the E-mail field.

   You can also complete any or all of the other contact information for the contact. Add all the contact method information you have; it may prove to be helpful for an emergency contact.

6. Enter any comments or notes about this person or business in the Contact notes field. The information you enter here is associated with the contact, not with the contact’s relationship with any particular resident. This information displays when you click the Notes link on the resident’s Contacts tab.

7. If this person or business refers prospective residents to your property, select the Referral source check box below the Contact notes box.

8. In the Group membership section, select the contact group that this person or business is a member of. Click the drop-down arrow to the right of the Group membership list and select a contact group.

9. After you select a group, click the Add button to add the group to the Group membership list to the left.

10. Repeat steps 7–8 as needed to identify all of the groups the contact is a member of. Most contacts will only be a member of one group, but some contacts will be members of multiple groups. For example, a person could be assigned to both the “Family” group and to the “Emergency Contact” group.

11. If you assign a contact to the wrong group by mistake, use the Remove link in the Group membership list to remove the contact group.

12. Click Save. You are returned to the Summary tab, where the contact’s new information is shown.

Fields

<table>
<thead>
<tr>
<th>Name</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>(Honorific)</td>
<td>For a person, select an honorific that is part of the name, such as Mr. or Dr.</td>
</tr>
<tr>
<td>(First name)</td>
<td>For a person, enter the person’s first name. If you leave the Business name blank, this field is required.</td>
</tr>
<tr>
<td>(Middle initial)</td>
<td>For a person, enter the person’s middle initial (if any).</td>
</tr>
</tbody>
</table>
(Last name)  
For a person, enter the person’s last name. If you leave the Business name blank, this field is required.

(Suffix)  
For a person, select a suffix that is part of the name, such as Junior or Senior.

Business name  
For a business, enter the business name here. For a person whose relationship with the resident or property is professional, enter the name of the person’s company here.

**Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>This is the contact’s address. To enter or change this address, click the MAIN ST button.</td>
</tr>
<tr>
<td>Contact method</td>
<td>Click the drop-down arrow and select the contact’s preferred method of communication. Depending on what method you choose, one of the phone number or e-mail address fields will be required.</td>
</tr>
<tr>
<td>Work phone (and ext)</td>
<td>Enter the work phone number for this contact, including the extension, if needed.</td>
</tr>
<tr>
<td>Cell</td>
<td>Enter the cell phone number for this contact.</td>
</tr>
<tr>
<td>Home phone (and ext)</td>
<td>Enter the home telephone number for this contact, including the extension, if needed.</td>
</tr>
<tr>
<td>After hours phone</td>
<td>Enter the after hours phone number for the contact. This is used more specifically for business contacts.</td>
</tr>
<tr>
<td>Fax</td>
<td>Enter the fax number for this contact.</td>
</tr>
<tr>
<td>E-mail</td>
<td>Enter the e-mail address for this contact.</td>
</tr>
<tr>
<td>Contact notes</td>
<td>Enter any notes or comments about this contact. If you enter these notes, property staff can view the notes directly from the resident’s Contacts tab by clicking the Yes link in the Notes column.</td>
</tr>
<tr>
<td>Referral source</td>
<td>If this contact refers prospective residents to your property, select this option.</td>
</tr>
</tbody>
</table>

**Group Membership**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Actions | Once the contact has been assigned to one or more contact groups, you can use the following option to manage the group membership:  
  **Remove:** Use this option to remove this contact from the contact group. This changes the contact’s base information and removes this contact from this group for all residents who have this type of relationship with the contact.  
  • If the contact is currently assigned to a resident as a “Primary emergency contact,” you’ll see a warning message explaining that you must first remove that contact from the resident’s contact list. Go the contact list at the resident’s “at a glance” page to remove it. |
- If the contact is currently assigned to a resident with any contact group role other than “Primary emergency contact,” you’ll see a warning message explaining that the “The contact is assigned to a resident. You may want to remove the contact from the resident before making inactive.” You can proceed to make it inactive. The contact will remain on the resident’s list with a red “X” in the **Active** column.

- If the contact is not assigned to any resident, the status is changed to Inactive. The contact disappears from the list (you may need to remove the check mark from the **Show active only?** box above the list to see it). The green check mark becomes a red “X.”

<table>
<thead>
<tr>
<th><strong>Group name</strong></th>
<th>This is the name of the contact group that this contact is a member of. Each contact group identifies the type of contact this person or business is for someone at the property.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Active</strong></td>
<td>This column indicates whether the contact is currently an active or inactive member of the group. Active contacts have a green check mark, while inactive contacts have a red X.</td>
</tr>
<tr>
<td><strong>(Contact group)</strong></td>
<td>Click the drop-down arrow and select a contact group that this contact belongs to. Then, click <strong>Add</strong> to add the contact group to the contact’s <strong>Group membership</strong> list.</td>
</tr>
</tbody>
</table>
General, Personal Health, and Demographic Information

Like the Senior at a glance page, the General, personal health, and demographic information option is made up of a series of tabs that present all of the resident’s personal information. These tabs include:

- **General information:** In addition to the resident’s name and contact information on this tab, you will record a description of the resident’s physical appearance, unit and move-in dates, service group assignment, and multiple types of insurance information.

- **Personal health information:** (on page 32) On this tab you record basic health information, including primary and secondary diagnoses, allergies and alerts, advance directives and code status, and medications. You also record information about the resident’s last medical evaluation, flu and pneumonia vaccines, and TB test. If this community uses the QuickMAR integration, then the Medications list is updated by QuickMAR.

  For details about the QuickMAR integration, refer to the QuickMAR Integration Frequently Asked Questions topic (on page 155) in the Appendices.

- **Demographics:** (on page 37) This tab allows you to gather demographic information about the resident. The information you collect here is customized for your property, but can include date of birth, gender, Social Security number, race, citizenship, ethnicity, marital status, veteran branch, former occupation, and language and religious preferences.

- **Previous residence:** (on page 41) Here you record information about where the resident lived prior to moving to the property. You have the option of collecting two previous residences.

- **Activities and preferences:** (on page 46) In Activities, you select the activities that the resident has expressed an interest in. These activities are set up and managed by the community. In Preferences, you simply record any of the resident’s personal preferences, such as dining room seating.

Access these tabs by clicking the Edit general, personal health, and demographic information button in the General information section of the Summary tab.

Before You Begin

- The service groups that you assign each applicant or resident to on the General information tab are defined for your community at the Service groups option on the Setup page.

- You can select which fields appear on the Personal health information tab and whether those fields are required or optional. Make your selections at the Personal health settings option in the Resident management section of the Setup page.

- If you choose to collect resident medication information on the Personal health information tab, the medication notes that you use to identify a resident’s medications are defined for your property at the Medication notes option on the Setup page.
• If this community uses the QuickMAR integration, then the Medications list appears. To see the resident’s medical information, you must have the “Allow the user to view unencrypted data” right.

• The demographic information that is collected at the Demographics tab is defined for your property at Demographics – General settings in setup. Depending on the fields you select at General settings, you must also set up the choices for those fields at the following setup options:
  • Former occupation: If you selected this option, the occupations that are available for selection are set up at the Demographics – Former occupation option in Senior Living setup.
  • Ethnicity: If you selected this option, the options that are available for selection are set up at the Demographics – Ethnic origins option in Senior Living setup.
  • Language: If you selected this option, the languages that are available for selection are set up at the Demographics – Resident languages option in Senior Living setup.
  • Citizenship: If you selected this option, the countries that are available for selection are set up at the Demographics – Countries of citizenship option in Leasing & Rents setup.

• The community activities that are listed on the Activities and preferences tab are defined for your property at the Resident activities option on the Setup page.

How to Get Here

Senior living ➔ View ➔ Edit general, personal health, and demographic information

1. Click the Senior living tab.
2. Use one of the search methods to locate the applicant or resident you want to work with.
3. Click the View link for the resident or applicant.
4. Click the Edit general, personal health, and demographic information button on the Summary tab of the person’s Senior at a glance page.

General Information

The General information page contains basic information about a resident or applicant, including name, contact, and identification information, unit and property move-in information, and various types of insurance accounts. All of this information can be completed when you initially add a new applicant to the system, but much of this will not be completed until a person actually moves in to the community. After move-in, you will update this information as needed to reflect changes in the resident’s information.

If you have required any demographic information for your property, you must complete the required fields on the Demographics tab when you add a new applicant.
All other information on the General information, Personal health information, Demographics, Previous residence, and Activities and preferences tabs can be entered at a later time, if desired.

To complete or update a person’s general information:

1. Enter the person’s first and last name. Middle initial and suffix (such as “Junior” or “Senior”) are optional. You can also enter Former last name, such as a married woman’s maiden name.
2. Click the drop-down arrow and select the person’s Eye color.
3. Click the drop-down arrow and select the person’s Hair color.
4. In the Distinguishing marks area, enter any of the resident’s identifying marks. These can include such things as scars, birth marks, or tattoos.
5. If the person has a personal e-mail address, enter that address in the E-mail field.
6. If the person has a personal phone number, enter that number in the Phone field.
7. The Other information section includes a group of fields to record the person’s unit and service group assignment and move-in dates. This section is different for applicants, residents, and former residents.

Applicants:

- **Scheduled move-in**: This is the Scheduled move-in date that you entered when you added the person as an applicant. You can change this date as the applicant’s plans change prior to move-in. You can enter the current date or a future date.
- **Unit**: If you have selected a unit for the applicant, that unit appears here. If you have not yet selected a unit, you can use the Select unit link to find an available unit for the applicant. If you need to change the unit assignment prior to move-in, use the Change unit link.
- **Service group**: Click the drop-down arrow and select the service group that this applicant will be assigned to. You can change this assignment at any time, if necessary. The service groups that are available are defined for your property at Service groups in Senior Living setup.
- **Respite**: If the applicant will be in respite care, select this check box.

Residents:

- **Unit move-in**: The Unit move-in field is the date on which the resident moved in to the current unit. For residents who transferred to a different unit, you can enter a past date up to the previous transfer date. For current residents that did not transfer, this cannot be prior to the resident’s earliest move-in date.
- **Unit**: This is the number of the resident’s unit. You cannot change this number except by transferring the resident.
- **Service group**: This is the service group that the resident is currently assigned to.
- **Respite**: If the resident is receiving respite care, select this check box.
- **Moved onto property**: This is the date of the resident’s original occupancy at the property: the move-in date for the resident’s first unit. You can change this
to any past date or future date. If the resident has transferred to a different unit, the Unit move-in date and the Moved onto property date will be different.

- **Length of stay:** The system calculates and displays this period based on the Moved onto property date and the current date.

**Former Residents:**

For former residents, you cannot change any of the information in the Other information section.

- **Unit move-in:** The Unit move-in field is the date on which the resident moved in to the current unit.
- **Unit:** This is the number of the resident’s unit.
- **Service group:** This is the service group that the resident was assigned to.
- **Respite:** This check box indicates whether the former resident received respite care.
- **Moved onto property:** This is the date of the resident’s original occupancy at the property: the move-in date for the resident’s first unit. If the resident has transferred to a different unit, the Unit move-in date and the Moved onto property date will be different.
- **Length of stay:** The system calculates and displays this period based on the Moved onto property date and the Moved out date.
- **Moved out:** This is the date on which the former resident moved out of the property.
- **Move-out reason:** This is the reason for the resident’s leaving.

8. The *Insurance accounts* section allows you to record insurance policy information for multiple types of coverage the applicant or resident has. Complete all of the following fields that apply:

- **Medicare part B:** Enter the person’s account number for Medicare part B benefits. Once the number is saved, only the last four digits are shown for security purposes. To edit the number, click the Change link. To return to the original number, click the Reset link.
- **Medicare part D:** Enter the person’s account number for Medicare part D benefits. Once the number is saved, only the last four digits are shown for security purposes. To edit the number, click the Change link. To return to the original number, click the Reset link.
- **Medicaid:** Enter the person’s account number for Medicaid benefits, if any.
- **Long term care:** If the person has a long term care insurance policy, enter that policy or account number.
- **SSI:** If the person receives SSI (Social Security Insurance) benefits, enter the account number here.
- **VA:** If the person receives veteran’s benefits, enter the account number here.
- **Other:** If the person receives some other type of insurance benefits, enter the account number here.

9. Click **Save** to update the General information for this applicant or resident.
When adding a new applicant, you will not be able to save and close the General information tab until you have completed any required information on the Demographics tab. If this is the case, the Demographics tab is red and you must click the tab and complete the required information before saving and closing the applicant’s information.

### Fields

**Resident Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Enter the person’s first and last names. The middle initial is optional. If appropriate, click the drop-down arrow and select a suffix for the person’s name (such as “Junior” or “Senior”).</td>
</tr>
<tr>
<td>Former last name</td>
<td>If the person had a former last name, enter it here. For example, you can record a married woman’s maiden name or a divorced woman’s married name.</td>
</tr>
<tr>
<td>Eye color</td>
<td>Click the drop-down arrow and select the color of the person’s eyes.</td>
</tr>
<tr>
<td>Hair color</td>
<td>Click the drop-down arrow and select the color of the person’s hair.</td>
</tr>
<tr>
<td>Distinguishing marks</td>
<td>If the person has identifying marks, such as scars, birth marks, or tattoos, describe those here.</td>
</tr>
<tr>
<td>E-mail</td>
<td>If the person has a personal e-mail address, enter that address here.</td>
</tr>
<tr>
<td>Phone</td>
<td>If the person has a personal phone number, enter that number here.</td>
</tr>
</tbody>
</table>

**Other Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unit move-in or Scheduled move-in</td>
<td>For residents and former residents, this is the date on which the person moved in to the unit identified below. For applicants, this is the date on which the person is scheduled to move in. You can change the Scheduled move-in date for applicants, if necessary.</td>
</tr>
<tr>
<td>Unit</td>
<td>This is the resident’s current or former unit or the unit into which an applicant is scheduled to move. For applicants, use the Select unit link to select this unit or the Change unit link to select a different unit. For residents, you must use the transfer option to move the resident to a different unit.</td>
</tr>
<tr>
<td>Service group</td>
<td>Click the drop-down arrow and select the service group the person belongs to.</td>
</tr>
<tr>
<td>Respite</td>
<td>If the person is receiving respite care, select this check box.</td>
</tr>
<tr>
<td>Moved onto property</td>
<td>For residents and former residents, this is the person’s original move-in date.</td>
</tr>
<tr>
<td>Length of stay</td>
<td>For residents and former residents, the system calculates and displays the length of the person’s residency at the property.</td>
</tr>
<tr>
<td>Moved out</td>
<td>For former residents, this is the date on which the resident moved out of the property.</td>
</tr>
<tr>
<td>Move-out reason</td>
<td>For former residents, this is the reason for the resident’s leaving.</td>
</tr>
</tbody>
</table>
Insurance Accounts

**Medicare part B** Enter the person’s account number for Medicare part B benefits. Once the number is saved, only the last four digits are shown. To edit the number, click the **Change** link.

**Medicare part D** Enter the person’s account number for Medicare part D benefits. Once the number is saved, only the last four digits are shown. To edit the number, click the **Change** link.

**Medicaid** Enter the person’s account number for Medicaid benefits.

**Long term care** If the person has long term care insurance, enter the account or policy number for that coverage.

**SSI** If the person receives SSI benefits (Social Security Insurance), enter the account or policy number for that coverage.

**VA** If the person receives veteran’s benefits, enter the account or policy number for that coverage.

**Other** If the person has other insurance benefits, enter the account or policy number for that coverage.

Selecting or Changing an Applicant’s Unit

Use this procedure when you need to select or change a unit for an applicant. Once a resident has moved in, you must use the transfer option to change the person to a different unit.

1. To select an applicant’s unit, click the **Select unit** link or the **Change unit** link.
2. At the **Find unit** page, click the drop-down arrow in the **Find** field and select one of the following options to create a list of units.
   - **Building**: If your property is set up with multiple buildings, use this option to locate available units in a particular building. When you select the **Building** option, the system displays an additional field that lets you select one of the property’s buildings. If your property does not use buildings, this option is not available.
   - **Floor level**: When you set up your property’s units, you have the option of identifying the floor or level that the unit is on (first, second, third, etc.). If your units are defined this way, you can use this option to locate units on a specific floor of your property. When you select the **Floor level** option, the system displays an additional field that lets you select the floor or level.
   - **Floor plan**: Use this option to locate units with a particular floor plan. When you select the **Floor plan** option, the system displays an additional field that lets you select the floor plan you are looking for.
   - **Unit**: Use this option to locate a specific unit. When you select the **Unit** option, the system displays an additional field where you enter the number of the unit.
   - **Vacant units**: Use this option to list all units that are currently vacant at the property.
3. After selecting your search method, click **Find**. The system builds a list of units that meet your search criteria. Unless you chose the “Vacant units” option, this list includes both occupied and vacant units. You can easily identify the vacant units as those that do not have a name in the **Current resident** column.

4. Locate the unit you are looking for and click the **Select** link. You should only select a vacant unit.

   Units are not removed from availability when you assign a unit to an applicant. Vacant units remain vacant and available until a resident moves in. As a result, you can assign multiple applicants to the same unit. If you do this, the system will not allow you to move multiple people into the same unit. Instead, the move-in process will alert you that the assigned unit is no longer available and you will have to select a different, vacant unit.

5. The system returns you to the **Summary** tab, and the selected unit is assigned to the applicant.

---

**Fields**

**Find**

Select one of the following options to locate units that are available at your property:

- **Building:** If your community is set up with multiple buildings, use this option to locate available units in a particular building. When you select the **Building** option, the system displays an additional field that lets you select one of the property’s buildings. If your property does not use buildings, this option is not available.

- **Floor level:** When you set up your community’s units, you have the option of identifying the floor or level that the unit is on (first, second, third, etc.). If your units are defined this way, you can use this option to locate units on a specific floor of your property. When you select the **Floor level** option, the system displays an additional field that lets you select the floor or level.

- **Floor plan:** Use this option to locate units with a particular floor plan. When you select the **Floor plan** option, the system displays an additional field.

- **Unit:** Use this option to locate a specific unit. When you select the **Unit** option, the system displays an additional field where you enter the number of the unit.

- **Vacant units:** Use this option to list all units that are currently vacant at the property.

**(Search)**

If you chose any option other than “Vacant units,” enter or select the value that you are searching for. For example, if you selected “Floor plan,” select the floor plan that you want to review.

**Units**

**Action**

To assign a unit to an applicant, click the **Select** link.
Unit
Current resident
Floor level
Floor plan
This is the unit number of the listed units.
If the unit is currently occupied, this is the current resident’s name.
If the unit is not currently occupied, this column is blank.
If the unit is assigned to a floor level, that floor level appears here.
This is the floor plan of the unit.

**Personal Health Information**

The **Personal health information** tab allows you to collect and manage the basic health and medication information for your residents. You will normally complete most of this information when a resident moves in and then update it when the information changes over time.

The fields that appear on this tab are determined by your company in setup. The steps given here address all of the possible fields you may see, but your property may have some or none of these fields. Your company also determines whether the fields are required or optional. If your property makes any of these fields required, you will have to complete all required fields before you can save the **General, personal health, and demographic information** the first time you open this tab for an applicant or resident.

To complete the personal health information:

1. Enter the resident’s primary diagnosis in the **Primary diagnosis** field. This is the resident’s most serious medical condition.
2. If the resident has a second serious medical condition, enter it in the **Secondary diagnosis** field.
3. If the resident has any allergies, particularly food or drug allergies, identify them in the **Allergies** field.
4. If there are any alerts for the resident, enter the information in the **Alerts** field.
5. In the **Advance directives** field, click the drop-down arrow and select “Yes” or “No” to indicate whether the resident has registered any advance directives with the property staff.
6. If the resident has registered a directive regarding **Code status**, click the drop-down arrow in this field and select the appropriate option.
7. If you have evaluated the resident to determine whether assistance is needed in case the community has to be evacuated, click the drop-down arrow in the **Evacuation assistance** field and select “Required” or “Not required.”
8. In the **Ambulatory** field, click the drop-down arrow and select “Yes” or “No” to indicate whether the resident can walk unaided.
9. The **Medications** list appears if it is selected in setup or if the community uses the QuickMAR integration.
   - When selected for use in setup, this list shows all of the medications that the resident takes on a regular basis. It shows the name of the medication and any
notes that you selected to describe the medication. Use the following options to manage this list:

- **Add a medication:** Click the **New** button to add a new medication to the resident’s file.
- **Modify a medication:** Click the **Edit** link to change the name or notes for an existing medication.
- **Remove a medication:** Click the **Delete** link to remove the medication from the resident’s list.
- When the community is integrated with QuickMAR, this list shows the name of the medication, an asterisk when the medication should be reviewed, the medication type, and detailed instructions for the medication. You should click the **Refresh** button to view the most recent medication data from QuickMAR. This list is updated by QuickMAR, so you cannot edit the list. Medications active as of the current date are shown.

For more information about the **Medications** list, refer to the **Medications for Residents** topic (on page 161) in the **Appendices**.

10. In the **Medical evaluation** section, complete the following fields to describe the resident’s last medical evaluation:
   - **Date:** Enter the date on which the last medical evaluation was performed.
   - **Physician:** Enter the name of the physician that performed the evaluation.
   - **Appropriate:** Click the drop-down arrow and select “Yes” or “No” to indicate if the evaluation was appropriate for the resident.

11. In the **Flu vaccine** section, complete the following fields to describe the resident’s current flu vaccine status:
   - **Offered:** Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident was offered a flu vaccine.
   - **Accepted:** Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident accepted the offered vaccine.
   - **Location:** If the resident accepted the vaccine, identify where the vaccine was administered.
   - **Completed:** Enter the date on which the vaccine was administered. If the vaccine was administered as a series, enter the date when the last in the series was administered.

12. If the resident has lived previously in a senior living community, identify this location in the **Prior placement** field.

13. In the **TB test** section, complete the following fields to describe the resident’s current TB test status:
   - **Date:** Enter the date on which the test was administered.
   - **Type:** Click the drop-down arrow and choose the type of test that was administered.
   - **Results:** Click the drop-down arrow and select “Negative” or “Positive” to record the test result.
   - **Notes:** Enter any additional notes about the test or the results.
14. In the *Pneumonia vaccine* section, complete the following fields to describe the resident’s current pneumonia vaccine status:

- **Offered:** Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident was offered a pneumonia vaccine.
- **Accepted:** Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident accepted the offered vaccine.
- **Location:** If the resident accepted the vaccine, identify where the vaccine was administered.
- **Completed:** Enter the date on which the vaccine was administered. If the vaccine was administered as a series, enter the date when the last in the series was administered.
- **Recent hospitalization:** If the resident has been recently hospitalized, enter any notes or comments about that hospitalization.

15. Click **Save** when you have completed entering or updating the resident’s personal health information.

When adding a new applicant, you will not be able to save and close the **Personal health information** tab until you have completed all required information on both the **Personal health information** tab and the **Demographics** tab. If this is the case, the **Demographics** tab is red and you must click the tab and complete the required information before saving and closing the applicant’s information.

### Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary diagnosis</strong></td>
<td>Enter the person’s primary medical diagnosis. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Secondary diagnosis</strong></td>
<td>If the person has a second major medical diagnosis, enter it here. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Allergies</strong></td>
<td>If the person has any food or drug allergies, enter them here. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td>If there are alerts for this resident, enter them here. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Advance directives</strong></td>
<td>Click the drop-down arrow and select the option that indicates whether the resident has filed advanced directives for the property. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Code status</strong></td>
<td>Click the drop-down arrow and select the option that indicates the resident’s preference on specific advance directives. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Evacuation assistance</strong></td>
<td>Click the drop-down arrow and select the option that indicates whether the resident requires assistance in case of evacuation. This field only appears if it is selected for use in setup.</td>
</tr>
<tr>
<td><strong>Ambulatory</strong></td>
<td>Click the drop-down arrow and select “Yes” or “No” to indicate if the resident is ambulatory. This field only appears if it is selected for use in setup.</td>
</tr>
</tbody>
</table>
### Medications

The **Medications** list only appears if it is selected for use in setup.

**Actions**

For existing medications, you can use the **Edit** link to change the medication name or the notes selected for the medication. Use the **Delete** link to remove a medication from the resident’s list.

**Medication**

This is the name of the resident’s medication.

**Notes**

These are the notes selected for the medication. The notes indicate what type of medication this is.

---

### Medications

The following **Medications** list appears when the community is using the QuickMAR integration.

**Medication**

This is the name of the resident’s medication. The medications list can be sorted by the medication name.

**Asterisk**

An asterisk appears if the medication is flagged for review in QuickMAR. In QuickMAR, there will be either a green flag or a red flag.

- A green flag indicates the order is waiting for approval.
- A red flag indicates there is a problem with the order, and a correction is required.

**Type**

At this time, only medications appear; there are no vitals or treatments.

**Details**

This has the detailed instructions for the medication. The medications list can be sorted by the details.

---

### Medical Evaluation

**Date**

Enter the date on which the resident’s medical status was last evaluated. This field only appears if it is selected for use in setup.

**Physician**

Enter the name of the doctor who performed the last evaluation. This field only appears if it is selected for use in setup.

**Appropriate**

Click the drop-down arrow and select “Yes” or “No” to indicate whether the evaluation was appropriate for the resident. This field only appears if it is selected for use in setup.

---

### Flu Vaccine

**Offered**

Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident was offered a flu vaccine. This field only appears if it is selected for use in setup.

**Accepted**

Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident accepted the flu vaccine. This field only appears if it is selected for use in setup.
### Location
If the resident accepted, enter the location where the vaccine was administered. This field only appears if it is selected for use in setup.

### Completed
Enter the date on which the vaccine was administered. If the vaccine included a series of treatments, enter the date on which the series was completed. This field only appears if it is selected for use in setup.

### Prior placements
Enter any prior placements for this resident or applicant. This field only appears if it is selected for use in setup.

### TB Test
- **Date**: Enter the date on which the TB test was administered. This field only appears if it is selected for use in setup.
- **Type**: Click the drop-down arrow and select the type of test that was administered. This field only appears if it is selected for use in setup.
- **Results**: Click the drop-down arrow and select test results. This field only appears if it is selected for use in setup.
- **Notes**: Enter any additional notes about the test or the results. This field only appears if it is selected for use in setup.

### Pneumonia Vaccine
- **Offered**: Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident was offered a pneumonia vaccine. This field only appears if it is selected for use in setup.
- **Accepted**: Click the drop-down arrow and select “Yes” or “No” to indicate whether the resident accepted the pneumonia vaccine. This field only appears if it is selected for use in setup.
- **Location**: If the resident accepted, enter the location where the vaccine was administered. This field only appears if it is selected for use in setup.
- **Completed**: Enter the date on which the vaccine was administered. If the vaccine included a series of treatments, enter the date on which the series was completed. This field only appears if it is selected for use in setup.
- **Recent hospitalization**: If the resident has been hospitalized recently, enter any notes about that hospitalization, such as the reason and date. This field only appears if it is selected for use in setup.

### Adding a Medication
The *Medications* list only appears if it is selected for use in setup.

1. Click the *New* button to add a new medication to a resident’s file or click the *Edit* link to modify a listed medication.
2. Enter the name of the medication in the *Medication name* field.
3. In the Notes section, select all of the options that accurately describe this medication. The options listed here are defined by your property, but typically include such options as over the counter, prescribed, and psychotropic.

4. Click Save to add the medication to the list and return to the Personal health information page, or click Save and add another to add another medication to this resident’s file.

**Fields**

**Medication name** Enter the name of the resident’s medication.

**Notes** This section provides a list of check box options that allow you to identify or classify the resident’s medication. The options that are listed are defined by your property in Senior Living setup, but typically include such things as prescribed or over the counter. Select all options that apply to the medication.

**Demographics**

The Demographics tab allows you to collect personal demographic information about your applicants and residents. The fields that appear here and whether those fields are required or optional is defined by your property at the Demographics – General settings option in the Resident management section in Senior Living setup. All possible demographics options are detailed below, but your property may have only some or even none of these options.

If your community makes any of these fields required, you will have to complete all required fields before you can save the General, personal health, and demographic information the first time you open these pages for an applicant or resident.

The demographics information is divided into two sections, Identification and General demographics. To enter this information, complete the following steps:

1. In the Identification section, enter the Date of birth. Once the date is saved, only the last four digits (the year of birth) are shown and the month and day are masked for privacy and security purposes. If you have the necessary rights in user management, the system provides a Change link beside the date of birth that you can use to correct this date, if necessary. To return to the original date, click the Reset link. This field displays only if enabled in demographics general settings in setup.

2. If the person has a Social Security number, enter it in the SSN field. Once the number is saved, only the last four digits are shown for security purposes. To edit the SSN, click the Change link. To return to the original number, click the Reset link. This field displays only if enabled in demographics general settings in setup.

3. If the person has no Social Security number, enter the Alien Registration number. Once the number is saved, only the last four digits are shown for security purposes. To edit the number, click the Change link. To return to the original number, click the Reset link. This field displays only if enabled in demographics general settings in setup.
4. If the person has some other type of ID number (perhaps a driver’s license), enter it in the ID number field, and then choose the state that issued that number from the State of issue drop-down list. Once the number is saved, only the last four digits are shown for security purposes. To edit the number, click the Change link. To return to the original number, click the Reset link. These fields display only if you enabled the Ask for driver’s license number option in demographics general settings in setup.

5. If a government-assigned ID number applies to this person, enter it in the Government ID field. This field displays only if enabled in demographics general settings in setup.

6. In the General demographics section, enter or edit the person’s Gender. This field displays only if enabled in demographics general settings in setup.

7. To enter the person’s race information, click the Select race link. In the box that opens, you’ll select the racial category (group) as determined by the resident. The box offers a number of racial groups. You can make more than one choice, but if you choose more than one race category, you must identify a “primary” race type. This field displays only if enabled in demographics general settings in setup.

   Once you have selected the person’s racial classifications, the Demographics page displays the primary racial selection as a link. To modify the classification, click the link and make the appropriate changes.

8. Enter or edit the person’s Ethnicity. This field displays only if enabled in demographics general settings in setup. To choose an ethnicity option, click the drop-down arrow. The available choices are determined at the Demographics – Ethnic origins option in setup.

9. Enter the person’s Place of birth. This field displays only if enabled in demographics general settings in setup.

10. Select the person’s Citizenship. This field displays only if enabled in demographics general settings in setup. The drop-down list shows the countries your property uses from the Countries of citizenship option in property setup.

11. Select the person’s Marital status. This field displays only if enabled in demographics general settings in setup.

12. Select the person’s Language. This field displays only if enabled in demographics general settings in setup. Items in the drop-down list are maintained at Demographics – Resident languages in property setup.

13. Select the person’s Religious preference. This field displays only if enabled in demographics general settings in setup.

14. Select the person’s Former occupation. This field displays only if enabled in demographics general settings in setup. Items in the drop-down list are maintained at Demographics – Former occupation in property setup.

15. Select the person’s Veteran branch. This field displays only if enabled in demographics general settings in setup. If the person is a U.S. military veteran, select the Veteran branch in which the person served from the drop-down list:

   • Air Force
   • Army
16. Click **Save** to save the person’s demographic information.

### Fields

**Identification**

The **Demographics – General settings** page in setup is where you select the fields that will display, and whether any are required.

**Date of birth**
Enter the person’s birth date. If the birth date was entered previously, only the year of birth displays. To change the birth date, click the **Change** link. If you change the birth date by mistake, click the **Reset** link before you save changes to this page to return to the original birth date.

**SSN**
Enter the person’s Social Security number (if any). If entered previously, only the last four digits are visible. To edit the number, click the **Change** link. If you change the **SSN** by mistake, click the **Reset** link before you save changes to this page to return to the original number.

**Alien Registration**
If the person has no Social Security number, enter the person’s Alien Registration number. If entered previously, only the last four digits are visible. To edit the number, click the **Change** link. If you change the number by mistake, click the **Reset** link before you save changes to this page to return to the original number.

**ID number**
Enter the person’s alternate ID number, such as a driver’s license number. If entered previously, only the last four digits are visible. To edit the number, click the **Change** link. If you change the number by mistake, click the **Reset** link before you save changes to this page to return to the original number.

**State of issue**
If you entered an alternate **ID number**, click the drop-down arrow and choose the state that issued the number.

**Government ID**
If a government-assigned ID number applies to this person, enter it here.

### General Demographics

**Gender**
Select the person’s gender. This option displays only if selected in demographics settings in setup.

**Race**
Select the person’s race. If you select more than one race, you must designate one as the person’s “primary” race type. If the person declines to offer race information, select the **Member did not specify** option. Once you have made the selection, the primary racial selection appears on the **Demographics** page as a link. Click this link to change the selection, if necessary. This option displays only if selected in demographics settings in setup.
Ethnicity  Select the person’s Ethnicity. The choices in the drop-down list are determined at the Demographics – Ethnic origins setup page. This option displays only if selected in demographics settings in setup.

Place of birth  Enter the person’s birthplace. This option displays only if selected in demographics settings in setup.

Citizenship  Select the person’s country of citizenship. The countries in the drop-down list are maintained at the Countries of citizenship page in property setup. This option displays only if selected in demographics settings in setup.

Marital status  Select the person’s marital status. This option displays only if selected in demographics settings in setup.

Language  Select the person’s primary language. The languages in the drop-down list are maintained at the Resident languages page in property setup. This option displays only if selected in demographics settings in setup.

Religious preference  Select the person’s religious preference. This option displays only if selected in demographics settings in setup.

Former occupation  Select the person’s former occupation. The occupations in the drop-down list are maintained at the Former occupations page in property setup. This option displays only if selected in demographics settings in setup.

Veteran branch  If the person is a veteran in the U.S. military, select the branch in which the person served (Army, Marines, etc.). This option displays only if selected in demographics settings in setup.

Select Race

If your community collects demographics on residents’ racial background, use this box to select the resident’s racial identity. The box lists six racial options (including “Other”) and allows you to select one primary racial identification and multiple secondary identifications.

1. Review the options and select the one that best fits the person as the Primary selection. If the person did not specify a race, select “Member did not specify race” as the Primary selection.

2. If the person is of mixed race background and wants to record the secondary racial identifications, click the check box for each additional race that applies. You can choose as many secondary options as needed.

3. Click Save.
Previous Residence

This page is used to record information about the residential history of the resident. You can indicate if the person has ever been evicted, sued for rent or damages, or has ever broken a lease. Detailed information about two of the resident’s previous residences can be added or edited.

1. If the resident has any history of eviction, breaking a lease, or has been sued for rent or damages, click to add a check mark for that option in the Rental history section of the page.

2. To add or edit a previous residence, enter the name of the previous residence and indicate whether the residence was rented or owned in the Previous residence section. If the residence was not rented or owned, choose the N/A (not applicable) option.

3. Click the MAIN ST button to add or change the residence address. Refer to Entering an Address (on page 43) for details.

4. Enter or edit the Rent amount paid at the previous residence.

5. Add or edit the date the person moved in and moved out of the previous residence. OneSite automatically calculates the Length of residency.

6. Add or edit a brief reason why the resident moved out of the previous residence.

7. Enter or edit the name and the contact information for the manager of the previous residence. The telephone number, fax number, and e-mail address can be added. This is useful reference information.
   - For a U.S. phone number, enter the 10-digit number (area code plus the number). The system will format it accordingly.
   - For an international phone number, enter a plus sign (+) followed by the number, such as +33 (0) 158 58 0060.

8. To add or edit information for a second previous residence, follow these same steps to complete the Other previous residence section.

9. Click Save when you have completed entering or updating the person’s previous residence information.

When adding a new applicant, you will not be able to save and close the Previous residence tab until you have completed all required information on the Demographics tab. If this is the case, the Demographics tab is red and you must click the tab and complete the required information before saving and closing the applicant’s information.

Fields

Rental History

Has been evicted? If it is determined that the resident or applicant has been evicted, select this option.

Has been sued for rent? If it is determined that the resident or applicant has been sued for unpaid rent, select this option.
Has been sued for property damages?  If it is determined that the resident or applicant has been sued for property damages, select this option.

Has broken a lease?  If it is determined that the resident or applicant has ever broken a lease, select this option.

Previous Residence

Residence name  Add or edit the name (if any) of the last residence of applicant or resident.

Rent/Own/N/A  •  If the person rented this residence, click the Rent option.
               •  If the person owned this residence, click the Own option.
               •  If the person neither rented nor owned this residence, click N/A.

Address  Click the MAIN ST button to add or edit a previous residence address.

Rent amount  Enter or edit the amount of rent paid at the previous residence.

Move in  Enter the date the resident or applicant moved into the previous residence. This date can be edited, if necessary.

Move out  Enter the date the resident or applicant moved out of the previous residence. This date can be edited, if necessary.

Length of residency  OneSite calculates the length of time the resident or applicant lived at the previous residence. This is based on the move-in and move-out dates above and cannot be changed here.

Reason for leaving  Enter the reason why the resident or applicant moved out of the previous residence. This information can be edited.

Manager/contact  Enter the name of the manager (or contact) at the previous residence. The name can be edited.

(Phone or fax)  Enter the phone number and/or fax number of the manager or contact at the previous residence.
               •  For a U.S. phone number, enter the 10-digit number (area code plus the number). The system will format it accordingly.
               •  For an international phone number, enter a plus sign (+) followed by the number, such as +33 (0) 158 58 0060.

E-mail  Enter the e-mail address of the manager or contact person at the previous residence. This information can be edited.

Other Previous Residence

Residence name  Add or edit the name of an additional previous residence.

Rent/Own/N/A  •  If the person rented this residence, click the Rent option.
               •  If the person owned this residence, click the Own option.
               •  If the person neither rented or owned this residence, click N/A.
<table>
<thead>
<tr>
<th><strong>Address</strong></th>
<th>Click the <strong>MAIN ST</strong> button to add or edit an additional previous residence address.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rent amount</strong></td>
<td>Enter or edit the amount of rent paid at this previous residence.</td>
</tr>
<tr>
<td><strong>Move in</strong></td>
<td>Enter the date the resident or applicant moved into this previous residence. This date can be edited, if necessary.</td>
</tr>
<tr>
<td><strong>Move out</strong></td>
<td>Enter the date the resident or applicant moved out of this previous residence. This date can be edited, if necessary.</td>
</tr>
<tr>
<td><strong>Length of residency</strong></td>
<td>OneSite calculates the length of time the person lived at this previous residence. This is based on the move-in and move-out dates above and cannot be changed here.</td>
</tr>
<tr>
<td><strong>Reason for leaving</strong></td>
<td>Enter the reason why the resident or applicant moved out of the previous residence. This information can be edited.</td>
</tr>
<tr>
<td><strong>Manager/contact</strong></td>
<td>Enter the name of the manager (or contact) at this additional previous residence. The name can be edited.</td>
</tr>
<tr>
<td><strong>(Phone or fax)</strong></td>
<td>Enter the phone number and/or fax number of the manager or contact at this previous residence.</td>
</tr>
<tr>
<td>• For a U.S. phone number, enter the 10-digit number (area code plus the number). The system will format it accordingly.</td>
<td></td>
</tr>
<tr>
<td>• For an international phone number, enter a plus sign (+) followed by the number, such as +33 (0) 158 58 0060.</td>
<td></td>
</tr>
<tr>
<td><strong>E-mail</strong></td>
<td>Enter the e-mail address of the manager or contact person at this previous residence. This information can be edited.</td>
</tr>
</tbody>
</table>

### Entering an Address

1. To enter or change an address, click the **MAIN ST** button. The **Enter address** box displays.

2. Click the drop-down arrow beside the **Country** field and select the appropriate country. Different fields display, based on your selection:

   - **United States (default choice):** Enter the street address, city, state, and ZIP Code information.
   - **Canada:** Enter the street address (and apartment number, if any), city, province, and postal code information. The postal code is a six-character alphanumeric code in the format “ANA NAN,” where “A” represents an alphabetic character and “N” represents a numeric character. Alphabetic characters must be in uppercase. Here is an example of a valid Canadian postal code: M4B 1G5.
   - Other international address selections may provide country-specific address options or a standard three-line address.

When entering an international address, keep these guidelines in mind:
• You can enter information in each of the three address fields, but only the first and last fields are required.
• If the country has a postal code, enter this in the last address field.
• When selecting the country for this address, the drop-down list includes a large number of countries. To select the country quickly, enter the first letter of the country’s name. If there are multiple countries beginning with the same letter, press the TAB key until the correct country is selected.

3. Click OK.

4. For U.S. addresses only, the system verifies the address in the Address Broker database.
   • If the address is valid, no message displays.
   • **No address match found:** If the address is not found in the database, a message displays that no matching address was found. To use the address you typed, click Use this address. Or, correct the address in the message box first, if necessary, and then click Use this address.
   • **Confirm address:** If the Address Broker database finds a similar address that is not an exact match, a message displays asking you to confirm the address. The system displays the address found in the database along with the address you entered. Click Use this address for the appropriate address. (You can correct the address in the message box, if necessary.)

5. OneSite returns you to the parent page (where you clicked the MAIN ST button).

6. To ensure the address is saved, save the parent page.

### Fields

**Enter Address Box**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Country</strong></td>
<td>Click the drop-down arrow and select whether the address is in the United States, Canada, or another country. Different fields display, based on your selection:</td>
</tr>
<tr>
<td><strong>United States (default choice):</strong></td>
<td>Enter the street address, city, state, and ZIP Code information.</td>
</tr>
<tr>
<td><strong>Canada:</strong></td>
<td>Enter the street address, city, province, and postal code information. The postal code is a six-character alphanumeric code in the format “ANA NAN,” where “A” represents an alphabetic character and “N” represents a numeric character. Alphabetic characters must be in uppercase. Here is an example of a valid Canadian postal code: M4B 1G5.</td>
</tr>
<tr>
<td>Other international address selections may provide country-specific address options or a standard three-line address. International addresses are often entered for students studying in the United States whose parents or guarantors live in a foreign country. This address type lets you send guarantor letters and other correspondence, return the unit deposit, and/or mail the final account statement to a foreign address.</td>
<td></td>
</tr>
</tbody>
</table>
When entering an international address, keep these guidelines in mind:

- If presented with a standard three-line address, you can enter information in each of the three address fields, but only the first and last fields are required.
- If the country has a postal code, enter this in the last address field in a standard three-line address.
- When selecting the country for this address, the drop-down list includes a large number of countries. To select the country quickly, enter the first letter of the country’s name. If there are multiple countries beginning with the same letter, press the TAB key until the correct country is selected.

No Address Match Found

<table>
<thead>
<tr>
<th>Country</th>
<th>This is the country selected on the parent page or the Enter address box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address 1</td>
<td>This is the first line of the street address that was entered in the first address field on the parent page or the Enter address box.</td>
</tr>
<tr>
<td>Address 2</td>
<td>This is the second line of the street address that was entered in the second address field on the parent page or the Enter address box.</td>
</tr>
<tr>
<td>City</td>
<td>This is the city that was entered on the parent page or the Enter address box.</td>
</tr>
<tr>
<td>State</td>
<td>This is the state that was selected on the parent page or the Enter address box.</td>
</tr>
<tr>
<td>ZIP</td>
<td>This is the ZIP Code that was entered on the parent page or the Enter address box.</td>
</tr>
</tbody>
</table>

Address Found in Database (Confirm Address)

| Street | This is the street address found in the Address Broker database. |
| City | This is the city found in the Address Broker database. |
| State | This is the state found in the Address Broker database. |
| ZIP | This is the ZIP Code found in the Address Broker database. |

Address You Typed (Confirm Address)

| Address type | This is the country selected on the parent page or the Enter address box. |
| Address 1 | This is the first line of the street address that was entered in the first address field on the parent page or the Enter address box. |
| Address 2 | This is the second line of the street address that was entered in the second address field on the parent page or the Enter address box. |
| City | This is the city that was entered on the parent page or the Enter address box. |
State

This is the state that was selected on the parent page or the Enter address box.

ZIP

This is the ZIP Code that was entered on the parent page or the Enter address box.

Activities and Preferences

The Activities and preferences tab allows you to collect and manage information about the community activities that the person wants to participate in and any personal preferences. Activities are typically the social activities available at the community, such as bridge club, stretch class, or weekly shopping. These activities can change over time and are managed in Senior Living setup. Preferences include such things as preferred seating in the dining room or food and beverage preferences.

To complete the activities and preferences:

1. In the Activities section, select the check box for each activity that the applicant or resident is interested in. You can select as many activities as you need.
2. In the Preferences section, enter any information about the person’s preferences in areas not already captured in the Senior at a glance tabs.
3. Click Save when you have completed entering or updating the person’s activities and preferences.

When adding a new applicant, you will not be able to save and close the Activities and preferences tab until you have completed all required information on the Demographics tab. If this is the case, the Demographics tab is red and you must click the tab and complete the required information before saving and closing the applicant’s information.

Fields

Activities

Click the check box for each community activity that the person is interested in.

Preferences

Enter any notes or comments about the person’s personal preferences not already recorded in other areas.
Assessment History Tab

The Assessment history tab is where you will perform all applicant and resident assessments. Once you begin an assessment, you can monitor or manage its status here. This tab also keeps a log of each historical assessment that has been performed, which you can review at any time. For finalized and approved assessments, you can also print the summary and/or forms from the Assessments list.

For each assessment, the list shows its effective date (the date on which the assessment becomes effective), the reason for doing the assessment, the resident’s acuity score (if this is visible to staff at your community), the template used to perform the assessment, and its current status. In addition, the user name of the person who reviewed the final assessment and the result of that review (whether it was approved or rejected) are also shown.

Before You Begin

- Care management templates must be defined at the Templates option on the Setup page before you can perform an assessment for an applicant or resident.
- You can organize how the needs are listed at the Templates option on the Setup page. Needs can be listed in ascending order based on their score, or they can be organized manually.
- The Resident care management – General settings that you define in Setup control whether the resident’s assessment score is visible to staff here. These settings also determine whether staff can add resident-specific needs to an assessment (or select only those needs defined in the template) and whether staff can modify the task descriptions for an individual resident. This is also where assessment reviews are required and the mandated review period.
- Many of the tasks that you perform at the Assessment history tab and within the assessment itself are controlled by user roles and rights. In order to perform the tasks detailed in this area, you must have the following roles and/or rights assigned in user management.
  - **Add or edit an assessment**: This action is controlled by the “Allow the user to create a new assessment or edit an existing assessment” right. By default, this right is assigned to the Bookkeeper, Property Manager, Regional Property Manager, Resident Care Director, Executive Director, and Superuser roles.
  - **Customize an assessment**: There are a group of rights that allow people to customize the assessment on a resident-by-resident basis. Without these rights, staff can only select the categories, needs, and tasks provided in the care assessment template. By default, all of these rights are assigned to the Bookkeeper, Property Manager, Regional Property Manager, Resident Care Director, Executive Director, Reviewer, and Superuser roles. These rights include:
    - “Add a new need to assessment template”: Displays the New button above the Needs list in a resident assessment.
    - “Add a new task or edit a task to the selected need”: Displays the New button above the Tasks list when viewing the tasks associated with a given resident need.
• “Delete an existing task for the selected need”: Allows the user to remove a user-added task that is otherwise a default or required task for the selected resident need.
• “Delete the selected need in a resident assessment”: Allows the user to delete a user-added need from the Needs list.
• “ Deletes the selected task in a resident assessment”: Displays the Delete link for a user-added task in the Tasks for selected need(s) list of the resident assessment.

• **Finalize or approve an assessment**: This action is controlled by the “Allow user to finalize a resident’s assessment” right. If your property uses the review workflow, this right allows the user to finalize the assessment prior to review and to approve the assessment following the review. By default, this right is assigned to the Property Manager, Regional Property Manager, Resident Care Director, Executive Director, and Superuser roles.
• **Review and modify an assessment**: This action is controlled by the “Allow user to modify residents assessment based on review” right. If your property uses the review workflow, this right controls the review process. That is, only people with this right will have the option to Modify based on review when an assessment is in Pending review status. By default, this right is assigned to the Executive Director, Reviewer, and Superuser roles.
• **Personalize tasks**: This action allows a user to modify the instructions, notes, and scheduled time/shift for a task in a resident’s assessment. This option is only available when the assessment is in Final or (if your property uses the review workflow) Pending review status. This option is controlled by the “Personalize a task for a resident assessment” right. By default, this right is assigned to the Property Manager, Regional Property Manager, Resident Care Director, Executive Director, Reviewer, and Superuser roles.
• **Delete an assessment**: This action is controlled by the “Delete the resident assessment” right. By default, this right is assigned to the Property Manager, Regional Property Manager, Resident Care Director, Executive Director, Reviewer, and Superuser roles.
• **View or print the assessment Summary or Forms**: This action is controlled by the “Allow user to view or print the resident assessment” right, and makes the View link available for assessments in the Assessment history list. The View link does not open the full assessment detail page. By default, this right is assigned to the Property Manager, Regional Property Manager, Resident Care Director, Executive Director, and Superuser roles.
• **Accept/Reject/Modify care fee**: This action is controlled by the “Update the care fee charge” right. This right makes the Update status link visible for the care fee on the Care fee history tab for an assessment that has been finalized. By default, this right is assigned to the Bookkeeper, Property Manager, Regional Property Manager, Executive Director, and Superuser roles.

**How to Get Here**

Senior living ➔ View ➔ Assessment history

1. Click the Senior living tab.
2. Locate the applicant or resident you want to work with and click the View link for that resident or applicant.

3. At the Senior at a glance page, click the Assessment history tab.

Understanding Assessment Status and Workflow—Without Reviews

If your community is not using the required review workflow, the steps that an assessment goes through are quite simple and straightforward. This workflow covers tasks and statuses of both the resident assessment and then the care fee associated with that assessment. In Senior Living, the tasks and statuses are shown on two tabs: the Assessment history tab and the Care fee history tab. The following table illustrates each step in the process, as well as who can perform each step.

When a new assessment is started, you can save and resume your work at any time. The assessment remains In progress throughout this time. Once the assessment is completed, use the More – Finalize link to finalize the assessment. When the assessment is finalized, the system calculates the new care fee based on the assessed needs of the resident. The new care fee is added on the Care fee history tab with Pending status. There, you will use the Update status link to accept, modify, or reject the new care fee amount.

<table>
<thead>
<tr>
<th>Who can do it?</th>
<th>What you do</th>
<th>Assessment Status</th>
<th>Review Result</th>
<th>Care Fee Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bookkeeper</td>
<td>Begin a new assessment</td>
<td>In progress</td>
<td>(blank)</td>
<td>(no care fee exists)</td>
</tr>
<tr>
<td>• Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Resident Care Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Property Manager</td>
<td>Finalize the assessment</td>
<td>Final</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td>• Resident Care Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Bookkeeper</td>
<td>Update care fee status: accept or modify</td>
<td>Final</td>
<td>Approved</td>
<td>Accepted or Accepted*</td>
</tr>
<tr>
<td>• Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

© 2013 RealPage, Inc. Care Management uGuide 49
Who can do it?

<table>
<thead>
<tr>
<th>Manager</th>
<th>What you do</th>
<th>Assessment Status</th>
<th>Review Result</th>
<th>Care Fee Status</th>
</tr>
</thead>
</table>
| • Executive Director
| • Superuser      | Update care fee status: reject                | Final            | Approved       | Rejected        |

Modifying a care fee enables you to document a discount or surcharge for care fees. Any modifications you make are denoted by an asterisk (*) on the status in the care fee box. Modifications also appear on the Care Fee Change report.

If you reject the care fee, you must then begin another assessment in order to generate a new care fee. That is, when the assessment is finalized, a new care fee is created and the existing care fee is expired. If you reject the new care fee, the resident has no care fee at all until you create and approve a new assessment and then accept the new care fee.

Understanding Assessment Status and Workflow—with Reviews

If your community is using the required review workflow, the steps that an assessment goes through can be more complicated. Once the community staff complete the assessment, it is submitted for review, usually by a regional or corporate reviewer. The reviewer can approve or modify the assessment. If the assessment is modified, it must be finalized again. The workflow examples given below cover tasks and statuses of both the resident care assessment and then the care fee associated with that assessment, and involves tasks performed by both community and oversight staff. In Senior Living, the tasks and statuses are shown on two tabs: the Assessment history tab and the Care fee history tab. The following table illustrates each step in the process, as well as who can perform each step.

Scenario #1: Assessment Is Completed and Approved in Review

When a new assessment is started, you can save and resume your work at any time. The assessment remains In progress throughout this time. Once the assessment is completed, use the More – Finalize link to finalize the assessment. When the assessment is finalized, the system calculates the new care fee based on the assessed needs of the resident. The new care fee is added on the Care fee history tab with Pending status. The reviewer now reviews the assessment and care fee for accuracy. The reviewer can approve the assessment (as shown here) or modify the assessment (as shown in Scenario #2). Once the assessment is approved, property staff will use the Update status link to accept, modify, or reject the new care fee amount.
<table>
<thead>
<tr>
<th>Who can do it?</th>
<th>What you do</th>
<th>Assessment Status</th>
<th>Review Result</th>
<th>Care Fee Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bookkeeper</td>
<td>Begin or complete an assessment</td>
<td>In progress</td>
<td>(blank)</td>
<td>(no care fee exists)</td>
</tr>
<tr>
<td>• Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Resident Care Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| • Property Manager                       | Finalize the assessment          | Pending review    | (blank)           | Pending                      |
| • Resident Care Director                  |                                  |                   |                   |                              |
| • Regional Property Manager              |                                  |                   |                   |                              |
| • Executive Director                     |                                  |                   |                   |                              |
| • Superuser                               |                                  |                   |                   |                              |

| • Reviewer                               | Review and approve               | Final             | Approved          | Pending                      |
| • Executive Director                     |                                  |                   |                   |                              |
| • Superuser                               |                                  |                   |                   |                              |

| • Property Manager                       | Update care fee status: accept, or modify or Update care fee status: reject | Final | Approved | Accepted or Accepted* |
| • Regional Property Manager              |                                  |                   |                   |                              |
| • Executive Director                     |                                  |                   |                   |                              |
| • Superuser                               |                                  |                   |                   |                              |

**Scenario #2: Assessment Is Completed and Modified in Review**

When a new assessment is started, you can save and resume your work at any time. The assessment remains In progress throughout this time. Once the assessment is completed, use the More – Finalize link to finalize the assessment. When the assessment is finalized, the system calculates the new care fee based on the assessed needs of the resident. The new care fee is added on the Care fee history tab with Pending status. The reviewer now reviews the assessment and care fee for accuracy. The reviewer can approve the assessment (as shown in Scenario #1) or modify the assessment (as shown here).

When the reviewer chooses the Modify based on review option, the system opens the full assessment page, allowing the reviewer to change the needs and tasks currently assigned to the resident. The assessment must then be approved. Once the assessment is approved, community staff will use the Update status link to accept or reject the new care fee amount. The amount shown on the Care fee history tab reflects the amount calculated when the assessment was finalized. The new amount, reflecting the
modifications made by the reviewer, is not shown until you actually click the **Update status** link to accept or reject the care fee.

<table>
<thead>
<tr>
<th>Who can do it?</th>
<th>What you do</th>
<th>Assessment Status</th>
<th>Review Result</th>
<th>Care Fee Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bookkeeper</strong></td>
<td>Begin a new assessment</td>
<td>In progress</td>
<td>(blank)</td>
<td>(no care fee exists)</td>
</tr>
<tr>
<td><strong>Property Manager</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Resident Care Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regional Property Manager</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Executive Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Superuser</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Property Manager</strong></td>
<td>Finalize the assessment</td>
<td>Pending review</td>
<td>(blank)</td>
<td>Pending</td>
</tr>
<tr>
<td><strong>Resident Care Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regional Property Manager</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Executive Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Superuser</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Reviewer</strong></td>
<td>Modify based on review</td>
<td>Modified</td>
<td>In progress</td>
<td>Pending</td>
</tr>
<tr>
<td><strong>Executive Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Superuser</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Property Manager</strong></td>
<td>Approve</td>
<td>Final</td>
<td>Approved</td>
<td>Pending</td>
</tr>
<tr>
<td><strong>Resident Care Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regional Property Manager</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Executive Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Superuser</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Property Manager</strong></td>
<td>Update care fee status: accept, or modify</td>
<td>Final</td>
<td>Approved</td>
<td>Accepted</td>
</tr>
<tr>
<td><strong>Regional Property Manager</strong></td>
<td>or Update care fee status: reject</td>
<td></td>
<td></td>
<td>Accepted*</td>
</tr>
<tr>
<td><strong>Executive Director</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Superuser</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Scenario #3: Assessment Is Modified After Care Fee Is Accepted**

When a new assessment is started, you can save and resume your work at any time. The assessment remains In progress throughout this time. Once the assessment is completed, use the **More – Finalize** link to finalize the assessment. When the
Assessment is finalized, the system calculates the new care fee based on the assessed needs of the resident. The new care fee is added on the Care fee history tab with Pending status. The reviewer now reviews the assessment and care fee for accuracy. The reviewer can approve the assessment (as shown in Scenario #1) or modify the assessment (as shown in Scenario #2).

In this scenario, the community staff accept the care fee before the assessment has been approved. The reviewer then makes a subsequent change to the assessment, updating the status of the assessment and changing the calculated care fee amount. The previously accepted fee is deleted from the system and a new Pending care fee is added at the Care fee history tab. Once the assessment is approved, community staff will use the Update status link to accept or reject the new care fee amount.

<table>
<thead>
<tr>
<th>Who can do it?</th>
<th>What you do</th>
<th>Assessment Status</th>
<th>Review Result</th>
<th>Care Fee Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Bookkeeper</td>
<td>Begin a new assessment</td>
<td>In progress</td>
<td>(blank)</td>
<td>(no care fee exists)</td>
</tr>
<tr>
<td>• Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Resident Care Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Property Manager</td>
<td>Finalize the assessment</td>
<td>Pending review</td>
<td>(blank)</td>
<td>Pending</td>
</tr>
<tr>
<td>• Resident Care Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Reviewer</td>
<td>Modify based on review</td>
<td>Modified</td>
<td>In progress</td>
<td>Pending</td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Property Manager</td>
<td>Accept care fee</td>
<td>Modified</td>
<td>In progress</td>
<td>Accepted</td>
</tr>
<tr>
<td>• Regional Property Manager</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Reviewer</td>
<td>Modify based on review</td>
<td>Replaced</td>
<td>Change needed</td>
<td>Pending</td>
</tr>
<tr>
<td>• Executive Director</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• Superuser</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Who can do it? | What you do | Assessment Status | Review Result | Care Fee Status
---|---|---|---|---
• Property Manager  
• Resident Care Director  
• Regional Property Manager  
• Executive Director  
• Superuser | Approve | Final | Approved | Pending

• Property Manager  
• Regional Property Manager  
• Executive Director  
• Superuser | Update care fee status: accept  
or  
Update care fee status: reject | Final | Approved | Accepted

Final | Approved | Rejected

### Approving an Assessment

After reviewing the assessment and determining that it is correct, the reviewer is ready to approve the assessment. This step is only performed if your community uses the assessment review workflow.

1. Locate the completed assessment in the **Assessments** list. This can be an assessment with one of the following two statuses:
   - **Pending review**: This is an assessment that was completed and finalized and is awaiting initial approval.
   - **Modified**: This is an assessment that was completed and finalized and then modified by the reviewer.

2. Click the **More** link and choose the **Approve** option. The **Status** is updated to **Final** and the **Result** is updated to **Approved**. The next step in the process is to review and accept the newly calculated care fee on the **Care fee history** tab.

You can also approve an assessment from the **Assessment summary** page by clicking the **View** link. (See **Reviewing or Printing an Assessment** (on page 75) for detailed information on this option.)

### Deleting an Assessment

You should only delete an assessment if you created the assessment by mistake (for the wrong resident, for example) or if you made a mistake that you cannot correct at the **Assessment** page. For example, if you selected the wrong type of assessment or entered the wrong **Effective date**, you must delete the assessment and start again.
You can delete an assessment in any status. If you delete an assessment after the care fee based on that assessment has been accepted, the system automatically deletes the care fee as well.

To delete an assessment:

1. On the resident’s Assessment history tab, locate the assessment you want to delete.
2. Click the More link and select the Delete option.
3. When asked to confirm the deletion, click Delete. The Assessments list refreshes and the assessment is removed.

Finalizing an Assessment

When the resident assessment is complete and correct, you are ready to finalize the assessment.

1. Locate the completed assessment in the Assessments list. This will be an assessment with In process status.
2. Click the More link and choose the Finalize option.

   If your property does not use the review workflow, the Status is updated to Final and the Result is updated to Approved. The next step in the process is to review and accept the newly calculated care fee on the Care fee history tab.

   If your community uses the review workflow, the Status is updated to Pending review and the Result is still blank. The next step in the process is for the reviewer to review and approve the assessment.

You can also finalize an assessment from the Assessment summary page by clicking the View link. (See Reviewing or Printing an Assessment (on page 75) for detailed information on this option.)
Fields

**Actions**

Use these actions to manage the resident’s existing assessments. The options vary depending on the status of the assessment and your setup in user management:

- **View**: Use this option to open any assessment and review or print the summary and forms.
- **More – Edit**: Use this option to open an assessment that has not yet been approved. This allows you to review and modify the current needs and tasks in the assessment.
- **More – Finalize**: Use this option to change an In progress assessment to Final.
- **More – Delete**: Use this option to delete any assessment.
- **More – Modify based on review**: If your community uses the review workflow, this is the option the reviewer uses to open and update the resident’s assessment. This option is only visible to people set up as reviewers and only when the assessment is in Pending review or Modified status.
- **More – Approve**: If your community uses the review workflow, this is the option you use to finalize an assessment that has been modified by the reviewer. This option is only visible when the assessment is in Modified or Replaced status.
- **More – Personalize tasks**: If your community uses the review workflow, the reviewer can use this option to modify the description, notes, inclusion on assignment sheets flag, and time/shift assignment for a task. This option is only visible to people set up as reviewers and only when the assessment is in Final status.

**Effective date**

This is the effective date of the assessment, usually the day on which the assessment was performed or begun.

**Reason**

This is the reason the assessment was performed, identifying it as an initial assessment, a periodic assessment, or a change of condition assessment.

**Score**

If your property displays the calculate care score, that score is shown here.

**Template**

This is the name of the care management template that was used to perform the assessment.
### Status

This column identifies the current status of the assessment:

- **In progress**: This status identifies an assessment that has been started, but has not yet been completed.
- **Pending review**: If your community uses the review workflow, this is the status of the assessment after it has been finalized and is awaiting review and approval.
- **Modified**: If your community uses the review workflow, this status indicates that the assessment was changed during the review process. It must now be approved again.
- **Replaced**: If your community uses the review workflow, this status identifies a prior assessment that was modified after the initial care fee was accepted. It must now be approved again.
- **Final**: If your community does not use the review workflow, this status indicates that the person performing the assessment has completed it and finalized it. If your property uses the review workflow, this assessment has been reviewed and approved.

### Review result

This column identifies the result of the review:

- **(blank)**: While the assessment is In progress, the result is blank.
- **Approved**: If your community does not use the review workflow, the result is Approved once the assessment is finalized. If your property does use the review workflow, the result is not Approved until a reviewer approves it.
- **Change needed**: If your community uses the review workflow, the assessment gets a Change needed result when a reviewer modifies the assessment after the care fee has been accepted. This result indicates that the assessment must be approved again and the new care fee accepted.

### Review by

Once the assessment has been finalized, approved, or modified, this column identifies the user name of the person who took the last of those actions.

## Creating a New Assessment

1. At the **Assessment history** tab, click the **Assess** button above the **Assessments** list.

   If the community is integrated with QuickMAR, then an alert displays when action is needed in the QuickMAR application. The alert is informational only. You can still do an assessment for the resident.

2. In the **New assessment** box, click the drop-down arrow in the **Reason** field to identify the type of assessment you are creating. Choose one of the following options:
• **Pre-assessment**: This type of preliminary assessment is done for applicants, prior to moving in to the property. This is the only option available for applicants and is not available for residents.

• **Initial assessment**: Use this reason for the first, full assessment after the resident moves in.

• **Change of condition**: If there is a change in the resident’s medical condition that necessitates a change in care, complete a change of condition assessment.

• **Periodic assessment**: Use this reason when completing a scheduled follow-up assessment not necessitated by a change in the resident’s medical condition.

3. Enter the **Effective** date of the assessment. This is normally the date on which the resident’s needs are assessed. The **Effective** date defaults to the current system date. Depending on how your user ID is set up in user management, you may be able to change this date within 30 days before or after the current date.

4. Select one of the following methods of creating the assessment:

   • **Previous assessment**: If this is not the resident’s first assessment and if you want to use the same assessment template as used in a previous assessment, select this option. Then, select the previous assessment that you want to use. When you use this method, the system creates the new assessment already filled out with the previous assessment’s needs and tasks. All categories completed in the previous assessment will show as completed in the new assessment, even before you have reviewed or adjusted the assessment needs.

   If you begin with a previous assessment, changes made to the template will not be reflected in the new assessment. If changes have been made to the template since the last assessment using that template, you should begin with a new, blank template in order to see those changes.

   • **New, blank template**: If this is the first assessment or if you need to use an assessment template that has not been used with this resident previously, select this option. Then, click the drop-down arrow in the **Template** field and select the assessment template you want to use. When you use this method, the system creates a new, blank assessment.

5. Click **Save** to create the new resident assessment.

6. Complete the steps in the **Completing an Assessment** (on page 61) procedure.
Chapter 2: Senior at a Glance

Fields

Reason
This is the reason the assessment was performed. Select one of the following options:

- **Pre-assessment**: This type of preliminary assessment is usually done for applicants, prior to moving in to the property.
- **Initial assessment**: Use this reason for the first, full assessment after the resident moves in.
- **Change of condition**: If there is a change in the resident’s medical condition that necessitates a change in care, complete a change of condition assessment.
- **Periodic assessment**: Use this reason when completing a scheduled follow-up assessment not necessitated by a change in the resident’s medical condition.

Effective
This is the effective date of the assessment, usually the day on which the assessment was performed or begun.

Create from
Choose one of the following methods for creating the new resident assessment:

- **Previous assessment**: If this is not the resident’s first assessment and if you want to use the same assessment template as used in a previous assessment, select this option. Then, select the previous assessment that you want to use. When you use this method, the system creates the new assessment already filled out with the previous assessment’s needs and tasks.
- **New, blank template**: If this is the first assessment or if you need to use an assessment template that has not been used with this resident previously, select this option. Then, click the drop-down arrow in the Template field and select the assessment template you want to use. When you use this method, the system creates a new, blank assessment.

Template
If you chose the option to start from a new, blank template, click the drop-down arrow and select the template you want to use.

Assessment – Select
If you chose the option to start from a previously used template, select the assessment you want to use.

Assessment – Reason
If you chose the option to start from a previously used template, this column shows the reason for each prior assessment.

Assessment – Date
If you chose the option to start from a previously used template, this column shows the effective date of each prior assessment.

Assessment – Template
If you chose the option to start from a previously used template, this column shows the template used for each prior assessment.
Assessment – Active
If you chose the option to start from a previously used template, this column shows whether the template used in the prior assessment is currently active or not. A green check mark indicates that the template is active and can be used. A red X indicates that the template is inactive and should not be used.

The Assessment Page
The Assessment page provides all of the information about the resident assessment at a glance. The page is divided into three major sections: the capabilities, the needs, and the tasks. To complete or review an assessment, select any of the categories of capabilities, and then select the appropriate needs and tasks for that category. Repeat this process for each capability.

a) Select a category to work with.
b) Click the plus to expand a section and show the list of categories. Click the minus sign to collapse the list.
c) For the currently selected category (a, above), this is the list of possible resident needs. For example, this list shows all of the needs a resident might have in the Grooming category. Depending on how you are set up in user management, you may be able to modify the needs or add new needs to this list.
d) Here, you simply select the appropriate need or needs. (Some categories allow multiple selections, while some allow only one, depending on how the category is set up in the assessment template.)

e) Once you have selected one or more needs, the care tasks associated with the needs appear here. Depending on how you are set up in user management, you may be able to modify or personalize the tasks shown here, or even add and delete tasks associated with the need. You may add instructions to tasks, if desired.

f) For each category, you can add specific notes for this resident and this assessment.

### Completing an Assessment

To perform an assessment:

1. To access an In progress assessment, locate the assessment in the Assessments list on the resident’s Assessment history tab, click the More link, and choose the Edit option.

2. On the left side of the page, click the plus sign for the assessment section you want to begin with. This does not have to be the first section in the assessment.

3. Once the categories or capabilities are shown, select the first category on the left side of the page. The Needs for this category appear in the list at the top of the right side of the page.

   For each need in the list, you see the description of the need and the expected result for the resident. The * (asterisk) column tells you whether the need is a default option coming in from the assessment template (“T”) or a user-added need for this specific resident (“U”). Finally, if your community is set up to display the score associated with each need, that score is shown for each option in the list.

   Note that, if you created this assessment from a previous assessment, the new assessment will reflect the completed selections from the previous assessment. That is, the categories on the left side of the page will be checked as completed before you begin.

4. Review the list of needs and select the options that best describe the resident’s needs in this category. These options describe the resident’s needs in this particular area, and usually cover a fairly broad range of needs, from requiring no assistance to requiring full assistance. There are two kinds of choices here.

   - This type of option means that you must select only one of the listed needs. That is, each choice is mutually exclusive of all of the other choices. Choose the option that applies best.

   - A check box option means that you can choose more than one of the listed needs. Choose all of the needs that apply to the resident.

   Depending on how your user ID is set up in user management, you may have one or more of the following options that allow you to customize the resident’s needs:
• **New:** If there is a **New** button at the top of the **Needs** list, you can add a need to this category that is specific to this resident.

• **More – Create copy:** This option also allows you to create a new need in this category by copying and changing one of the needs already listed.

• **More – View tasks:** This option allows you to review the list of tasks associated with any listed need. There, you can add new tasks specific to this resident or customize the template tasks for this resident.

• **More – Update care fee inclusion:** This option opens the definition of the listed need, where you can modify the need description, the expected result, or the care fee calculation flag.

5. When you choose one or more needs in the category, the system displays all of the **Tasks for the selected need(s)** beneath the **Needs** list. These are the things that property staff must do to meet the resident’s needs, as defined in the care assessment template you are using.

For each task in the list, you see the description, instructions, and notes for the task, as well as responsible party the task is assigned to and the scheduled frequency. The * (asterisk) column tells you whether the task is a default option coming in from the assessment template (“T”), a required task that can’t be deleted (“D”), a task that has been modified for this resident (“Δ”), or a task that has been added for this resident (“U”).

6. Depending on how your user ID is set up in user management, you may be able to edit the care tasks using the **Edit** link in the tasks list. This option opens the definition of the listed task, where you can modify the task description, instructions, notes, responsible party, number of people required to perform the task, the care fee calculation flag, or the task schedule.

7. If you want to record any notes or comments about the resident’s assessed needs in this category, enter that information in the **Notes** field at the bottom of the right side of the page. Notes are used internally and do not appear on reports.

8. Repeat steps 2-6 for each category in the first section.

9. Then, repeat this whole process for each section in the assessment.

10. When you have finished assessing all categories in all sections, click the **Save changes** button at the top of the page.

It is a good practice to save your changes periodically as you work through the categories and sections rather than waiting until you have completed the full assessment.

If you cannot complete all categories and sections at the same time, you can save your work and close the **Assessment** page. You can then resume the assessment at a later time. The assessment will remain in In progress status until you have completed and finalized it.

**Instructions** on tasks are useful for caregivers and other responsible parties. You can enter details here that will print on assignment sheets and **Individualized Service Plan** reports. **Notes** are internal tools and are not printed.
Fields

**Page Heading**

**Assessment**
This is the effective date of the assessment that you are working with. In general, this is the date on which the assessment was performed.

**Service plan – (category)**
This area identifies the category of capabilities or needs that you are working with. As you move through the various sections and categories in the assessment, this label changes to show the category you are currently in.

**Score**
If your community is set up to show the resident’s score during an assessment, the accumulative score for the category you are working with is shown in the upper-right corner of the page. This score changes as you add and remove resident needs and tasks during the assessment and as you move among different categories.

**Sections/Categories**

**Section**
The assessment sections are identified by the folder icons and their bold text labels. Each section is a group of similar or related categories. The sections that appear in the assessment are those defined by your community in the assessment template, but most templates have more than one section. Click the plus sign to open the section folder and see its categories. This score changes as you add and remove resident needs and tasks during the assessment. Click the minus sign to collapse the section and hide its categories.

**Category**
The assessment categories are identified by their plain text labels (with no folder icon and no plus/minus sign). Each category identifies a particular resident capability that you will assess. These generally include both daily life tasks (such as dressing and grooming) as well as medical needs (such as breathing treatments or wound care). The categories that appear in the assessment are those defined by your property in the assessment template, and can be very different from one template to the next. Click a category to select it and display the possible resident needs in this category in the Needs list on the right side of the page.

**Score**
If your property is set up to show the resident’s score during an assessment, the accumulative score for the full assessment you are working with is shown beneath the list of sections and categories. This score changes as you add and remove resident needs and tasks during the assessment.
Needs

<table>
<thead>
<tr>
<th>Actions</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View</strong></td>
<td>Use this option to view the definition of the need: its section, category, description, and expected result. This is the same information shown on the main <strong>Assessment</strong> page and cannot be changed here.</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td>This option appears only for needs that were added or modified for this resident. Use this option to open the definition of the need, where you can change the need description, expected result, or care fee inclusion flag.</td>
</tr>
<tr>
<td><strong>More – View tasks</strong></td>
<td>Use this option to open the <strong>Tasks</strong> list for this need, that is, a list of all of the tasks that must be performed for residents with the need you are working with. From the <strong>Tasks</strong> list, you can add new tasks for this resident or modify the tasks that come in from the template.</td>
</tr>
<tr>
<td><strong>More – Create copy</strong></td>
<td>Use this option to create a copy of the selected need and add it to the list. Then, use the <strong>Edit</strong> link to modify the new need. This is a quick way to add a resident-specific need that is similar to an existing need.</td>
</tr>
<tr>
<td><strong>More – Update care fee inclusion</strong></td>
<td>Use this option to open the definition of the need, where you can change the need description, expected result, or care fee inclusion flag.</td>
</tr>
</tbody>
</table>

(Select) Select the item or items that best describe the resident’s needs in this category.

- This type of option means that you must select only one of the listed needs. That is, each choice is mutually exclusive of all of the other choices. Choose the option that applies best.

- A check box option means that you can choose more than one of the listed needs. Choose all of the needs that apply to the resident.

* This one-letter code identifies whether the listed needs have been modified for this resident or are taken directly from the assessment template.

- **T**: The need definition matches the definition in the assessment template.

- **U**: The need has been added or modified for this specific resident.

Need This is the description of the resident’s need.
Chapter 2: Senior at a Glance

Expected result  This is the expected outcome of this need. That is, if the associated tasks are performed, this is the result that should occur.

Score  If your property is set up to show the resident’s score during an assessment, this column shows the number of points associated with each need. This score is based on the staff time and frequency of the tasks associated with the need.

Tasks for Selected Need(s)

Actions  Depending on how you are set up in user management, you may have one or more of the following options to manage the tasks associated with the needs you have selected for this resident:

- **Edit:** Use this option to open the definition of the task, where you can change the task description, instructions, notes, responsible party, number of people required, care fee exclusion flag, and the task schedule.

- **Delete:** This option only appears for tasks that you have added or customized for this resident. When you delete a customized task, the system returns the default version of the task from the template.

*  This one- or two-character code identifies whether the listed tasks have been modified for this resident or are taken directly from the assessment template.

- **T:** The need definition matches the definition in the assessment template.

- **D:** This task is marked as required in the template and cannot be changed or deleted.

- **Δ:** This symbol identifies a task from the template that has been modified for this resident.

- **U:** The need has been added or modified for this specific resident.

Description  This is the description of the task.

Instructions  These are the specific instructions to the staff on how to complete the task.

Notes  If there are additional notes about this task, they display here.

Responsible party  This is the responsible party group that is assigned to perform the task. Click this link to see the scheduling details (including the frequency, duration, number of times per day, and shift/time assignments).

Frequency  This column shows the frequency of the task (daily, weekly, monthly, etc.).

Notes  If you want to add specific notes about the needs and/or tasks in this category for this resident, enter that information in the Notes field.
Adding or Changing a Resident Need

1. To begin:
   - To add a new need for this resident in this assessment category, click the New button above the Needs list.
   - To modify an existing need for this resident, click the More link and select the option to Update care fee inclusion.

2. In the resident need definition box, the system shows the resident name in the box heading. Below that, the section and category of the need are shown. When modifying an existing need, the section and category that you are working with displays for reference. When adding a new resident need, these fields are blank, but will be filled in by the system with the section and category you are working with when you save the need.

3. The Need field is the description or name of the need. When modifying a need brought in from the template, this is the descriptive name defined in the template. Modify this description as needed. When adding a new need, enter the descriptive name of the need.

4. The Expected result of this need is the desired outcome for the resident. When modifying a need brought in from the template, this is the result defined in the template. Modify this description as needed. When adding a new need, enter the expected result or outcome of the need.

5. If you want tasks associated with this need to be omitted when calculating the resident’s care fee, select the option to Exclude from care fee calculation.

6. To continue, perform one of the following:
   - Click Save. The system returns you to the category detail where the need appears in the Needs list.
   - Click Save and view tasks. The system opens the Tasks list for the need where you can create or modify the tasks associated with the need. When finished, click Close to return to the resident Assessment page. The need is shown in the Needs list.

Deleting a Resident Need

If you add a need to a resident assessment by mistake, you can delete that need. This is more of a housekeeping issue than an assessment issue. If the assessment includes unnecessary or redundant needs, there is no impact on the resident’s care or billing unless that need is selected for the resident.

Only user-added needs can be deleted. Needs defined for the assessment category in the template cannot be deleted.

1. To delete a need from the list of available needs in a particular assessment category, locate the need in the Needs list.

2. Click the More link and then select the Delete option.
3. Click **Delete** again when asked to confirm the deletion. The system removes the need from the **Needs** list.

**Fields**

<table>
<thead>
<tr>
<th>Needs Section</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Need display order</strong></td>
</tr>
<tr>
<td>Use this option to organize how the needs are listed when generating a resident assessment. You can choose the <strong>User defined</strong> option to manually select the needs order. The <strong>Score</strong> option will list needs based on their score.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Need Box</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Section</strong></td>
</tr>
<tr>
<td>This is the section that the need is assigned to. The section is shown for reference, to ensure that you are working in the section you need to work in.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
</tr>
<tr>
<td>This is the name of the category that the need is assigned to. The category is shown for reference, to ensure that you are working in the category you need to work in.</td>
</tr>
<tr>
<td><strong>Need</strong></td>
</tr>
<tr>
<td>Enter a description of the resident need for this category.</td>
</tr>
<tr>
<td><strong>Expected results</strong></td>
</tr>
<tr>
<td>Enter the expected result for this need.</td>
</tr>
<tr>
<td><strong>Exclude from care fee calculation</strong></td>
</tr>
<tr>
<td>If you want all tasks associated with this need to be excluded from the care fee calculation, select this option.</td>
</tr>
</tbody>
</table>

**Copying an Existing Need**

To add a new need for this resident by copying an existing need, complete these steps. This is often a faster way to create a new resident-specific need, as it allows you to start from a similar need and then make the changes you want.

1. In the **Needs** list, select the need that is most similar to the one you want to create.
2. Click the **More** link and select the option to **Create copy**. OneSite creates an exact copy of the need, except that the copy is identified as a user-added need (with a “U” in the * column).
3. Locate the copied need, and click the **Edit** link to open the need definition.
4. Modify the need description, expected result, and care fee exclusion flag as needed to reflect your new need. (See **Adding or Changing a Resident Need** (on page 66) for detailed instructions on modifying a need.)
5. If the new need has care tasks associated with it, click the **Save and view tasks** button. When you copy a need, OneSite does not copy any tasks set up for that need, so you must define the tasks for your new need yourself. Add any needed tasks at the **Tasks** list, and click **Close** to return to the resident assessment. (See **Managing the Tasks Associated with a Resident Need** (on page 68) for detailed instructions on working with the tasks list.)

If the new need does not have any care tasks, click the **Save** button to return to the resident assessment.
Managing the Tasks Associated with a Resident Need

Unless a resident need requires no action on the part of staff, each need in an assessment category will have one or more tasks that someone will perform to meet that resident need. When completing a resident assessment, the tasks associated with a given need are shown in the Tasks for selected need(s) list for any task you have selected. By default, these are the tasks defined for the selected needs in the assessment template. If you are set up in user management with the necessary rights, you have the option of modifying these tasks for specific residents, including the ability to add new tasks, delete user-added or modified tasks, or change the definition of existing tasks. You can also revert the tasks back to those defined in the template.

To manage the tasks defined for a particular resident need:

1. At the Assessment page, locate the need you want to work with.
2. Click the More link and select the View tasks option.
3. The system opens the resident’s Tasks page, where all of the tasks associated with this need are listed.

   The category, need, and expected result that you are working with appear at the top of the View tasks page for reference. If your property shows the resident’s score during the assessment, the total score for the tasks for this need also appears in the page heading. Below this, the Tasks list shows the description, instructions, and notes for each task set up for this need. It also indicates who is responsible for performing the task and how long it should take, as well as the scheduled frequency and shift. The * (asterisk) indicator column identifies whether the task definition matches the template definition or has been modified, is required in the template (and cannot be deleted), or is user-added for this specific resident.

4. Perform one of the following actions to customize the tasks for this resident:
   
   - To modify an existing task, click the Edit link and then change the task definition as needed.
     
     A task from a template, a task altered from a template, and a task added by the user can be edited. A default task from a template CANNOT be edited.
     
   - To add a new task, click the New button above the Tasks list and define the task.
     
     See Adding or Changing a Task (on page 70) for detailed instructions on performing this step.
     
   - To delete a task that you added or customized, click the Delete link. If the Delete link is not available, the task cannot be deleted from the resident’s assessment.
     
     A task from a template, a task altered from a template, and a task added by the user can be deleted. A default task from a template CANNOT be deleted.
     
     See Deleting a Resident Task from the Tasks List (on page 73) for detailed instructions on performing this step.
• If the resident’s tasks have been customized, the system displays a link View template tasks above the Tasks list. Click this link to show the Tasks originally defined in the template for this need.

Alternatively, you can return to the customized tasks by clicking the check box for one or more of the template tasks and then clicking the Restore selected tasks button at the bottom of the page.

That is, the View template tasks link and the Restore selected tasks button allow you to toggle between the standard and customized tasks for this need.

5. Once the tasks for this resident need are correct, click the Close button to return to the resident assessment.

It is critical that the information in the task definition is correct. This is ultimately what determines how resident care fees are calculated and how staff assignments are created.

### Fields

**Category**
This is the name of the category that the tasks are assigned to. The category is shown for reference, to ensure that you are working in the category you need to work in.

**Need**
This is the need that the tasks are assigned to. The need is shown for reference, to ensure that you are working in the need you need to work in.

**Score**
When working with the tasks associated with a specific resident’s assessment, the system displays the current score for the tasks associated with this resident’s needs. This is only shown if your property is set up to display the care assessment score.

**Expected results**
This is the expected result for this need.

### Tasks List

**Actions**
The Actions column provides the following options to review and manage your resident care tasks:

- **Edit**: Select this option when you want to review or change a task.

- **Delete**: Select this option to delete a task. When working in the assessment template, this action removes the task from this template and from any staff assignments. When working with a resident assessment, this action removes the task only from this resident’s assessment.
* (asterisk) This status indicator identifies how this task is defined.
  - D indicates that the task is a default, required task for this need and cannot be deleted from a resident’s assessment.
  - E indicates that the task is excluded from the care fee calculation.
  - T indicates that the task is a template tasks. (All tasks in the template are noted as T-tasks.)
  - U indicates that the task is a user-added task. This status only appears when working with tasks in a resident assessment, not with tasks in the template.
  - Δ indicates that a template task was modified by the user. This status only appears when working with tasks in a resident assessment, not with tasks in the template.

Print This column shows “Yes” or “No,” indicating whether the task will be printed on staff assignment sheets. This column only appears when working with the care tasks in the template.

Description This is the description of the task.

Instructions These are the instructions entered for the task, if any.

Notes These are the notes entered for the task, if any.

Responsible party This is the responsible party or group this task is assigned to.

Frequency This column identifies how often this task must be performed.

Minutes This column identifies how long it takes to complete this task.

Scheduled This column identifies whether the task is assigned to a shift or to a specific time.

### Adding or Changing a Task

1. Enter or modify the description of the task in the Description box.
2. Enter or modify any Instructions needed for completing this task. Instructions will display on the Individualized Service Plan report and assignments.
3. Enter or modify any Notes for the task.
4. Click the drop-down arrow in the Responsible party field and select the person or role who will perform this task. The options available here are the ones defined at the Responsible parties option in Staff setup.
5. If you want this task to Print on staff assignment sheets, select this option.
6. In the Task requires field, enter the number of people needed to perform this task.
7. If you want to make this task required for any resident who has the selected need, select the Default task option. In this case, the task is always selected for this need and cannot be changed during the assessment. If you do not select this option, staff with the appropriate rights assigned to them in user management will be able to delete the task from a resident’s assessment.
8. If you want this task to be omitted when calculating the resident’s care fee, select the option to **Exclude from care fee calculation**.

9. On the right side of the page, define the scheduling for the task in the *Schedule* section. First, choose the **Frequency** for this task. That is, how often does this task need to be completed? You can schedule a task to be completed hourly, daily, weekly, monthly, or annually.

10. Then, complete the remaining options in the *Schedule* section. These options change depending on the **Frequency** you choose. Once you have scheduled the task, click **Save** to add the task.

   **Hourly:** To schedule an hourly task, complete the following steps:
   
   - In the **Duration** field, enter the number of minutes it should take to complete this task. The duration must be less than an hour.
   - Complete the **Start time** and **End time** fields to define the period during which this task should be performed.
     
     For example, you might schedule an hourly task to be performed once an hour between 7:00 A.M. and 7:00 P.M.

   **Daily:** To schedule a daily task, complete the following steps:
   
   - In the **Duration** field, enter the number of minutes it should take to complete this task. The maximum duration that you can enter is 720 minutes, or 12 hours. If a task requires more time than this, you must schedule it as a multi-day task with the number of minutes per day entered here.
   - Click the drop-down arrow in the **Repeat every** field and select how often the task should be performed. That is, to schedule a task for every day, enter “1.” To schedule a task for every other day, enter “2.”
   - Next, choose how many **Times per day** the task should be performed.
   - Select one of the following options to define how you want this task scheduled:
     
     - **Specific time:** Select this option to schedule a task for a specific time (or times). When you choose this option, you must also specify the **Time(s)**. The number of times that you define is based on the **Times per day** you selected.
     - **Shift:** Select this option to schedule a task for a shift rather than a specific time. Again, you must select as many **Shifts** as you entered in the **Times per day**. The options that you choose from are those you have set up at the **Shifts** option in **Staff** setup.

   **Weekly:** To schedule a weekly task, complete the following steps:
   
   - In the **Duration** field, enter the number of minutes it should take to complete this task. The maximum duration that you can enter is 720 minutes, or 12 hours. If a task requires more time than this, you must schedule it as a multi-day task with the number of minutes per day entered here.
   - Click the drop-down arrow in the **Repeat every** field and select how often the task should be performed. That is, to schedule a task for every week, enter “1.” To schedule a task for every other week, enter “2.”
   - Next, choose how many **Times per day** the task should be performed.
   - Select one of the following options to define how you want this task scheduled:
- **Specific time:** Select this option to schedule a task for a specific time (or times). When you choose this option, you must also specify the **Time(s).** The number of times that you define is based on the **Times per day** you selected.

- **Shift:** Select this option to schedule a task for a shift rather than a specific time. Again, you must select as many **Shifts** as you entered in the **Times per day.** The options that you choose from are those you have set up at the **Shifts** option in **Staff** setup.

- Select the **Day(s) of week** that this task should be performed.

**Monthly:** To schedule a monthly task, complete the following steps:

- In the **Duration** field, enter the number of minutes it should take to complete this task. The maximum duration that you can enter is 720 minutes, or 12 hours. If a task requires more time than this, you must schedule it as a multi-day task with the number of minutes per day entered here.

- Click the drop-down arrow in the **Repeat every** field and select how often the task should be performed. That is, to schedule a task for every month, enter “1.” To schedule a task for every other month, enter “2.”

- Select one of the following options to define how you want this task scheduled:
  - **Specific time:** Select this option to schedule a task for a specific time (or times). When you choose this option, you must also specify the **Time(s).**
  - **Shift:** Select this option to schedule a task for a shift rather than a specific time. Again, you must select as many **Shifts** as you entered in the **Times per day.** The options that you choose from are those you have set up at the **Shifts** option in **Staff** setup.

- Select one of the following **Day(s) in month** options to define when the monthly task will be scheduled:
  - **By numeric day of month:** Select this option to schedule a task for one or more specific dates in the month, such as the first or the fifteenth. The system displays a calendar page where you click the numbered day. You can select as many days as you need.
  - **By weekday:** Select this option to schedule a task based on the day of the week, such as the first and third Wednesday of the month. The system displays a calendar page where you click the day. You can select as many days as you need.

**Annually:** To schedule an annual or yearly task, complete the following steps:

- In the **Duration** field, enter the number of minutes it should take to complete this task. The maximum duration that you can enter is 720 minutes, or 12 hours. If a task requires more time than this, you must schedule it as a multi-day task with the number of minutes per day entered here.

- Click the drop-down arrow in the **Repeat every** field and select how often the task should be performed. That is, to schedule a task for every year, enter “1.” To schedule a task for every other year, enter “2.”

- Next, choose how many **Times per day** the task should be performed.

- Select one of the following options to define how you want this task scheduled:
**Chapter 2: Senior at a Glance**

- **Specific time**: Select this option to schedule a task for a specific time (or times). When you choose this option, you must also specify the **Time(s)**. The number of times that you define is based on the **Times per day** you selected.

- **Shift**: Select this option to schedule a task for a shift rather than a specific time. Again, you must select as many **Shifts** as you entered in the **Times per day**. The options that you choose from are those you have set up at the **Shifts** option in **Staff** setup.

- Select one or more **Month(s)** in which this task should be performed.

- Select one of the following **Day(s) in month** options to define when the annual task will be scheduled:
  
  - **By numeric day of month**: Select this option to schedule a task for one or more specific dates in the month, such as the first or the fifteenth. The system displays a calendar page where you click the numbered day. You can select as many days as you need.
  
  - **By weekday**: Select this option to schedule a task based on the day of the week, such as the first and third Wednesday of the month. The system displays a calendar page where you click the day. You can select as many days as you need.

**Deleting a Resident Task from the Tasks List**

If you add a task to a resident assessment by mistake, you should delete that task. If the task is associated with a need selected for the resident, that task will be part of the resident’s assessment and will be included in staff assignments. Depending on how the need and task are defined, it could also affect the resident’s care fee.

1. To delete a need from the list of available needs in a particular assessment category, locate the need in the **Needs** list.
2. Click the **More** link and then select the **Delete** option.
3. Click **Delete** again when asked to confirm the deletion. The system removes the need from the **Needs** list.

User-added tasks can also be deleted directly from the resident’s **Assessment** page by using the **Delete** option in the **Tasks for selected need(s)** list.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Need</strong></td>
<td>This is the resident need that the task is assigned to.</td>
</tr>
<tr>
<td><strong>Expected result</strong></td>
<td>This is the expected result for the resident need.</td>
</tr>
<tr>
<td><strong>Task</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description of the task to be performed.</td>
</tr>
<tr>
<td><strong>Instructions</strong></td>
<td>Enter any specific instructions about performing the task.</td>
</tr>
<tr>
<td><strong>Notes</strong></td>
<td>Enter any notes or comments about the task.</td>
</tr>
</tbody>
</table>
Responsible party
Select the responsible party group that will perform this task.

Print on assignment sheet(s)
Select this option if you want this task to print on staff assignment sheets.

Task requires
Enter the number of people needed to perform this task.

Default task
To make this task required for residents who have the associated need, select this option. Staff will not be able to remove this task from the resident’s assessment if the need is selected.

Care fee exclusion
To exclude this task from the care fee calculation, select this option.

Schedule

Frequency
Click the drop-down arrow and select one of the following options to define how often this task will be performed. The remaining scheduling options change depending on the Frequency that you choose.
- Hourly
- Daily
- Weekly
- Monthly
- Annually

Duration
Enter the number of minutes it takes to complete this task. The maximum that you can enter is 720, or 12 hours. If the task requires more than that, you must schedule it as a multi-day task.

Repeat every
Select a number to define how often this task recurs. That is, for a weekly task, enter “1” here to schedule the task every week. Enter “2” to schedule the task every other week.

Times per day
Enter the number of times a day this task should be performed.

Scheduled by
Select the way you want to schedule this task:
- Specific time: If you select this option, you will also define one or more specific times that this task must be performed.
- Shift: Select this option for less time-sensitive tasks. The task can be performed at any time during a specific shift.

Time(s)
If you are scheduling this task by a specific time, enter the time here. The number of Time(s) you must enter is determined by the Times per day you defined for the task.

Shift(s)
If you are scheduling this task for a shift, enter the shift here. The number of Shift(s) you must enter is determined by the Times per day you defined for the task. You can enter the same shift multiple times. For example, you can schedule a task to be performed twice during the day shift.
Day(s) of week  For a “Weekly” task, use this option to select the days of the week that this task will be scheduled. You can select more than one day.

Month(s)  For a task scheduled “Annually,” select the month or months in which this task will be scheduled.

Day(s) in month  For a task scheduled “Monthly” or “Annually,” use this option to select the days in the month when this task will be scheduled. Select one of the following options:

- **By numeric day of month:** Select this option to schedule by the numeric day, such as the first and the fifteenth of each month. When you choose this option, the system opens a calendar page where you can select the numerical days for scheduling. You can select one or more days.

- **By weekday in month:** Select this option to schedule by the day of the week in the month, such as the first and third Tuesday of every month. When you choose this option, the system opens a calendar page where you can select the days for scheduling. You can select one or more days.

**Reviewing or Printing an Assessment**

Senior Living Care Management provides both an Assessment summary page and a printable PDF Form that summarize the resident’s assessment. The online page and the printable form are available in several places, and allow you to review and print a resident’s assessment without opening the full assessment detail. If your community uses the assessment review workflow, reviewers can even approve the assessment from the online summary page after ensuring that everything is in order.

When you choose to print or view an assessment, the system opens a two-tab page:

- **Summary:** The Summary tab displays the online Assessment summary. This page shows basic information about the community and the resident, as well as details about the assessment you are reviewing. The following information is provided:
  - **Heading:** The resident’s name and unit appear in the heading, along with the property name, address, and telephone number.
  - **Assessment information:** The effective date, last assessment date and next assessment date are given, along with the reason for the current assessment and its status. The user name of the person who prepared, finalized, and reviewed the assessment are also given, depending on where in the process the assessment is at the time you are looking at it.
  - **Personal health information:** This section shows the primary and secondary diagnoses, any allergies, alerts, advance directives, and code status for the resident. It also shows whether the resident is ambulatory or needs assistance evacuating the property.
  - **Assessment:** The remaining information on the page is the assessment itself. A heading appears for each of the sections in the assessment in which at least one need is selected for the resident. Each category is listed along with the need...
selected in that category. Note that only the needs are shown here, not the expected results or the tasks associated with those needs.

In addition, the assessment score is not shown, even if the property is set up to display the score in the Assessment page itself.

You can use the Print button to print this version of the assessment summary. You can use the Finalize or Finalize and close buttons to finalize an In progress assessment from this page. If your property uses the review workflow, people set up as reviewers can also use the Approve or Approve and close buttons to approve a Pending review or Modified assessment from this page.

- **Forms:** When you click this tab, the system generates a PDF version of the assessment that you can print or download. This form identifies the resident name and unit, the effective date of the assessment, and the user name of the person who finalized and reviewed the assessment (if those tasks have been completed). It then prints a section for each assessment section in which the resident has at least one selected need, giving the category and the assessed needs in each category.

Unlike the summary, the form reports the score for each need and the total score for each section. The assessment score is shown here even if the property is set up to not display the scores in the Assessment page itself.

### How to Get Here

**Senior living ➔ View ➔ Print assessment**

1. Click the Senior living tab.
2. Locate the applicant or resident you want to work with and click the View link for that resident or applicant.
3. At the Senior at a glance page, click the Print assessment option in the Actions list. This option opens the Assessment summary and Forms for the most recent assessment.

**Senior living ➔ View ➔ Assessment history ➔ View**

1. Click the Senior living tab.
2. Locate the applicant or resident you want to work with and click the View link for that resident or applicant.
3. At the Senior at a glance page, click the Assessment history tab.
4. In the Assessments list, locate the assessment you want to review or print.
5. Click the View link to open the Assessment summary and Resident reports for the selected assessment.

### Finalizing an Assessment

Once an assessment has been completed, it must be finalized. While the assessment is in In progress status, you can finalize the assessment directly from the Assessment summary page.
1. Review the assessment information, the resident’s personal health information, and the needs assessed for the resident in each category and section.

2. Select one of the following options:
   
   - To finalize the assessment and close the Assessment summary page, click the Finalize and close button.
   - To finalize the assessment and leave the assessment summary open, click Finalize. If you want to view or print the assessment form, click the Forms tab. Click Cancel to close the Assessment summary.

   If your community does not use the assessment review workflow, the Status of the assessment is updated to Final, and the Review result is updated to Approved. If your property does use the assessment review workflow, the Status of the assessment is updated to Pending review, and the Review result is still blank.

### Approving an Assessment

If your community is using the assessment review workflow, the reviewer will have to review the assessment and either approve it or modify it. While the assessment is in either Pending review or Replaced status, the reviewer can approve the assessment directly from the Assessment summary page.

1. Review the assessment information, the resident’s personal health information, and the needs assessed for the resident in each category and section.

2. Select one of the following options:
   
   - To approve the assessment and close the Assessment summary page, click the Approve and close button.
   - To approve the assessment and leave the assessment summary open, click Approve. If you want to view or print the assessment form, click the Forms tab. Click Cancel to close the Assessment summary.

   The Status of the assessment is updated to Final, and the Review result is updated to Approved.

### Fields

<table>
<thead>
<tr>
<th>Page Heading</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(Resident name)</td>
<td>This is the name of the resident or applicant whose assessment you are viewing.</td>
</tr>
<tr>
<td>(Unit)</td>
<td>This is the resident’s unit number.</td>
</tr>
<tr>
<td>(Property name and address)</td>
<td>This is your property’s name and address.</td>
</tr>
</tbody>
</table>

**Assessment Information**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effective date</td>
<td>This is the effective date of the assessment you are viewing, usually the day on which the assessment was performed or begun.</td>
</tr>
<tr>
<td>Last assessment</td>
<td>This is the date on which the most recent assessment was performed.</td>
</tr>
</tbody>
</table>
Next assessment due
This is the date on which the next assessment is scheduled.

Reason
This is the reason the assessment was performed, identifying it as an initial assessment, a periodic assessment, or a change of condition assessment.

Status
This column identifies the current status of the assessment you are viewing:
- **In progress:** This status identifies an assessment that has been started, but has not yet been completed.
- **Pending review:** If your property uses the review workflow, this is the status of the assessment after it has been finalized and is awaiting review and approval.
- **Modified:** If your property uses the review workflow, this status indicates that the assessment was changed during the review process. It must now be approved again.
- **Replaced:** If your property uses the review workflow, this status identifies a prior assessment that was modified after the initial care fee was accepted. It must now be approved again.
- **Final:** If your property does not use the review workflow, this status indicates that the person performing the assessment has completed it and finalized it. If your property uses the review workflow, this assessment has been reviewed and approved.

Prepared by
This is the user name of the person who created the assessment.

Finalized by
This is the user name of the person who finalized the assessment, if the assessment has been finalized.

Reviewed by
This is the user name of the person who reviewed and approved the assessment, if the assessment has been approved by a reviewer. If your property does not use the assessment review workflow, this field will always show “n/a.”

Personal Health Information

**Primary diagnosis**
This is the person’s primary diagnosis, as recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

**Secondary diagnosis**
This is the person’s secondary diagnosis, as recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

**Allergies**
This shows any allergies recorded on the Personal health information tab of the person’s General, personal health, and demographic information.

**Alerts**
This shows any alerts recorded on the Personal health information tab of the person’s General, personal health, and demographic information.
**Advance directives**  This Yes/No flag indicates whether there are any advance directives for this person, as recorded on the person’s **Personal health information** tab of the person’s **General, personal health, and demographic information**.

**Code status**  This shows the code status recorded on the **Personal health information** tab of the person’s **General, personal health, and demographic information**.

**Evacuation assistance**  This flag identifies whether the person requires assistance in case the property must be evacuated, as recorded on the **Personal health information** tab of the person’s **General, personal health, and demographic information**.

**Ambulatory**  This Yes/No flag indicates whether the person is ambulatory, as recorded on the person’s **Personal health information** tab of the person’s **General, personal health, and demographic information**.

**(Assessment)**  

**(Assessment section heading)**  For each section of the assessment for which at least one need is selected for this person, the section heading is printed.

**(Assessment category)**  Within each section, each of the assessment categories for which a need is selected for this person is printed.

**(Need description)**  The description of each need selected for the resident in any given category is listed. If multiple needs are selected in a category, all are listed.
Contacts Tab

Use the Contacts tab to set up and manage all of a resident’s contacts. This can include personal contacts (such as family members or religious contacts) as well as contacts involved in the resident’s care (such as hospice workers or personal physicians). The Contacts tab includes two contacts lists, one for emergency contacts and one for other contacts. Primary and alternate emergency contacts are listed separately, so it is always easy for you to quickly locate this contact information, if needed. In fact, the primary emergency contact and the primary physician are shown on the Summary tab, so you always have quick access to this information. All contacts except emergency contacts are presented in the Other contacts list. Contacts are sorted between the two lists based on the resident association defined for the contact. Use the New button above the Emergency contacts list to add a new contact and the Actions to manage existing contacts.

Contacts are managed at two levels. First, all contacts are maintained as individuals on the master contacts list, which you can work with directly from the Administration page. When you add a contact through a person’s Senior at a glance page, that person is first added to the master list. You then select the person as a contact for a specific resident, and define that person’s relationship to that resident. In this way, contacts such as doctors can be entered once as a contact but associated with multiple residents.

From the resident’s point of view, contacts are defined and managed by their relationships with the resident. As a result, the same person (contact) can be listed multiple times as a contact for a resident. For example, if the resident’s son is both the primary emergency contact and the primary financial power of attorney, that person could be listed three times: as a family member, the primary emergency contact, and the primary financial power of attorney.

Emergency Contacts

For each emergency contact, the list shows the relationship of the contact to the resident, type of contact, the contact’s name and preferred contact method, and any notes entered for the contact. The Active column identifies active and inactive contacts. You have options to edit the information for a listed contact, add a new contact, and find (and select) a contact on the property’s master contact list. You can also select a new primary emergency contact.

Other Contacts

All non-emergency contacts are shown in the Other contacts list, which shows the contact group and type, the contact’s name and preferred contact method, and any notes entered for the contact. The Active column identifies active and inactive contacts. You have options to edit the information for a listed contact, add a new contact, and find (and select) a contact on the property’s master contact list.

Before You Begin

- The contact groups (types of contacts) and contact types that you use to identify a resident’s personal contacts are those that are defined for your community at the Contact groups option on the Setup page.
Many of the contact management tasks that you perform on the Contacts tab are controlled by user roles and rights. In order to perform the tasks detailed in this area, you must have the following roles and/or rights assigned in user management.

- **Add or edit resident contacts**: This action is controlled by the “Edit the primary emergency contact information for a resident” right. By default, this right is assigned to the Activity Director, Bookkeeper, Leasing Consultant, Property Manager, Regional Property Manager, Resident Care Director, and Superuser roles.
- The “Allow the user to view unencrypted data” right lets you view all data that has been encrypted in the database. By default, this right is assigned to the Superuser role.

### How to Get Here

**Senior living ➔ View ➔ Contacts**

1. Click the Senior living tab.
2. Use one of the search methods to locate the applicant or resident you want to work with.
3. Click the View link for the resident or applicant.
4. Select the Contacts tab.

### Adding a Contact

All contacts added end up on the property’s master contacts list, the Manage other contacts list available at the Senior Living – Other section of the Administration page in Senior Living. You can add new contacts there, if you wish.

1. To add an emergency contact or an “other” type of contact, click the New button.
2. The Manage contact (on page 93) page opens. Enter the Name and (contact) Information for the contact. The name and preferred contact method are the only required fields. Add all the contact methods you have; it may prove to be important for an emergency contact. When this information is added, click Save.
3. The Contact/Resident association (on page 97) page opens. You are also required to assign the contact to a group. You can also edit the contact’s information and make a resident association (decide on the relationship of the contact to the resident, and if the contact will have access to the unit in case of an emergency).
4. When the page is completed, click Save to return to the Contacts tab. Depending on the Group membership assignment you made, the contact person appears on either the Emergency contacts or Other contacts list.

Add other contacts as needed.

You can also use the Find method to search for contacts already added to the master contacts list for the property. Refer to the next topic for details.
Chapter 2: Senior at a Glance

Finding a Contact

1. To add an existing contact person, click the Find button.
2. The Find contacts page opens. To generate a list of contacts who have already been added to the property’s master contacts list, use any of the three search options. To choose a search method, click the Find field drop-down arrow above the list. These are the options:
   - Business name: If business names have been applied to your contacts, choose this name and enter the first few letters of the business name in the next field and click the Find button. If no business names exist for contacts at this property, OneSite opens a list of all contacts.
   - Contact: Select this option to list all contacts on the property’s master contact list, or search for a specific name by entering the first few letters of the name in the field to the right, and click Find.
   - Contact group: Select this option if you want to find a list of all contacts added to a specific group by selecting a contact group from the drop-down list, and click Find.
3. If your search resulted in a list of names, find the name and click the Select link. The Contact/Residents association page opens.
4. To add this contact person, you must choose a contact group and type in the Contact/Resident association section. When your selection is listed in the Group membership list, click Save.
5. You are returned to the main page. Depending on the Group membership assignment you made, the contact person appears on either the Emergency contacts or Other contacts list.
6. Click Save to close the page.

Changing the Primary Emergency Contact

Choosing a New Primary Emergency Contact (Method 1)

1. If a current primary emergency contact person is already listed, and other contact types have also been selected for the resident, you have the option to change the primary emergency contact. If you want to do this, click the More option in the Actions column.
2. To continue, click the Select new primary emergency contact link.
3. This opens the Change primary emergency contact (on page 103) box. It lists all the contacts currently selected for this resident. Choose the one you want. The primary contact you replaced is removed from the list.

Choosing a New Primary Emergency Contact (Method 2)

1. This method uses the Find function. To select a new primary emergency contact person from your master contacts list, click Find.
2. At the Contacts page, use one of the search methods to generate a list of contacts.
3. Click the Select link for the new primary emergency contact person.
4. The **Contact/Resident association** page opens. Choose “Emergency contact” and “Primary emergency contact” in the **Contact/Resident association** section.

5. Click the **Add** button.

6. A warning box opens. It asks if you want to replace the existing primary emergency contact. Click **Confirm**.

7. Click **Save**. You are returned to the main tab, and the new primary emergency contact person is listed.

### Editing a Contact’s Information

1. To edit the information for a contact person on either list at the **Other contacts** tab, click the **More** option.

2. To proceed, select the appropriate edit link for the person. There are two:
   - **Edit contact**: Choose this link to edit the contact’s name, preferred contact method, or notes. Refer to **Manage Contacts** (on page 93) for details.
   - **Edit contact association**: Choose this link to edit the contact’s group membership, contact/resident association (to select the contact group or type), or resident association (including relationship and access options). Refer to **Contact/Resident Association** (on page 97) for details.

3. When you have completed your changes, click **Save**.

### Deleting a Contact

To delete a contact from resident’s **Emergency contacts** or **Other contacts** lists:

1. Locate the contact that you want to delete and select the **More** option.

2. Click the **Remove contact from resident** link.
   
   This link does not appear for a primary emergency contact. Refer to the **Changing the Primary Emergency Contact** topic, above.

3. A confirmation box opens. Click **Delete** when asked to confirm your action.
   
   The contact is removed from the resident’s contacts list. The association with this resident for the deleted contact type is removed from the **Resident association** list for the contact in the contacts master list. This action does not remove the contact from the master contacts list, only from the resident’s contacts list.
## Fields

### Emergency Contacts

<table>
<thead>
<tr>
<th>Action</th>
<th>Use these actions to manage the resident’s current list of emergency contacts:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• <strong>Edit contact</strong>: Use this option when you need to change the contact’s name, contact methods, or notes.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edit contact association</strong>: Use this option when you need to change the contact’s group or type, group membership, or resident association information.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Select new primary emergency contact</strong>: This option only appears if you have selected the More option for the primary contact person. Use it when you want to replace the current primary emergency contact person. The Change primary emergency contact (on page 103) box opens with a list of all current contacts for the resident. This does not remove the contact from the master contact list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Remove contact from resident</strong>: This option only appears if you have selected the More option for an emergency contact person who is not the primary contact person. To confirm your intention, click Delete in the confirmation box.</td>
</tr>
</tbody>
</table>

| Relationship | This is the relationship of the contact to the resident. It is added in the Resident association section of the Contact/Resident association page. A value must be entered here to display the Relationship on the Resident Information report. |
| Type | This column identifies the type of emergency contact. The contact types are added at Setup – Leasing & Rents – Resident management – Other contact groups or Setup – Senior Living – Contacts – Contact groups. |
| Name | This is the contact’s name. |
| Contact method | This is the contact’s preferred method of communication. If this is a link, you can view a list of alternate items. For example, if a work number and a cell number have been added for the contact, click the link to see both telephone numbers. |
| Notes | This column indicates whether there are any notes entered for the contact. If so, “Yes” appears in the column. Click this link to display the contact notes. These are the notes entered for the contact, not the notes entered for the resident association with the contact. |
| Active | This column identifies active and inactive contacts. A green check mark identifies an active contact, while a red “X” identifies an inactive contact. Status is determined at Manage other contacts, (the contacts master list), at Administration – Leasing & rents – Other – Setup – Manage other contacts or Administration – Senior Living – Other – Manage contacts. |
### Other Contacts

**Action**  
Use these actions to manage the resident’s current list of non-emergency contacts:

- **Edit contact:** Use this option when you need to change the contact’s name, contact methods, or notes.
- **Edit contact association:** Use this option when you need to change the contact’s group or type, group membership, or resident association information.
- **Remove contact from resident:** This option only appears if you have selected the More option for an emergency contact person who is not the primary contact person. To confirm your intention, click Delete in the confirmation box.

**Group**  
This column identifies the contact group that is the basis for the resident association. This information is determined by the group name.

**Type**  
This column identifies the contact “type.” The contact types are added at Setup – Leasing & Rents – Resident management – Other contact groups or Setup – Senior Living – Contacts – Contact groups.

**Name**  
This is the contact’s name.

**Contact method**  
This is the contact’s preferred method of communication. If this is a link, you can view a list of alternate items. For example, if a work number and a cell number have been added for the contact, click the link to see both telephone numbers.

**Notes**  
This column indicates whether there are any notes entered for the contact. If so, “Yes” appears in the column. Click this link to display the contact notes. These are the notes entered for the contact, not the notes entered for the resident association with the contact.

**Active**  
This column identifies active and inactive contacts. A green check mark identifies an active contact, while a red “X” identifies an inactive contact. Status is determined at Manage other contacts, (the contacts master list), at Administration – Leasing & rents – Other – Setup – Manage other contacts or Administration – Senior Living – Other – Manage contacts.
Find Contacts

The **Find contacts** page allows you to search your property’s master list of contacts. When adding a resident or applicant contact, use this page to see if the contact already exists. If so, use the existing contact. If the contact does not exist, add a new contact. You can search for contacts by business name, contact name, or contact group. You can search for an individual name or business name, or simply list everyone on the master list. You also have the option to list active contacts only.

For each listed contact, the name, address, and preferred contact method are listed, along with links to view lists of residents associated with the contact, and any contact groups the person has been associated with. The last column indicates if the contact is active or inactive. If the contact is associated with a resident in a professional capacity (such as a doctor or lawyer), the contact’s business name is also shown. To the left, the **Select** link opens the **Contact/Resident association** page, where you can add or edit the contact’s information, group membership, and associations.

This page is nearly identical to the **Manage other contacts** page available at the **Administration** page. In both places, you can add contacts and update information for existing contacts. However, at the **Find contacts** page, you cannot change the contact’s active/inactive status or delete the contact from the master list. More importantly, you can use the **Select** option here to associate a contact to the resident you are working with. This can only be done from the **Find contacts** page that you access for a specific resident.

How to Get Here

**Senior living ➔ View ➔ Contacts ➔ Find**

1. Click the **Senior living** tab.
2. Use one of the search methods to locate the applicant or resident you want to work with.
3. Click the **View** link for the resident or applicant.
4. Select the **Contacts** tab.
5. Click the **Find** button.

**Residents/Applicants/Waitlist ➔ Find ➔ View ➔ New/Edit ➔ Other contacts ➔ Find**

1. Click the **Residents, Applicants, or Waitlist** tab.
2. Use one of the search methods and click **Find** to list the person you need to work with.
3. Click the **View** link in the **Actions** column.
4. Decide on the type of action needed:
   - Click the **New** button to add a new household member.
   - Click the **Edit** link to the left of the person’s name you want to edit.
5. Click the **Other contacts** tab.
6. Click the **Find** button.

### Finding Contacts

To find an existing contact, use one or more of the following options:

**Active and Inactive Contacts**

This option can be used in combination with any of the **Find** options.

1. By default, the contacts list is filtered to show only Active contacts. To find an Inactive contact, click the **Select active only?** check box to clear it.
2. Click **Find**. The **Contacts** list redisplay showing both Active and Inactive contacts.

**Find by Business Name**

Use this option when you are looking for a person who is associated with a business. For example, if you are looking for a doctor associated with a particular medical practice, you can search for the practice name and find all contacts for that business.

1. Click the drop-down arrow and select “Business name.”
2. In the search field, enter one or more letters or characters that are part of the business name.
3. Click **Find**. The system returns a list of all contacts associated with businesses whose name contains the characters you entered.

**Find by Contact Name**

Use this option when you are looking for a person by name.

1. Click the drop-down arrow and select “Contact.”
2. In the search field, enter one or more letters or characters that are part of the person’s name.
3. Click **Find**. The system returns a list of all contacts whose first or last name contains the characters you entered.

If nothing is entered in the search field (step 2), the system generates a list of every contact.

**Find by Contact Group**

Use this option when you are looking for a person of a certain type. For example, if you want to see a list of all insurance contacts, you can search for people assigned to that group.

1. Click the drop-down arrow and select “Contact group.”
2. If “Contact group” is selected, a drop-down arrow is added to the search field. To search for a particular group, click the drop-down arrow and select a group from the list.

3. Click **Find**. The system returns a list of all contacts associated with the selected contact group.

### Using the Find Contacts Page

After you use the **Find** button, a list of contacts who meet your search criteria appears. You can do the following:

#### Select a Contact for the Resident or Applicant

1. Find the contact person on the list, and click the **Select** link.

2. The **Contact/Resident association** page opens. You can simply click **Save**, to choose the contact, and you can also:
   - Edit the contact information (name, contact method, business name, address, contact methods, and notes) at the **Manage contact** page.
   - Change the contact group membership.
   - Select or change the resident association and decide if the contact person will have emergency access to the resident’s unit.

3. When this page is saved, the contact is added to the resident’s contact list.

#### View Address

1. The information in the **Address** column is a link. To view the entire address (includes city, state, ZIP Code, and country), click the link.

2. To close the pop-up box, click anywhere outside the box.

#### View Contact Method

1. In the **Contact Method** column, the preferred contact information is listed. If more than one contact method has been added, the information in this column is a link. To open a list of all contact methods (such as telephone numbers) for a contact, click the link.

2. To close the pop-up box, click anywhere outside the box.

#### View Associated Residents

1. In the **Residents Associated** column, a “Yes” indicates that this contact has been associated with one or more residents. “Yes” is a link. To open a list of all residents associated with this contact, click the link.

2. To close the pop-up box, click anywhere outside the box.

#### Viewing Groups Associated with the Contact

1. The **View** link in the **Contact Group** column opens a list of the group(s) the contact has been associated with.

2. To close the pop-up box, click anywhere outside the box.
**Fields**

**Find**
Click the drop-down arrow and select the kind of search you want to perform:

- **Business name**: Use this option when you are looking for a business contact. Enter one or more letters or characters in the search field, and click **Find**. The system returns a list of all businesses whose name contains the characters you entered.

- **Contact**: Use this option to search for a contact by name. Enter one or more letters or characters in the search field, and click **Find**. The system returns a list of all contacts whose name contains the characters you entered.

- **Contact group**: Use this option to search for contacts of a certain group type (such as legal or emergency). If “Contact group” is selected, a drop-down arrow is added to the search field. To search for a particular group, click the drop-down arrow and select a group from the list. To continue, click **Find**. The system generates a list of all contacts associated with the selected contact group.

**Show active only?**
Use this option to filter the list of all contacts by their active/inactive status.

**Contacts List**

**Action(s)**
When working with the contacts list from the resident file, you have two options:

- **Select**: Click this link when you want to work with the contact’s basic information, Group membership, and the Contact/Resident association information. When you use this option, the contact page includes the Resident association section.

- **Edit**: This link does not appear when this page is opened from the Resident/Applicant at a glance page. Click the **Edit** link when you want to open the contact’s basic information. Here you can edit the contact’s name, address, and group membership information. You cannot assign or change the Resident association information, which defines the contact’s relationship with a resident.

**Contact**
This is the name of the contact.

**Business name**
If the contact is associated with a business, this is the business name. You may have multiple contacts for the same business.

**Address**
This is the contact’s address. Click this link to view all address information (city, state, ZIP Code, and country).

**Contact method**
This is the primary phone number or e-mail address for the contact. If more than one contact method was added, this is a link. Click the link to view alternate contact information.
### Residents associated?

- “Yes” indicates one or more residents are associated with the contact. To see a list of the associated resident names, click the link.
- “No” means that there are no associated residents.

### Contact group

The **View** link in this column allows you to quickly see all of the contact groups that the contact is assigned to.

### Active

This column indicates whether the contact is currently active or inactive at the property. Active contacts have a green check mark, and a red X indicates Inactive status.

### Buttons

**Find**

Generates a list of contacts that meets the search criteria
**Manage Contacts**

To add a new contact for a resident or applicant, complete the information in this box. Though only two fields are required, add as much information as possible. Having more than one “contact method” may prove to be helpful, especially for an emergency contact.

**How to Get Here**

**Senior living ➔ Find ➔ View ➔ Contacts ➔ New/More ➔ Edit contact**

1. Click the Senior living tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link for the resident or applicant.
4. Select the Contacts tab.
5. To add a new contact person, click the New button.
6. To edit a contact, click the More action and select Edit contact.

**Residents/Applicants/Waitlist ➔ Find ➔ View ➔ New/Edit ➔ Other contacts ➔ New/More ➔ Edit contact**

1. Click the Residents, Applicants, or Waitlist tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link in the Actions column.
4. Decide on the type of action needed:
   - Click the New button to add a new household member.
   - Click the Edit link to the left of the person’s name you want to edit.
5. Click the Other contacts tab.
6. To add a new contact person, click the New button.
7. To edit a contact, click the More action and select Edit contact.

**Adding Name and Contact Information**

1. In the Name section, you must enter either a Contact name or a Business name (or both).
   - For individuals, enter the name in the Contact name fields. First and last names are required. You can also enter an honorific (Mr., Mrs., Ms., Dr., etc.), a middle initial, or a suffix (Junior, Senior, etc.).
   - If the contact is associated with the resident or property professionally, enter the name of the company the person works for in the Business name field.

© 2013 RealPage, Inc. Care Management uGuide 93
For businesses, you can leave the **Contact name** fields blank and enter only the **Business name**.

When you enter a new contact name, the system automatically checks for duplicates. If there is already a contact with the same first and last name, the system displays a link in red reading “Duplicates exist for this name.” You must click this link and determine whether this is the same contact or a different contact with the same name. (See **Checking for Duplicate Contacts** (on page 104) for detailed instructions on this step.)

2. In the **Information** section, click the **MAIN ST** button and enter the contact address. An address is not required.

3. Click the drop-down arrow in the **Contact method** field and select the contact’s preferred method of contact.

4. Based on the contact method you selected, you must complete one of the contact fields. That is, if you selected “Work phone,” you must enter the phone number in the **Work phone** field. If you selected “E-mail,” you must complete the **E-mail** field.

   You can also complete any or all of the other contact information for the contact. Add all the contact method information you have; it may prove to be helpful for an emergency contact.

5. Enter any comments or notes about this person or business in the **Contact notes** field. The information you enter here is associated with the contact, not with the contact’s relationship with any particular resident. This information displays when you click the **Notes** link on the resident’s **Contacts** tab.

6. If this person or business refers prospective residents to your property, select the **Referral source** check box below the **Contact notes** box.

7. When you have completed this box, click **Save**, or click **Cancel** to close the box without saving the information.

   The **Contact/Resident association** page opens next. You’ll choose one or more contact groups for the new contact, and may also define a relationship to the resident and decide on access (to the unit) options. You can also edit the name and contact information that was added here.

### Fields

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td></td>
</tr>
<tr>
<td>(Honorific)</td>
<td>For a person, select an honorific that is part of the name, such as Mr. or Dr.</td>
</tr>
<tr>
<td>(First name)</td>
<td>For a person, enter the person’s first name. If you leave the <strong>Business name</strong> blank, this field is required.</td>
</tr>
<tr>
<td>(Middle initial)</td>
<td>For a person, enter the person’s middle initial (if any).</td>
</tr>
<tr>
<td>(Last name)</td>
<td>For a person, enter the person’s last name. If you leave the <strong>Business name</strong> blank, this field is required.</td>
</tr>
<tr>
<td><strong>Suffix</strong></td>
<td>For a person, select a suffix that is part of the name, such as Junior or Senior.</td>
</tr>
<tr>
<td>------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Business name</strong></td>
<td>For a business, enter the business name here. For a person whose relationship with the resident or property is professional, enter the name of the person’s company here.</td>
</tr>
</tbody>
</table>

**Information**

<table>
<thead>
<tr>
<th><strong>Address</strong></th>
<th>This is the contact’s address. To enter or change this address, click the MAIN ST button.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contact method</strong></td>
<td>Click the drop-down arrow and select the contact’s preferred method of communication. Depending on what method you choose, one of the phone number or e-mail address fields will be required.</td>
</tr>
<tr>
<td><strong>Work phone (and ext)</strong></td>
<td>Enter the work phone number for this contact, including the extension, if needed.</td>
</tr>
<tr>
<td><strong>Cell</strong></td>
<td>Enter the cell phone number for this contact.</td>
</tr>
<tr>
<td><strong>Home phone (and ext)</strong></td>
<td>Enter the home telephone number for this contact, including the extension, if needed.</td>
</tr>
<tr>
<td><strong>After hours phone</strong></td>
<td>Enter the after hours phone number for the contact. This is used more specifically for business contacts.</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>Enter the fax number for this contact.</td>
</tr>
<tr>
<td><strong>E-mail</strong></td>
<td>Enter the e-mail address for this contact.</td>
</tr>
<tr>
<td><strong>Contact notes</strong></td>
<td>Enter any notes or comments about this contact. If you enter these notes, property staff can view the notes directly from the resident’s Contacts tab by clicking the Yes link in the Notes column.</td>
</tr>
<tr>
<td><strong>Referral source</strong></td>
<td>If this contact refers prospective residents to your property, select this option.</td>
</tr>
</tbody>
</table>
Contact/Resident Association

Use this page to add a new, or edit an existing contact.

What you see here depends on the process. When adding a new contact, you’ll complete the basic information in a separate box, and then add the details of the contact group and association with the resident. The information added at this page also goes to the property’s master contacts list, the Manage contacts list available at the Senior Living – Other section of the Administration page.

These three sections are completed here.

- **Group membership:** This lists all groups that have been associated with the contact. A Remove link is available for each listed group.
- **Contact/Resident Association:** You must select at least one group and group type for a contact. Both fields have drop-down arrows that list all groups and group types available for the property. The common groups are emergency contact, family, friend, legal, medical, and the like. A contact type is selected from a group of options determined by the group. When selected, the group and group type appear on the list to the left.
- **Resident Association:** The fields in this section define the relationship of the contact to the resident, and the contact’s access to the property and the resident’s possessions, if necessary. The information in this section is optional.

How to Get Here

**Senior living ➔ Find ➔ View ➔ New/Edit ➔ Contacts ➔ More ➔ Edit contact association**

1. Click the Senior living tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link in the Actions column.
4. Decide on the type of action needed:
   - Click the New button to add a new household member.
   - Click the Edit link to the left of the person’s name you want to edit.
5. Click the Contacts tab.
6. In the Actions column, click More.
7. Click the Edit contact association link.

**Residents/Applicants/Waitlist ➔ Find ➔ View ➔ New/Edit ➔ Other contacts ➔ More ➔ Edit contact association**

1. Click the Residents, Applicants, or Waitlist tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link in the Actions column.
4. Decide on the type of action needed:
   - Click the New button to add a new household member.
   - Click the Edit link to the left of the person’s name you want to edit.
5. Click the Other contacts tab.
6. In the Actions column, click More.
7. Click the Edit contact association link.

Adding the Contact/Resident Association Information

1. When this page opens, the Contact section has already been completed. If you need to edit the basic contact information, click the Edit button at the top of the page. For details on these steps, refer to the Manage contact (on page 93) topic, above.
2. In the Contact/Resident association section, click the drop-down arrow in the Contact group field and select the option that correctly defines the contact’s group membership as it relates to the resident.
   
   The options available here are added for the property at the Setup – Senior Living – Contacts – Contact groups.

3. Next, click the Contact type drop-down arrow. The list that appears depends on the Contact group selected above. Select the group type that further defines how the contact and the resident are related.
4. With the contact group and type selected, click the Add button. The choices you just made are now listed in the Group membership section to the left. If you made a mistake, use the Remove link and return to step 2.
   
   At least one contact group and type must be entered and added for a new contact.
   
   Add additional groups and types, if they may apply to the contact.
   
   An “Emergency contact” designated as “Primary emergency contact” will not have a Remove link. If you must change one, return to the main Emergency contacts list and choose the option to Select new primary emergency contact. Refer to Change primary emergency contact (on page 103) for details.

5. The information in the Resident association section is optional. Enter the relationship description you want in the Relationship field. For example, enter “Friend” if a contact is a doctor and a close friend to the resident. This text appears in the emergency contact grid and on the Resident Information report.
6. If the resident has a policy or account number with the contact, then enter this number in the Policy/Account field. To see the policy or account number, you must have the right to view encrypted data.
7. If a Policy/Account number is added, and you don’t want it to appear on the Resident Information report, select the Hide on resident information report option.
8. If you think any Notes will be helpful to describe the relationship, enter them here.

9. If Notes are added, and you don’t want them to appear on the Resident Information report, select the Hide on resident information report option.

10. If this contact shall have access to the resident’s property in the event of serious illness or death, select the Allowed access option.

11. If the power of attorney will receive verification correspondence for the resident, select the Receive correspondence option.

12. If this contact referred the resident or applicant to the property, select the Referred by option.

13. If this contact should have restricted access to the resident, select the Restrict access option.

14. Click Save. The system returns you to the Other contacts page.

The new contact has been added to one of the two Contacts lists, depending on the type of contact you added for the resident.

Removing a Contact from Group Membership

To remove a contact from membership in a contact group, perform the following steps. When you remove the contact from the group, the system automatically removes the contact from all residents contact lists that are based on that group membership.

Once it has been assigned, you cannot remove the “Emergency contact” group. For information about changing an emergency contact that has been assigned to a resident, refer to Changing the Primary Emergency Contact (on page 83) in the Resident Management uGuide.

To remove a contact from a group:

1. At the Contacts for (resident’s name and unit number) page for the contact, locate the group you want to remove in the Group membership list.

2. Click the Remove link.

3. Click Delete when asked to confirm the change.

4. The system removes the group from the Group membership list and from any resident contacts lists it has been assigned to.

Fields

<table>
<thead>
<tr>
<th>Contact</th>
<th>The fields in the Contact section cannot be edited here. To make changes, click the Edit button.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact name</td>
<td>This is the contact’s name.</td>
</tr>
<tr>
<td>Business name</td>
<td>This is the contact’s business name. It is not a required field.</td>
</tr>
<tr>
<td>Address</td>
<td>This is the contact’s address. It is not a required field.</td>
</tr>
</tbody>
</table>
**Contact notes**
These are any notes added for this contact. It is not a required field.

**Work phone**
This is the contact’s work telephone number. It is not a required field. Only one of the phone/fax/e-mail fields is required.

**Home phone**
This is the contact’s home telephone number. It is not a required field.

**Cell**
This is the contact’s cell phone number. It is not a required field.

**Fax**
This is the contact’s fax number. It is not a required field.

**After hours**
This is the after hours phone number. It is not a required field.

**E-mail**
This is the contact’s e-mail address. It is not a required field.

* (asterisk)
Of the five fields above, one has an asterisk. It denotes the contact’s preferred contact method.

---

**Group Membership**

**Action**
The only available action is a link to Remove the listed group name and type.
This link does not appear for the “Primary emergency contact.” To remove a primary contact, return to the main Emergency contacts list and choose the option to Select new primary emergency contact. Refer to Change primary emergency contact (on page 103) for details.

**Group name**
This is the contact group name selected in the Contact/Resident Association section, below.

**Contact type**
This is the contact type selected in the Contact/Resident Association section, below.

---

**Contact/Resident Association**

**Contact group**
The two fields in this section are required. Click the drop-down arrow and select the Contact group name that best describes the association between the contact and resident.

**Contact type**
Click the Contact type drop-down arrow and select a contact type from the list. The items on the list depend on the contact group selected in the previous field. When these two fields are selected, click the Add button. The fields appear in the Group membership section, to the left.

---

**Resident Association**

**Relationship**
The fields in this section are not required. Enter a brief relationship. This is the text that displays on the Resident Information report.

**Policy/Account**
Enter any policy or account number that the resident has with the contact.
Hide on resident information report
Select this option if you do not want the policy or account number to appear on the Resident Information report.

Notes
Enter any notes needed to describe the relationship/association between the contact and the resident.

Hide on resident information report
Select this option if you do not want the note (entered in the previous field) to appear on the Resident Information report.

Allowed access
Select this option if this contact shall have access to the resident’s unit in case of a serious illness or death.

Receive correspondence
Select this option if the power of attorney will receive verification correspondence for the resident.

Referred by
Select this option if this resident was referred to the property by this contact.

Restrict access
Select this option if the contact should have restricted access to the resident.
Change Primary Emergency Contact

If more than one contact has been added for a resident or applicant, use this box to quickly change the primary emergency contact.

How to Get Here

Senior living ➔ Find ➔ View ➔ New/Edit ➔ Contacts ➔ More ➔ Select new primary emergency contact

1. Click the Senior living tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link in the Actions column.
4. Decide on the type of action needed:
   - Click the New button to add a new household member.
   - Click the Edit link to the left of the person’s name you want to edit.
5. Click the Contacts tab.
6. In the Actions column, click More.
7. Click the Select new primary emergency contact link.

Residents/Applicants/Waitlist ➔ Find ➔ View ➔ New/Edit ➔ Other contacts ➔ More ➔ Select new primary emergency contact

1. Click the Residents, Applicants, or Waitlist tab.
2. Use one of the search methods and click Find to list the person you need to work with.
3. Click the View link in the Actions column.
4. Decide on the type of action needed:
   - Click the New button to add a new household member.
   - Click the Edit link to the left of the person’s name you want to edit.
5. Click the Other contacts tab.
6. In the Actions column, click More.
7. Click the Select new primary emergency contact link.

Assigning a New Primary Emergency Contact

1. All contacts assigned to the resident or applicant are listed (except for the current primary assignment). To change the primary emergency contact, select the replacement.
2. To continue, click Save, or click Cancel if you don’t want to change the primary emergency contact.
Fields

Select  Select the new primary emergency contact.

Contact  Each contact person assigned to the resident/applicant is listed, except for the currently assigned primary emergency contact.

Checking for Duplicate Contacts

When adding a new contact, the system searches for contacts at your property that have the same first and last name as the contact you are currently entering (the middle initial of a person’s name is excluded from the search). Inactive contacts are included in the search. For example, if you are adding John T. Smith, and if there is already a contact for John H. Smith and John Smith, both would be identified as possible duplicates.

When the system finds possible duplicates, it displays a Duplicates exist for this name link. To determine whether this is the same person (or business) or a different person (or business) with the same name, click this link.

After clicking the Duplicates exist for this name link:

1. The duplicate contacts list shows the name, business name, address, primary contact, and Active/Inactive status for each duplicate the system finds. The View link in the Contact group column allows you to see what contact groups the existing contact is assigned to. Review all of this information to determine if this is the same person you are currently entering or a different person with the same (or similar) name.

2. Perform one of the following actions, depending on your decision:
   - **Same person:** If the contact you are entering is the same person as one of the contacts listed as a duplicate, click the Select option for the person who matches and click Save. The system returns you to the contact detail page for the contact you selected. Make any additional updates needed for this contact.
   - **Different person:** If the contact you are entering is not the same person as any of the contacts listed as possible duplicates, click Close. The system returns you to the contact detail page, where you can complete adding the new contact. The link is changed to Duplicates exist, none selected. When you save, you will have two contacts with the same or similar names.
Fields

Select
Review the list of duplicate contacts and determine if the contact you are entering is one of the people listed or is a different person with the same name.

- If this is the same person, click the **Select** option for the listed contact and click **Save**.
- If you are NOT adding a duplicate (the person on this list is not the same person, click **Close**. You can continue to add the new contact.

Contact
This is the name of the contact.

Business name
If the contact is associated with a business, this is the business name. You may have multiple contacts for the same business.

Address
This is the contact’s address. Click this link to view all address information (city, state, ZIP Code, and country).

Contact method
This is the primary phone number or e-mail address for the contact. If more than one contact method was added, this is a link. Click the link to view alternate contact information.

Residents associated?
- “Yes” indicates one or more residents are associated with the contact. To see a list of the associated resident names, click the link.
- “No” means that there are no associated residents.

Contact group
The **View** link in this column allows you to quickly see all of the contact groups that the contact is assigned to.

Active
This column indicates whether the contact is currently active or inactive at the property. Active contacts have a green check mark, and a red X indicates Inactive status.
Care Fee History Tab

The Care fee history tab is where you will review and accept the system-calculated resident care fees. Once an assessment is finalized, the new care fee calculated for the resident’s needs is added to the Care fees list in Pending status. You will use the Update status action to accept, modify, or reject the care fee here. This tab also keeps a log of each historical care fee that has been created.

For each care fee, the list shows its status (Pending, Accepted, or Rejected) and the calculated monthly fee amount. It shows the date on which the fee was calculated and the specific assessment that was performed. The start and end date of each fee is shown, along with the user name of the person who created, accepted, or rejected the fee.

Fields

| Actions | Only Pending care fees have available actions. Use the Update status action to approve or reject the care fee and to define the date on which the new care fee goes into effect. |
| Status | This column identifies the current status of the care fee charge: |
| **Pending**: This status identifies a care fee that has been created from a newly finalized assessment, but has not yet been accepted or rejected. This fee is not yet in effect. | |
| **Accepted**: This status identifies a care fee that has been accepted. This can be the current, active fee (if there is no end date) or a historical, expired fee (if there is an end date). | |
| **Accepted***: This status identifies a care fee that has been modified and saved. | |
| **Rejected**: This status identifies a care fee that has been rejected. | |
| Monthly amount | This is the system-calculated monthly amount of the care fee. This amount cannot be changed. |
| Calculated | This is the date on which the care fee was calculated. This is the date on which the assessment was finalized. |
| Assessment based on | This is the effective date and reason of the assessment on which this care fee is based. |
Care fee charge - These two dates identify the period for which this care fee is or was in effect.

- Pending care fees have the assessment effective date as the start date and no end date.
- Active care fees have Accepted status and the start date specified when the fee was accepted. There is no end date, so this is the fee currently in effect.
- Expired care fees have Accepted status and both a start and end date. In this case, the end date identifies the date on which this fee expired. This end date is one day prior to the new care fee’s start date.
- Rejected care fees have the assessment effective date as the start date and no end date.

Accepted/Rejected – by
Once the care fee has been accepted or rejected, this column identifies the user name of the person who performed that action.

Accepted/Rejected – date
Once the care fee has been accepted or rejected, this column identifies the date on which that happened.

Updating the Care Fee Status

When an assessment is finalized, the system automatically calculates the care fee for that resident’s care based on the needs and tasks selected for the resident. That care fee is posted here as a Pending fee. The fee is not considered active until it has been accepted. Use the Update status link to either accept or reject the care fee. You can also override the date on which the fee starts, if necessary, if you have the necessary rights assigned to your user name in user management.

1. Click the Update status link for the Pending care fee in the Care fees list.
2. Review the information in the Care fee charge box. At the top, the system displays the effective date and reason for the assessment that the pending fee is based on. This information is shown for reference only. You cannot change these values here. If these values must be corrected, you should not accept the care fee. To correct the assessment values, you must create a new assessment using the correct date and reason.
3. Next, review the care fee amount. This can be shown in one of three ways, as shown below:
   - The first example illustrates a care fee that has not been modified since it was originally created. The amount of the new care fee is shown as the Current amount.
   - The second illustrates a care fee that was recalculated based on changes made to the assessment during the review process. The Current amount is the care fee that was originally calculated. The amount of the new care fee is shown as the New care fee. You will only see this type of Care fee charge box if your property is using the assessment approval workflow.
The third illustrates a care fee that was modified to provide a discount or surcharge to the resident.

This is an original care fee, calculated when the assessment was finalized.

This is a modified care fee, calculated when the assessment was modified by the reviewer in a way that affects the care fee change.

This is a modified care fee, calculated when a discount or surcharge is added to the care fee.

The modify feature is not designed for you to change these values if you made an error or omission. If this happens, you should not accept the care fee. What action
you take depends on whether you are using the approval workflow and what status the assessment is in.

- **No approval workflow:** If your property does not use the approval workflow, the assessment cannot be modified once it has been finalized. If the care fee amount or assessment effective date is incorrect, you must reject the care fee and create a new assessment. The current care fee remains in effect until you finalize the new assessment and accept the new care fee.

- **With approval workflow:** If your property does use the approval workflow, a finalized assessment can be modified by a reviewer up until the assessment has been approved. If the assessment has not yet been approved (that is, the assessment Review result is still blank), you can notify the reviewer of the problem. The reviewer can modify the assessment as needed. When the assessment is modified, the care fee is automatically recalculated. You can now accept the modified care fee.

You will not see the recalculated amount in the Care fees list. You must click the Update status link and view the New care fee amount inside of the Care fee charge box.

Once the assessment is approved, it cannot be modified. If the care fee amount is incorrect, you must reject the care fee and create a new assessment.

4. Once you have reviewed the calculated fee, select either Accept, Modify, or Reject:

- **Accept:** Select this option to accept the care fee as shown. The care fee Status is updated to Accepted. This care fee will remain in effect until a new assessment is performed and finalized and a new care fee calculated and accepted.

- **Modify:** Select this option if you intend to discount or increase the calculated care fee. Insert the positive or negative number by which you are modifying the care fee. After saving, this care fee will remain in effect until a new assessment is performed and finalized and a new care fee calculated and accepted.

- **Reject:** Select this option to reject the care fee as shown. The care fee Status is updated to Accepted. What happens when you reject a care fee depends on the status of the assessment at the time you reject the fee:
  - If the assessment was in Pending review status, the option to approve the assessment is removed. The reviewer can modify the assessment, in which case the system updates the rejected fee to Pending and recalculates the fee amount based on the reviewer’s changes. Or, you can create and finalize a new assessment, which will generate a new care fee.
  - If the assessment was in Modified status, the option to approve the assessment is removed. The reviewer can modify the assessment again, in which case the system updates the rejected fee to Pending and recalculates the fee amount based on the reviewer’s changes. Or, you can create and finalize a new assessment, which will generate a new care fee.
• If the assessment was in Replaced status, the options to approve or modify the assessment are removed. You will need to create and finalize a new assessment, which will generate a new care fee.

• If the assessment was in Final status with an Approved Review Result, you must create and finalize a new assessment and accept the care fee in order to have an active care fee for the resident.

If your community uses the approval workflow and the assessment is modified by the reviewer after the care fee has been accepted or rejected, the system creates a new Pending care fee based on the reviewer’s changes when the modified assessment is saved. The amount of the Pending care fee is based on the modified assessment.

5. If you chose to accept the care fee, review the date in the Start field. Initially, this is the effective date of the assessment that the fee is based on. This is the date on which the new care fee will go into effect. If appropriate, you can change this date. You cannot backdate the care fee to begin prior to the assessment effective date, but you can start it anytime within seven weeks following the effective date.

For example, if a resident has suffered a significant change in condition that will cause a large increase in the care fee, you may want to delay the start of this new fee amount until you have had time to notify the family. In this case, change the date in the Start field to the appropriate date.

6. Click Save to accept or reject the care fee.

**Fields**

**Assessment**
- This field shows the effective date and the reason or type of the assessment that this Pending care fee is based on. Use this information to locate and review the assessment before accepting or rejecting the fee, if necessary.

**Current amount**
- This is the system-calculated amount of the monthly care fee. This amount is calculated based on the resident’s needs and the tasks associated with those needs, as selected in the assessment.

**Status**
- Select one of the following options:
  - **Accept**: Select this option to accept the care fee.
  - **Modify**: Select this option to modify the care fee.
  - **Reject**: Select this option to reject the care fee.

**Modify care fee by:**
- Enter the amount. If this is a negative modification, enter a minus sign before the number.

**New care fee amount:**
- This is the new care fee amount that is system-calculated after entering a modification.
**Start**

This is the date on which this care fee goes into effect. By default, this date is the same as the effective date of the assessment. However, if your property is set up to allow it, you can change this date if you want to delay the start of this fee. That is, if the resident has suffered a change of condition that will significantly increase the care fee, you may delay the start of the increased fee by a certain number of days. That number is determined in [Care fees – General information](#) in Senior Living setup.
Activity Tab

The Activity tab allows you to view and add activities for an applicant or resident. Some activities are system-generated. OneSite adds an entry to the activity journal automatically whenever significant events are recorded elsewhere in the system, such as when a resident moves in or out, is assessed, gives or cancels a notice, etc. In addition, you can record significant non-system events. For example, you can record meetings and communications with the resident and the resident’s family, events or accidents that occur that affect the resident’s care, or other issues that occur.

The Activity tab lists the activities that have been recorded for the applicant or resident to date. Optionally, you can filter the list by any of the user-added activity types, allowing you to quickly create a list of all family communications, for example.

You can add activities for family and resident communications, progress notes, and significant events or observations through the Record activity action. For each listed activity, this page shows the date the activity occurred, the activity type, the staff member who recorded the action, and any notes that explain the situation. The Print activity button allows you to print the activity journal. Each activity is listed by date (oldest to latest).

Adding or Editing Activities

1. To add a new activity, click the Record activity button. To edit an activity that was added manually, click the Edit link beside the activity. The Record activity box opens.

   If the Edit link is shaded, you do not have the right to edit activities. If no Edit link displays, this is a system-generated record, and it cannot be edited.

2. Enter the activity Date.

3. Select the Activity type from the drop-down list. The activity may have been initiated by the resident or applicant, or by you. The choices are:

   - **Family communication:** Use this type to record communication between the applicant’s or resident’s family members and the property staff.
   - **Resident communication:** Use this type to record communication between the applicant or resident and the property staff.
   - **Progress note:** Use this type to record general notes on the resident’s progress. Progress notes are usually recorded to track progress related to a particular course of action, such as recovery from a recent surgery or a course of physical therapy.
   - **Significant event:** Use this type to record significant events in the resident’s life. This can be a medical event, such as a serious fall, or a personal event, such as death of a family member or pet.
   - **Significant observation:** Use this type to record staff observations about the resident not related to a particular event or course of treatment. This can include such things as loss of appetite or increased forgetfulness.
4. To add additional information that describes the situation or activity, enter any notes in the **Description** text box.
5. If the information is correct, click **Save**.

**Printing the Activity Journal**
1. Sort and/or filter the **Activity list** as you want it to appear in the report.
2. Click the **Print activity** button.
3. The system opens the **Activity** list in a report format. Click the **Print** button.
4. Select the printer and the number of copies in the **Print** window and click **Print** again.

**Resident Activity Journal Detail**
The property name and the person’s name appear at the top of the report. For applicants and residents, the unit number also appears in parentheses beside the person’s name. The report lists the following information for each activity listed on the **Activity** tab:

- **Date**
- **Activity (type)**
- **Logged by**
- **Notes**

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Actions</td>
<td>To edit an activity, click the <strong>Edit</strong> link. You cannot edit system-generated entries.</td>
</tr>
<tr>
<td>Date</td>
<td>This is the date the activity was entered.</td>
</tr>
<tr>
<td>Activity</td>
<td>This is the type of activity that was selected when the activity was added or that was system-assigned. Sort this column to view activities by type.</td>
</tr>
<tr>
<td>Logged by</td>
<td>This is the name of the OneSite user who entered the activity or who performed the task that generated the system-added activity.</td>
</tr>
<tr>
<td>Notes</td>
<td>This shows comments added by the system or user when the activity was added. To view the entire note, rest your mouse over the text.</td>
</tr>
</tbody>
</table>
Book II

Actions

The following chapters describe all the Actions shortcuts (to the left of every page) and the various processes that are used to complete certain tasks, such as moving in an applicant or transferring a resident. The information is found in the following chapters:

In This Book

Actions Common to Applicants and Residents ........................................................ 117
Applicant Actions ..................................................................................................... 125
Resident Actions ....................................................................................................... 135
CHAPTER 3

Actions Common to Applicants and Residents

The Actions Panel

The Actions in this chapter apply to both applicants and residents. They include printing reports, assessments, and recording activities. Although many of the Actions options are also available from the Senior at a glance tabs, choosing an option in the Actions section is a direct shortcut to the chosen task.

Applicant Actions (on page 125) and Resident Actions (on page 135) are presented as separate chapters.

In This Chapter

Print Reports ............................................................................................................. 119
Assess ....................................................................................................................... 121
Record Activity ......................................................................................................... 123
Print Reports

Use this action to open the resident’s Assessment summary page. The Summary tab is selected. Here you can finalize, close, and print the Assessment summary.

How to Get Here

Senior living ➔ Find ➔ View ➔ Print reports ➔ Resident reports ➔ Print

1. To print an applicant’s or resident’s reports, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant or resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Print reports action. The Assessment Summary report is selected.
5. To select a resident report, click the Resident reports tab. Click the drop-down arrow and select a report.

Printing Reports

1. The Summary tab has the Assessment Summary for the applicant or resident.
   - At the top of the page, you see the person’s full name and assigned unit number. The property name, address, and phone number are also listed.
   - The Assessment information section has the effective date, the date of the last assessment, and the due date for the next assessment.
   - The Personal health information section has the details of the person’s health.
   - Any tasks are listed next. These tasks are listed by their categories.
2. The Resident reports tab generates the selected report in PDF format. Click the drop-down arrow and choose one of the following reports:
   - **Resident Assessment**: This report displays the most recent assessment for the resident. It has the reason for the assessment, who completed the assessment, and who reviewed it. The Personal health information from the Summary tab is listed next.
     In the next section, all tasks assigned to the assessment are listed along with their score. These tasks are listed by their categories with a score for each category and then a total assessment score.
   - **Resident Information**: This report displays the resident’s information from the General information, Personal health information, Demographics, and Contacts tabs.
   - **Individualized Service Plan**: This report displays the resident’s Personal health information from the Summary tab. The next section has the details listed for each task. That is, each need is listed along with the expected result, task description, instructions, and the responsible party.
• **Cost of Care Communication:** This report displays a change in the cost of care received for the resident. It has the date of the assessment, reason for the assessment, the resident’s previous and new acuity score, the new cost of care, and the effective date.

• **Staff Assignments by Month:** This report displays the staff assignments scheduled for the resident for the current month.

3. To print a report, click the **Print** button.

**Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Opens the Print box</td>
</tr>
<tr>
<td>Finalize</td>
<td>Finalizes the assessment</td>
</tr>
<tr>
<td>Finalize and</td>
<td>Finalizes the assessment and closes the page</td>
</tr>
<tr>
<td>close</td>
<td></td>
</tr>
<tr>
<td>Cancel</td>
<td>Returns to the resident summary</td>
</tr>
</tbody>
</table>
Assess

Use this action to enter a new assessment for the applicant or resident. When entering a new assessment, you must enter a reason and effective date. Choose to create the new assessment from a previous assessment or a new template. Refer to Creating a New Assessment (on page 57) for the detailed steps to complete this action. After you save the assessment, the system adds it to the Assessment history page.

How to Get Here

Senior living ➔ Find ➔ View ➔ Assess/Assessment history ➔ More ➔ Edit

1. To add or edit an assessment, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant or resident you need to work with.
3. Click the View link to the left of the person’s name.
4. To add an assessment, click the Assess action.
5. To edit an assessment, click the Assessment history tab.
   - Click the More link next to the assessment that you want to work with.
   - Click the Edit link.
Record Activity

Use the Record activity box to record a family communication, resident communication, progress note, significant event, or significant observation. For each activity, you will enter the date, activity type, and a description of the event. Refer to Adding or Editing Activities (on page 113) for detailed steps. After you save the activity, the system adds it to the Activity page.

How to Get Here

Senior living ➔ Find ➔ View ➔ Record activity/Activity ➔ Edit

1. To add or edit an activity, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant or resident you need to work with.
3. Click the View link to the left of the person’s name.
4. To add an activity, click the Record activity action.
5. To edit an activity, click the Activity tab, and then click the Edit link beside the entry. You cannot edit system-generated entries.
CHAPTER 4

Applicant Actions

This chapter discusses applicant actions available in the Actions section. The list of options that displays in the Actions section is dynamic; it changes with the status of the applicant. Because an applicant may be in the process of selecting a unit or changing to a different unit after a unit has already been assigned, these options change to meet your needs. Although many of the options are also available from the tabs, selecting an option in the Actions section is a direct shortcut to the chosen task.

In This Chapter

Select Unit.................................................................................................................127
Move-In ....................................................................................................................129
Cancel or Deny Application......................................................................................131
Undo Cancel or Deny Application............................................................................133
Select Unit

Once an applicant has decided to move to the property, use the Select unit action to assign a unit. When a unit has been assigned but needs to be changed, use the Change unit action. Refer to Selecting or Changing an Applicant’s Unit (on page 30) for the detailed steps to complete either action.

How to Get Here

**Senior living ➔ Find ➔ View ➔ Select unit**

1. To select a unit for an applicant, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Select unit action.

**Senior living ➔ Find ➔ View ➔ Change unit**

1. To change a unit for an applicant, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Change unit action.
Move-In

This page is where you will complete the move-in and make the applicant a resident at the property.

How to Get Here

Senior living ➔ Find ➔ View ➔ Move-in

1. To move in an applicant, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Move-in action.

Moving In an Applicant

1. Click the Select unit link. The Units page opens where you can find the unit that the applicant will move to.
   - Click the Find drop-down arrow to search for the unit using one of the following options:
     - Building: If your property uses buildings, then use this to choose a unit by its building number. Next, click the drop-down arrow to select the building.
     - Floor level: Use this to choose a unit by its floor level. Next, enter the number of the floor level and click Find.
     - Floor plan: Use this to choose a unit by its floor plan description.
     - Unit: Use this to choose a specific unit number. Next, enter the unit number and click Find.
     - Vacant units: Use this to display all vacant units at the property.
   - Once you’ve selected the option for choosing a unit, the list of units is updated based on your search parameter(s).
   - Action: The Select action is used to choose the unit.
   - Unit: This is the unit number.
   - Current resident: If applicable, this is the name of the resident that currently occupies the unit.
   - Floor level: If applicable, this is floor level for the unit.
   - Floor plan: This is the floor plan name assigned to the unit.
   - Locate the unit the applicant will move to and then click the Select action. You return to the Move-in box.
2. Enter the applicant’s Move-in date. Click the Calendar and select a date. The current property date is the default, but you can choose a date up to 45 days prior to the current property date.
3. If the applicant is moving in for respite care, then select the **Respite** check box.
4. Click the **Move-in** button. The applicant’s status is updated to Current resident.

**Fields**

- **Unit**: Click the **Select unit** link and choose a unit for the applicant.
- **Move-in**: Enter the date when the applicant will move to the property.
- **Respite**: If the applicant is moving for respite care, then select this check box.

**Buttons**

- **Move-in**: Moves in the applicant
- **Cancel**: Cancels the move-in process
Chapter 4: Applicant Actions

Cancel or Deny Application

Use this box to cancel or deny an application. These are distinctly different actions.

- Cancel an application when the person is no longer interested in living at the property.
- Deny an application if the person does not meet the residency requirements.

How to Get Here

Senior living ➔ Find ➔ View ➔ Cancel application
1. To cancel an application, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Cancel application action.

Senior living ➔ Find ➔ View ➔ Deny application
1. To deny an application, click the Senior living tab.
2. Use one of the search methods and click Find to list the applicant you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Deny application action.

Canceling the Application

This box is used if the applicant decides to cancel. If the decision is made by management not to lease to this applicant, choose the Deny application option instead.

1. To cancel an application, enter the Date the applicant canceled. Click the Calendar and select a date.
2. Click the drop-down arrow beside the Cancel reason field and select the reason the person canceled. The reason may help OneSite reports find recurring patterns in the leasing process of this property.
3. Click Save. The applicant’s status is updated to Former applicant.

Denying the Application

This box is used if management determines that the applicant does not meet the property’s standards. If the decision is made by the applicant, click Cancel to exit from this box and choose the Cancel application option instead.

1. To deny an application, enter the Date you denied this application. Click the Calendar and select a date.
2. Click the drop-down arrow beside the **Deny reason** field and select the reason the person is denied. The reason may help OneSite reports find recurring patterns in the leasing process of this property.

3. Click **Save**. The applicant’s status is updated to Former applicant.

**Fields**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Date</strong></td>
<td>Enter the date when the application was canceled or denied.</td>
</tr>
<tr>
<td><strong>Cancel reason</strong></td>
<td>Click the drop-down arrow and select the reason for canceling the application.</td>
</tr>
<tr>
<td><strong>Deny reason</strong></td>
<td>Click the drop-down arrow and select the reason for denying the application.</td>
</tr>
</tbody>
</table>
Undo Cancel or Deny Application

Use this box to restore the applicant. If the unit is still available, OneSite restores the applicant to the same unit.

Use the **Undo cancel or deny application** action if:

- An applicant who previously decided to cancel decides he or she is still interested in living at the property.
- A denied applicant has been re-appraised by management and determined to be acceptable.
- An application was canceled or denied by mistake.

How to Get Here

**Senior living ➔ Find ➔ View ➔ Undo cancel application**

1. To reverse a canceled application, click the **Senior living** tab.
2. Use one of the search methods and click **Find** to list the applicant you need to work with.
3. Click the **View** link to the left of the person’s name.
4. Click the **Undo cancel application** action.

**Senior living ➔ Find ➔ View ➔ Undo deny application**

1. To reverse a denied application, click the **Senior living** tab.
2. Use one of the search methods and click **Find** to list the applicant you need to work with.
3. Click the **View** link to the left of the person’s name.
4. Click the **Undo deny application** action.

Restoring the Application

1. To restore an applicant, enter the date of this action.
2. Enter a brief reason for restoring this application.
3. Click **Save**. The applicant’s status is updated to Applicant.

Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Enter the date to restore the person as an applicant.</td>
</tr>
<tr>
<td>Reason</td>
<td>Enter the reason for restoring the applicant.</td>
</tr>
</tbody>
</table>
CHAPTER 5

Resident Actions

The pages in this chapter describe the options in the Actions section that are specific to residents only.

The list of actions is dynamic; it changes with the status of the resident. Because a resident may be in the process of renewing the lease or transferring to a new unit, the options in the Actions section change to meet your needs. Although many of these options are also available from other pages, clicking an action is a direct shortcut to the chosen task.

In This Chapter

Change Presence .................................................................137
Print Staff Assignments.......................................................139
Give/Change Notice............................................................141
Cancel Notice ........................................................................143
Transfers .............................................................................145
Undo Transfer .....................................................................147
Move-Outs ..........................................................................149
Undo Move-In or Move-Out....................................................151
Chapter 5: Resident Actions

Change Presence

Use this action to enter a temporary absence for the resident. If applicable, you can enter a date to stop and then restart the care fee charges. Refer to Changing Presence (on page 20) for the detailed steps to complete this action. After you save the absence, the system adds it to the Temporary absence history list.

How to Get Here

Senior living ➔ Find ➔ View ➔ Change presence

1. To add or edit a person’s residency status, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. To add a residency update, click the Change presence action.
Print Staff Assignments

Use the Print staff assignments action to open the page where you can display the tasks by staff member.

How to Get Here

Senior living ➔ Find ➔ View ➔ Print staff assignments

1. To print a resident’s staff assignments, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. To display the staff assignments for the resident, click the Print staff assignments action.

Printing Staff Assignments

1. When you open the Print staff assignments page, the resident’s name, unit number, and the property name and number are at the top of the page.

   Click the Responsible party drop-down arrow and make a selection. Choose “All” parties or a specific group. This is a list of the responsible party groups set up under Senior living at the Responsible parties option.

2. Click the Staff member drop-down arrow and make a selection. Choose “All” members or a specific staff member. This is a list of the people and positions set up under Senior living at the Manage staff option.

3. Click the Task drop-down arrow and make a selection. Choose “All” tasks or a specific task. These are the tasks assigned to the responsible party you selected. Each task is set up under Senior living at the Manage tasks option.

4. After selecting the report criteria, the report shows the following information:
   - Assigned staff
   - Task description
   - Instructions
   - Scheduled time
   - Estimated time
   - Comments

5. To print the report, click Print.

Fields

**Responsible party**

Click the drop-down arrow and choose “All” parties or a specific group.
<table>
<thead>
<tr>
<th>Staff member</th>
<th>Click the drop-down arrow and choose “All” members of a specific staff member.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task</td>
<td>Click the drop-down arrow and choose “All” tasks or a specific task.</td>
</tr>
</tbody>
</table>
Give/Change Notice

This box is where you indicate that a resident has given notice to move out or to change an existing notice. The advance warning helps you find a new resident so cash flow is not diminished.

How to Get Here

Senior living ➔ Find ➔ View ➔ Give/Change notice

1. To enter or change a resident’s move-out notice, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Give notice or the Change notice action.

Giving Notice to Move Out

1. Enter the date on which the resident gave notice in the Notice given on field.
2. Click the Reason for move drop-down arrow and select one of the reasons listed. Move-out reasons are used on certain reports to calculate statistics.
3. Click Save. The resident’s status is updated to Current resident notice given – move out.

Changing the Move-Out Notice

1. The same box that was used to give notice to move out is used to change the notice. Review the information carefully.

   If the unit is unavailable, make it available on the Edit unit page in unit setup. Once the notice is changed, you can make the unit unavailable again if it should not be leased for a period of time due to renovations or other reasons.

2. Edit the Notice given for date, as needed.
3. Change the Reason for move, if necessary.
4. Click Save. The system adds a new activity to the Activity tab for the new move-out notice.

Fields

Notice given for  This is the move-out date.
Reason for move  Select the reason that best describes why the resident decided to move out.
Cancel Notice

This box is where you cancel a resident’s notice to move out. The cancellation process updates the resident’s status from Pending move out to Current resident.

How to Get Here

Senior living ➔ Find ➔ View ➔ Cancel notice

1. To cancel a resident’s move-out notice, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Cancel notice action.

Canceling a Move-Out Notice

1. Enter the Cancel notice reason. There’s a 200 character maximum limit for this field.
2. Click Save. The Canceling notice to vacate confirmation box displays.
3. To cancel the move-out notice, click Yes.

What’s Next?

- The system updates the person’s status to Current resident and removes the Scheduled move-out (date) from the Summary page.
- The system adds a “Reverse give notice to move-out” activity to the activity journal, which notes the reason for the cancellation.

Fields

| Cancel notice reason | This is the reason for canceling the move-out notice. You can enter up to 200 characters in the text entry box. The reason appears in the activity journal. |
Transfers

Use the Transfer action to enter a transfer request for a resident. Select the unit the resident will transfer to, the transfer date, and the reason for transferring.

How to Get Here

Senior living ➔ Find ➔ View ➔ Transfers

1. To transfer a resident, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Transfers action.

Transferring a Resident

1. Click the Select unit link. The Units page opens where you can find the unit that the resident will transfer to.
   - Click the Find drop-down arrow to search for the unit using one of the following options:
     - Building: If your property uses buildings, then use this to choose a unit by its building number. Next, click the drop-down arrow to select the building.
     - Floor level: Use this to choose a unit by its floor level. Next, enter the number of the floor level and click Find.
     - Floor plan: Use this to choose a unit by its floor plan description.
     - Unit: Use this to choose a specific unit number. Next, enter the unit number and click Find.
     - Vacant units: Use this to display all vacant units at the property.
   - Once you’ve selected the option for choosing a unit, the list of units is updated based on your search parameter(s).
     - Action: The Select action is used to choose the unit.
     - Unit: This is the unit number.
     - Current resident: If applicable, this is the name of the resident that currently occupies the unit.
     - Floor level: If applicable, this is floor level for the unit.
     - Floor plan: This is the floor plan name assigned to the unit.
   - Locate the unit for the transfer, and then click the Select action. You return to the Transfer box.
2. After you select the unit that the resident will transfer to, the Unit number appears.
   - If you need to choose a different unit, then click the Change unit link next to the unit number.
3. Once you’ve entered the new unit for the resident, enter the **Transfer** date. Click the **Calendar** and select the date of the transfer.

4. You must enter a reason for the resident transfer. Click the **Reason for transfer** drop-down arrow and make a selection.

5. To complete the transfer, click the **Transfer** button. The resident status at the previous unit is Former resident. At the new unit, the resident status is Current resident.

### Fields

- **Unit**: This is the unit that the resident will transfer to.
- **Transfer**: This is the date of the transfer.
- **Reason for transfer**: Select the reason that best describes why the resident decided to transfer.

### Buttons

- **Transfer**: Transfers the resident
- **Cancel**: Cancels the transfer process
Chapter 5: Resident Actions

Undo Transfer

Use this box to undo a transfer. This can be completed only if the resident has moved out of the old unit, and the transfer occurred in the current fiscal period and calendar month. Specifically, the:

- Transfer move in/out dates must be within current calendar month.
- Transfer move in/out dates must be within the current fiscal period.
- Original unit must be free (not pre-leased to applicants or residents).
- New lease must be in current resident status (not on-notice to move-out).
- Transfer has been completed.

The undo process reverses all transactions charged during the transfer. OneSite also adds an undo transfer activity to the resident’s activity journal.

Before You Begin

You must have selected a resident that transferred in the current fiscal period and calendar month that has also moved out of the old unit.

How to Get Here

Senior living ➔ Find ➔ View ➔ Undo transfer

1. To undo a resident’s transfer, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Undo transfer action.

Undoing the Transfer

1. Review the message in the Undo transfer box, which reflects the resident’s name and the previous unit the person is returning to.
2. To complete the process, click Undo.
3. Review the new message that displays after a few moments. If the undo transfer process was successful, the message reflects the resident is now current in the previous unit.
   If the process is restricted, the message provides information as to why the undo transfer process is invalid.
4. Click Close.
**Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Returns the resident to the previous unit</td>
</tr>
<tr>
<td>Cancel</td>
<td>Closes this box and cancels the process</td>
</tr>
</tbody>
</table>
Move-Outs

Use this action when the resident is going to move out of the community. Enter the move-out date, select a move category, and the reason for moving.

How to Get Here

Senior living ➔ Find ➔ View ➔ Move outs

1. To move out a resident, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Move outs action.

Moving Out a Resident

1. Enter the resident’s Move-out date. To do this, click the Calendar and select a date.
2. To filter the reasons for moving, select the Category of move that best fits the situation. “All” (the default choice) lists all move-out reasons, with the exception of cancellation, rejection, and transfer reasons, which are available only when canceling or denying an application or when entering a transfer request. For certain property types, this is a fixed field.
3. Select the Reason for move. The reasons listed are determined by the category choice above. If you selected “Other” as the Category of move, enter the reason. (The “Other” category has no predefined reasons.) Move-out reasons are used on certain reports to calculate statistics.
4. Click the Move-out button. The resident’s status is updated to Former resident.

Fields

- **Move-out**: Enter the date when the resident is scheduled to move out.
- **Category of move**: Select the category that best fits the reason why the resident is moving.
- **Reason for move**: Select the reason for the move.

Buttons

- **Move out**: Moves out the resident effective on the scheduled Move-out date
- **Close**: Closes the page so the move-out can be completed later
Undo Move-In or Move-Out

Use this box to reverse a move-in or move-out action that was completed by mistake. This box shows the move-in or move-out date, and provides a place for you to enter a brief explanation as to why this action is needed.

You can undo a move-in or move-out action only within the same accounting period as the original action.

How to Get Here

Senior living ➔ Find ➔ View ➔ Undo move-out

1. To reverse a move-out, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Undo move-out action.

Senior living ➔ Find ➔ View ➔ Undo move-in

1. To reverse a move-in, click the Senior living tab.
2. Use one of the search methods and click Find to list the resident you need to work with.
3. Click the View link to the left of the person’s name.
4. Click the Undo move-in action.

Undoing a Move-Out

1. The Move-out date that was entered is shown as a reference. This date cannot be changed.
2. You must enter a Reason for undoing the move-out. Enter a brief reason why this action is necessary.
3. Click the Undo button. The status is updated to Current resident.

Undoing a Move-In

1. To verify that the correct resident is selected, confirm the name and unit number that display at the top of the box.
2. Move-ins for prior periods cannot be undone: You can only undo the action if the current accounting period is the same period in which the original action occurred.
3. Review the dates, particularly the current accounting period start date and the move-in date.
4. Enter a brief explanation of why this action is necessary in the Comment field.
5. To reverse the move-in action, click **Undo**.

### Fields

<table>
<thead>
<tr>
<th>Name (Unit number)</th>
<th>The resident’s name and unit number display at the top of the box. Verify that you selected the correct resident who moved in or moved out by mistake.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accounting period start</td>
<td>This date is important. You can undo a move-in or move-out action in the same accounting period the original action occurred. If a new accounting period has begun, Senior Living Care Management displays a message that prevents you from reversing the action when you click the <strong>Undo</strong> button.</td>
</tr>
<tr>
<td>Move-out</td>
<td>This field displays only in the <strong>Undo move-out</strong> box. This is the date the person moved out. This date must fall within the same accounting period defined by the Accounting period start date above.</td>
</tr>
<tr>
<td>Notice for date</td>
<td>This field displays in the <strong>Undo move-out</strong> box if the person gave notice to vacate. This is the move-out date.</td>
</tr>
<tr>
<td>Reason</td>
<td>Enter a brief reason why it is necessary to undo the original action.</td>
</tr>
</tbody>
</table>

### Buttons

<table>
<thead>
<tr>
<th>Undo</th>
<th>Reverses the move-in or move-out action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Cancels the action</td>
</tr>
</tbody>
</table>
Appendices

The information in this section is provided as additional reference material.

**Appendices**
QuickMAR Integration Frequently Asked Questions.........................................................155
QuickMAR Integration Frequently Asked Questions

This topic has the details for integrating QuickMAR with Senior Living.

- QuickMAR Setup (on page 155)
- Synchronization Process (on page 155)
- QuickMAR Data Updates (on page 158)
- QuickMAR on the Today Page (on page 159)
- Resident Medications (on page 161)
- QuickMAR Access (on page 163)

QuickMAR Setup

**QUESTION: Are there any setup requirements in order to integrate with QuickMAR?**

- Yes. The gender and date of birth are required fields. Go to Setup > Senior Living > Resident Management Demographics General Settings to make these fields required. Refer to the Defining Demographic Settings procedure in either the Care Management Setup uGuide or Community Management Setup uGuide for instructions on how to complete this setup. All communities should enter these values for residents “before” integrating with QuickMAR.

Note that if these values are NOT entered for a resident, then the QuickMAR application may contain inaccurate information for date of birth and gender.

**QUESTION: How do you set up the integration with QuickMAR?**

- The account setup team activates the QuickMAR center for each PMC or community.
- The account setup team contacts QuickMAR to get a unique authentication code for each community. This code is forwarded to the PMC or community.
- The PMC Superuser enters the code for each community. This code initiates the connection with QuickMAR. Refer to the QuickMAR procedure in either the Care Management Setup uGuide or Community Management Setup uGuide for instructions on how to complete this setup.

Synchronization Process

**QUESTION: What is the Sync process and why is it necessary?**

Patients in QuickMAR and residents in Community Management or Care Management are matched by first name and last name. The syncing process does the matching. Once a match is found, IDs are saved by each system.

- If a match is not found, then the resident is added automatically to the QuickMAR application. Not all fields are imported into QuickMAR, so you’ll have to do some updating in their application. For a list of the fields that are automatically updated, see the QuickMAR Data Updates section (on page 158).
• If a match is found, the IDs are saved but no other updates are made within QuickMAR. This means some of the fields may not match. See details listed later in this document to describe the updated fields (on page ). For a list of the updated fields, see the QuickMAR Data Updates section (on page 158).

There is no back-filling of resident data from QuickMAR to Community Management or Care Management.

**QUESTION: What if the sync process creates a duplicate record in QuickMAR?**

This can happen if the information is not entered exactly the same. For example, “Patricia Davis” is entered in QuickMAR but “Patty” is entered as the first name in Community Management or Care Management. This will create two name entries in QuickMAR. There is a process within QuickMAR to merge duplicates, if found.
When you initiate the merge process in QuickMAR, contact RealPage customer support to be sure any data issues that may occur are addressed.

**QUESTION: What should I do if there are residents in the Unsynced residents list?**

Residents in Community Management or Care Management can be synced with QuickMAR by clicking the **Sync** button in the **Unsynced residents** box. Once a resident is synced, there is no need to sync again. Residents are usually included in this modal if an attempt was made to send information to QuickMAR, but the service was down or there is an issue with the data being sent.

This modal only lists residents who are currently set up in Community Management or Care Management. It cannot identify patients in QuickMAR who are not yet set up in Community Management or Care Management.

**QUESTION: How can I tell if a patient in QuickMAR has been successfully synced?**

A resident synced with QuickMAR will have a unique secondary ID in the QuickMAR profile on the Profile page.

All residents must be entered in Community Management or Care Management in order to sync successfully with QuickMAR. If there are residents without a secondary ID in QuickMAR, this indicates the resident does not exist in Community Management or Care Management. You should check for duplicates. You can also check to be sure the unit/room number is accurate.
QuickMAR Data Updates

QUESTION: What data is sent to QuickMAR and when is it sent?

Certain administrative updates for a resident are sent to the QuickMAR application, depending on the action in Community Management or Care Management. The following information is updated in QuickMAR:

- **Match is found in QuickMAR on first name and last name**
  - Actions in Community Management or Care Management:
    - Submit button is clicked the first time the QuickMAR integration is made.
    - Sync button is clicked in the **Unsynced residents** modal.
    - Move-in button is clicked.
  - No data is updated in QuickMAR except the secondary ID.

- **Admit a resident (no match found in QuickMAR)**
  - Actions in Community Management or Care Management:
    - Submit button is clicked the first time the QuickMAR Integration is made.
    - Sync button is clicked in the **Unsynced residents** modal.
    - Move-in button is clicked.
    - Undo move-out is selected.
  - The following data is sent and updated in QuickMAR:
    - First name and last name of resident
    - Unit # matches room # in QuickMAR
    - Date of birth and gender, if available
    - Admission date is the **Moved onto property** date
    - Secondary ID represents the Resident ID

- **Discharge resident**
  - Actions in Community Management or Care Management:
    - Move-out button is clicked.
  - The following data is sent and updated in QuickMAR:
    - First name and last name of resident
    - Unit # matches room # in QuickMAR
    - Discharge date for move-out

- **Update resident**
  - Actions in Community Management or Care Management:
    - Transfer to a different unit.
    - Select Undo move-in.
    - Select Undo transfer.
  - The following data is sent and updated in QuickMAR:
    - First name and last name of resident
Appendix A: QuickMAR Integration Frequently Asked Questions

- Unit # transfer updates the room # in QuickMAR
- Admission date is the date Moved Onto Property in all cases for transfers
- Discharge date

QuickMAR on the Today Page

**QUESTION: How do I add the QuickMAR snapshot to the Today page?**

Click the Customize link on the Today page, and then select “Senior Living” from the drop-down list. Drag and drop the QuickMAR Data snapshot so that it lands within the rectangle that represents the user’s screen.

**QUESTION: Why do I have to refresh the data each time I open the Today page or on the resident’s Personal health information tab?**

Data from QuickMAR is not saved or cached in our system. This means the service must be called every time the page is opened. This also provides you with the most current data from QuickMAR.

**QUESTION: Should I compare the statistics on the Today page with the QuickMAR dashboard?**

You can compare the medication statistics on the Today page with the QuickMAR dashboard. There are many variables involved, so an exact match may not occur every time, but it will be close. Remember that the main purpose of the snapshot on the Today page is to alert you of possible upcoming medication administration tasks, etc.
QUESTION: What do the numbers for each medication status represent on the Today page snapshot?

The medication numbers show you inconsistencies or issues that may need resolution in QuickMAR. There is no expectation that the statistics will match every time.

- **Orders to review** is the number of orders (or medications) flagged for review in the QuickMAR application.
- **Missed meds (yesterday)** refers to the number of medications (including vitals, treatments, etc.) missed as of yesterday.
- **Exceptions** lists the number of exceptions.
- **Consider assessment** is a new feature to be implemented in a future version of QuickMAR.
- **Unsynced residents** is the number of residents that are not matched in QuickMAR. It does not include patients in QuickMAR that have not been set up yet in Community Management or Care Management.

QUESTION: Why doesn’t the count of residents in the modal match the number in the Today page snapshot?

The number in the snapshot is the number of medications, not the number of residents. A resident could have multiple medications needing review, missed, or with an exception.

QUESTION: Does the Today page snapshot display data as of the property date? What if it has not been advanced yet?

The current calendar date is used to retrieve the statistics from QuickMAR, even if the property date has not been advanced.
QUESTION: What does this message mean: “Please check the QuickMAR application for the medication status selected.”
This occurs when the patient in QuickMAR has not yet been synced with Community Management or Care Management. Check the dashboard in QuickMAR to identify the patient.

Resident Medications

QUESTION: How can I view the list of medications for a resident?
Clicking the View link in any of the snapshot modals will take you to the Senior at a glance page for the resident.

To view the list of medications for a resident, click the Edit general, personal health, and demographic information button on the Summary tab of the Senior at a glance page. You must then click the Refresh button to get the latest data from QuickMAR.

Only users with the “Allow the user to view unencrypted data” right have access to this new medication control.

QUESTION: Please explain the columns in the Medications list.
This list has the following medication information for the resident:

- Name or title of the medication.
- An asterisk displays next to the medication if it is flagged for review in QuickMAR.
  There are two reasons an order is flagged for review, with either a green flag or a red flag in QuickMAR. A red flag indicates a problem with the order; it needs correction. A green flag means the order is awaiting approval. Within QuickMAR, either one of these is considered something that needs review.
- Type of medication. (At this time, only medications are returned, not vitals or treatments.)
• Details set out any instructions for the medication.

QUESTION: I don’t see vitals or treatments listed in the Medications list. Is that right?

Only medications are listed here. Even though vitals and treatments are listed as medications in QuickMAR, this list only includes medications.

QUESTION: How are split orders displayed in the Medications list?

Split orders may be listed multiple times in the list. A split order is the same medication with different instructions.

If a medication is given multiple times for a 24-hour period, it is only listed once in this list.

QUESTION: Does the list include expired medications? What’s the time frame for the list?

This list only includes medications that are active as of the current date. If a medication has expired, it is not listed. If a medication does not start until some date in the future, it is not listed. Also, it does not take into account the property date for the community, which may be different if it’s not advanced yet.

QUESTION: Can I edit or make updates to the Medications list?

No, all updates are made in QuickMAR. Medication data is not stored within Community Management or Care Management.
QUESTION: Can I generate a report that lists the medications for a resident?
No, all reports for medication data should be generated in QuickMAR. Medication data is not stored within Community Management or Care Management.

QUESTION: I can see the Today page snapshot, but not the Medications list for a resident?
The Medications list is controlled by a special right: “Allow the user to view unencrypted data.” See your administrator or Superuser for access.

QUESTION: When will I be alerted if a resident has medication issues?
If there are any issues with medications (red-flagged or green-flagged in QuickMAR), then the alert displays when you click the Assess button. You can still do an assessment for the resident. This alert is informational only.

QUESTION: Will I be alerted if an applicant has medication issues?
No, only current residents are considered for this alert and are included in the statistics on the Today page snapshot. Applicants and former residents are not included.

QuickMAR Access

QUESTION: Can I access the QuickMAR application directly from Care Management or Community Management?
No, there is no direct link to QuickMAR. You should already have access to the application or obtain it from your property’s Superuser.
Index

E
Exclude from care fee calculation • 66, 70

M
Medications • 32

R
Refresh data • 6, 8

S
Shortcuts • 3, 8, 10, 13, 115

T
Temporary absence history • 17, 20, 137